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1— INTRODUCTION

Curtis 1232E/SE, 1234E/SE, 1236E/SE, and 1238E/SE AC motor controllers provide accurate,
dependable, and highly efficient control of speed and torque of AC induction motors (ACIM)
and surface permanent magnet synchronous motors (SPM).

These AC controllers contain two microprocessors to provide exceptional capability and
functional safety. The primary microprocessor runs an advanced field-oriented AC motor
control while simultaneously running VCL software in an embedded logic controller. The second
microprocessor continuously monitors the operation of the system, redundantly measuring
inputs, crosschecking results, and verifying critical timing and operations.

VCL (Vehicle Control Language) is an innovative software programming language developed
by Curtis. Many electric vehicle functions are uniquely built into the VCL code, and additional
functions can be created by OEMs as required. VCL opens new avenues of customization,
allowing specific vehicle application functions to be created quickly and easily within the motor
controller itself, often eliminating the need to use separate vehicle manager modules.

The CANbus communications included within these controllers allow these AC motor
controllers to function as system CAN masters (Server) or CAN slaves (Client) as part of an
efficient distributed system. Inputs and outputs can be optimally shared throughout the system,
minimizing wiring and creating integrated functions that often reduce the cost of the system.

These controllers are the ideal solution for traction, hoist, dual drive, and other motor drive and
vehicle control needs.

Figure 1

Curtis AC induction and surface permanent magnet motor controllers:
from left to right, models 1232SE, 1234E, 1236E, and 1238E.

The E and SE models look similar, and share the same standard features.
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Like all Curtis controllers, the E and SE models offer superior operator control of motor drive
performance. Features include:

+ Closed-loop speed and torque control for both induction (ACIM) and surface permanent
magnet (SPM) motors.

« High efficiency, field-oriented motor control algorithms that enable maximum possible motor
torque generation for all operating conditions.

 Advanced Pulse Width Modulation technology for efficient use of battery voltage, low motor
harmonics, low torque ripple, and minimized switching losses.

« Extremely wide torque/speed range including full regeneration capability.

« Full field-weakening capability with ACIM motors; full control up to no-load base speed
with SPM motors.

» Smooth low speed control, including zero speed.

« Adaptation of control algorithm to motor temperature variation for optimal performance
and reduced motor heating.

« Power limiting maps allow performance customization for reduced motor heating and
consistent performance over varying battery state-of-charge.

o Thermal cutback, warning, and automatic shutdown provide protection to motor and controller.
« Insulated metal substrate power base provides superior heat transfer for increased reliability.

 Built-in auto-characterization routines for effective in-vehicle optimization of motor
performance and efficiency.

» Powerful operating system allows parallel processing of vehicle control tasks, motor control
tasks, and user configurable programmable logic (VCL).

» A wide range of I/O can be applied wherever needed, for maximum distributed system control.

« Built-in Dual Drive software allows easy setup and control of typical dual-drive vehicles,
without VCL.

« Internal battery-state-of-charge, hourmeter, and maintenance timers.

« CANopen compatible CANbus connection; other CANbus protocols are configurable
through VCL.

« Significantly increased CAN master capabilities, VCL execution speed, and VCL code space
o Field-programmable, with flash downloadable main operating code.

 Easily programmable through the Curtis 1313 handheld programmer and 1314 PC
Programming Station.

» Rugged sealed housing and connectors meet IP65 environmental sealing standards for use
in harsh environments.

» Compliance with Machinery Directives 2006/42/EC and EN13849-1.

Getting the most out of your Curtis controller

Read and apply the information in this manual. The Installation/Wiring, Initial Setup, and Tuning Guide
chapters are critical to proper operation of your controller. For technical support, contact the Curtis
distributor where you obtained your controller or the Curtis sales-support office in your region.

pg. 2
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Figure 2a

Curtis 1232E and 1232SE

motor controllers.
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Note: The SE has a thicker base.
Dimensions in millimeters.

2 — INSTALLATION AND WIRING

MOUNTING THE CONTROLLER

The outline and mounting hole dimensions for the 1232E/SE controller are shown in Figure 2a, for the
1234E/SE controller in Figure 2b, and for the 1236E/SE and 1238E/SE controllers in Figure 2c. When
an Ampseal plug housing is mated with the 35-pin logic receptacle, these controllers meet the IP65
requirements for environmental protection against dust and water. Nevertheless, in order to prevent
external corrosion and leakage paths from developing, the mounting location should be carefully chosen
to keep the controller as clean and dry as possible.

Mount the controller to a flat surface devoid of protrusions, ridges, or a curvature that can cause damage
or distortion to its heatsink (the base plate). Secure the controller using four 6 mm (1/4") diameter bolts
evenly torqued to the vehicle’s mounting surface. These controller’s heatsink (bottom surface) have a typical
roughness grade of N8 (ISO 1302), with a flatness tolerance of < 5 mm (0.13 per 25 mm). A thermal joint
compound is recommended to improve heat conduction from the controller heatsink to the vehicle’s
mounting surface. Typically, when properly mounted to a larger metal surface, additional heat-sinking or
fan-cooling is not necessary to meet the application’s peak and continuous current ratings.

2 — INSTALLATION AND WIRING Pg. 3
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Figure 2b

Mounting dimensions,
Curtis 1234E and 1234SE
motor controllers.
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Note: The SE has a thicker base and taller terminals.

Dimensions in millimeters.
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Figure 2¢

Mounting dimensions,
Curtis 1236E/SE and
1238E/SE motor controllers.
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& WARNING | HiGH CURRENT ARCS — Batteries can supply very high power, and arcing can occur if they

A
Aza\

Working on electrical systems is potentially dangerous. Protect yourself against
uncontrolled operation, high current arcs, and outgassing from lead-acid batteries:

UNCONTROLLED OPERATION — Some conditions could cause the motor to run out of control.
Disconnect the motor or jack up the vehicle and get the drive wheels off the ground before
attempting any work on the motor control circuitry.

are short circuited. Always open the battery circuit before working on the motor control circuit.
Wear safety glasses, and use properly insulated tools to prevent shorts.

LEAD-ACID BATTERIES — Charging or discharging generates hydrogen gas, which can build
up in and around the batteries. Follow the battery manufacturer’s safety recommendations.
Wear safety glasses.

You will need to take steps during the design and development of your end product to ensure that its EMC
performance complies with applicable regulations; suggestions are presented in Appendix A.

These controllers contain ESD-sensitive components. Use appropriate precautions in connecting,
disconnecting, and handling the controller. See installation suggestions in Appendix A for protecting the
controller from ESD damage.

pg. 6
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HIGH POWER CONNECTIONS

There are five high power terminals, identified on the controller housing as B+, B-, U, V, and W.

Table 1 High Powered Connections

Terminal Function
B+ Positive battery to controller
B- Negative battery to controller
u Motor phase U
v Motor phase V
w Motor phase W

Lug Assembly: 1232E/SE and 1234E/SE models

Five aluminum M6 terminals are provided. Lugs should be installed as follows, using M6 bolts sized
to provide proper engagement (see diagram):

« Place the lug on top of the aluminum terminal, followed by a high-load safety washer
with its convex side on top. The washer should be a SCHNORR 416320, or equivalent.

« Iftwo lugs are used on the same terminal, stack them so
the lug carrying the least current is on top.

 Tighten the assembly to 10.2 +1.1 N-m (90 10 in-lbs).

1 ]
M6 BOLT
11.75 mm MIN / S
DEPTH 10 FS'E‘},'Tvll_,IN HIGH LOAD
% % o~ SAFETY WASHER
? T 1234SE 1 o \
= f.-' ] has larger i b LUG —
v ﬁ,x ? terminal o i ; \ \
,x" jj & . : M6 TERMINAL \(—
1975 mm MAX - A 18 mm MAX - b
DEPTH S DEPTH ] . .
SECTION VIEW SECTION VIEW EXPLODED VIEW
1234SE 1232E/SE, 1234E
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Lug assembly: 1236E/SE and 1238E/SE models

Five M8 terminals are provided. Lugs should be installed as follows, using M8 bolts sized to provide
proper engagement (see diagram):

« Place the lug on top of the terminal, followed by a safety washer with its convex
side on top. The washer should be a SCHNORR 700800, or equivalent.

o If two lugs are used on the same terminal, stack them so
the lug carrying the least current is on top.

 Tighten the assembly to 9.6 £0.9 N-m (85 %8 in-1bs).

MeBOLT —— [ ]

7.5 mm MIN DEPTH —

‘/SAFETYWASHER
L 5y \ L
A
e T

)
— T T~ MBTERMINAL

13.75 mm MAX DEPTH

SECTION VIEW EXPLODED VIEW

High Power Wiring Guidelines: All Models
Battery cables (B+, B-)

These two cables should be run close to each other between the controller and the battery. Use high
quality copper lugs and observe the recommended torque ratings. For best noise immunity the cables
should not run across the center section of the controller. With multiple high current controllers,
use a star ground from the battery B— terminal.

Motor wiring (U, V, W)

The three phase wires should be close to the same length and bundled together as they run between
the controller and the motor. The cable lengths should be kept as short as possible. Use high quality
copper lugs and observe the recommended torque ratings.

For optimum noise immunity, the motor cables should not run across the center section of the
controller. In applications that seek the lowest possible emissions, a shield can be placed around
the bundled motor cables and connected to the B— terminal at the controller. Typical installations
will readily pass the emissions standards without a shield. Low current signal wires should not be
run parallel to the motor cables. When necessary they should cross the motor cables at a right angle
to minimize noise coupling. Refer to Appendix A for further information about Electromagnetic
Compatibility (EMC).

pg. 8 2 — INSTALLATION AND WIRING
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LOW POWER 35-PIN CONNECTIONS

All low power connections are made through a single 35-pin AMPSEAL connector. The mating plug
housing is AMP p/n 776164-1 and the gold-plated socket terminals are AMP p/n 770520 (Strip form)
and 770854-3 (loose piece). The connector will accept 0.5 — 1.25 mm (20 - 16 AWG) wire with a
1.7 - 2.7 mm diameter (thin-wall insulation). Seal any non-used connector positions that have the
silo-diaphragm pierced with seal plug 770678-1.

The 35 individual pins are characterized in Table 2.

harness wire-side view

1 ¥ooooooo0oo00000*
200000000000
,00000000000 0,

7

Low Power Wiring Guidelines

Position feedback (Pins 7, 26, 31, 32)

All four wires (+5V, Feedback A, Feedback B, and I/O ground) should be bundled together as they
run between the motor and controller logic connector. These can often be run with the rest of the low
current wiring harness. The encoder cables should not be run near the motor cables. In applications
where this is necessary, shielded cable should be used with the ground shield connected to the I/O
ground (pin 7) at only the controller side. In extreme applications, common mode filters (e.g. ferrite
beads) could be used.

CANbus (Pins 21, 23, 34, 35)

It is recommended that the CAN wires be run as a twisted pair. However, many successful applications
at 125 kbit/s are run without twisting, simply using two lines bundled in with the rest of the low
current wiring. The CANbus wiring should be kept away from the high current cables and cross
them at right angles when necessary.

All other low power wiring

The remaining low power wiring should be run according to standard practices. When designing
the vehicle’s wiring and routing, keep the input lines such as throttle, brake, temperature, and the
above mentioned encoder or Sin/Cos sensor signals separate from controller’s output lines such as
the coil driver outputs. Avoid routing the low-power wiring parallel to the high power (and current)
battery and motor cables.

2 — INSTALLATION AND WIRING Pg. 9
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Table 2 Low Power Connections

Related VCL*
Pin Name Description
Function References
1 KS| Keyswitch input. Provides logic power for Keyswitch_Voltage
the controller and power for the coil drivers.
Automate_PWIM() Sw_13
Proportional driver. This is a coil driver with E\ﬂiamgo E\SIN(I;?J rrent
current control capability typically used Frequency PD Output
2 Prop. Driver for a proportional valve on a hydraulic . V- —Julp
manifold Output() PD_Throttle
: C Frequency_ VCL_PD_Throttle
Can also be used as a digital input. Output_Duty_
Cycle()
Generic driver #4; can also be used as Automate_PWM() Sw_12
3 Driver 4 a digital input. Has low frequency PWM Put_PWM() PWM4
capabilities. PWM4_Qutput
Generic driver #3; can also be used as Automate_PWM() Sw_11
4 Driver 3 a digital input. Has low frequency PWM Put_PWM() PWM3
capabilities. PWM3_Output
Typically used for pump contactor.
Generic driver #2; can also be used as Automate_PWM() Sw_10
a digital input. Has low frequency PWM Put_PWM() PWM2
5 Driver 2 capabilities and a slightly higher current PWM2_Qutput
rating.
Typically used for electromagnetic brake.
Generic driver #1; can also be used as /Sﬂ}ogv?lt'%PWM() gz\'m%
6 Driver 1 gadp'ggﬁiltilggm' Has low frequency PWM Setflnterlock() PWM1_Output
; ' . Clear_Interlock() Interlock_State
Typically used for main contactor. Main_State
7 I/0 Ground Input and output ground reference.
Can be used as generic switch input #2 or Sw_2
8 Switch 2 as generic analog input #2. Analog2_Input
Analog 2 Typically used as the motor temperature Motor_Temperature
analog input.
. Generic switch input #3. Sw_3
9 Switch 3 Typically used as the interlock switch.
10 | Switch4 Generic switch input #4. Sw_4
11 | Switch5 Generic switch input #5. Sw_5
12 | Switch 6 Generic switch input #6. Sw_6
. This is the coil return pin (at B+ potential)
13 | Coll Return for all the contactor coils.
14 | Switch 16 Generic switch input #16. Sw_16
15 | Throttle Pot High Pot high connection for a 3-wire throttle pot.
. . . Setup_Pot() Throttle_Pot
16 | Throttle Pot Wiper Pot wiper connection for the throttle pot. Setup_Pot_Faults | Throttle_Pot_Output
) . . Setup_Pot() Brake_Pot
17 | Pot2 Wiper Pot wiper connection for the brake pot. Setup_Pot_Faults() | Brake_Pot Output

* The related VVCL columns are vital when writing VCL code (see Chapter 10). VCL “functions” are used to access the various I/0s; VCL “references” are
predefined names for specific pins. Refer to the 0S Sysinfo file for specific VCL functions, controller system variables, usage, and CAN Object IDs.

pg. 10
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Table 2 Low Power Connections, cont'd

Related VCL*
Pin Name Description
Function References
Common pot low connection for the throttle Pot_Low_Output
18 | PotLow and brake pots.
. Set_DigOut() Sw_14
- An On/Off output driver. ) X
19 | Digital Out 6 C Clear_DigOut() DigOut6
Can also be used as a digital input. Dig6_Output
. Set_DigOut() Sw_15
20 | Digital Out7 An OO output river. Can also be Used | - gjer pigout) | DigOut7
g put. Dig7_Output
High connection for the CAN termination
21 CAN Term H jumper.
. Generic switch input #7. Sw_7
22 | Switch7 Typically used as the Forward switch.
Setup_CAN()
. Setup_Mailbox()
23 | CANH CANbus high. Send_Mailbox()
etc.
Can be used as generic switch input #1 or Sw_1
o4 Switch 1 as generic analog input #1. Analog1_Input
Analog 1 Typically used for emergency reverse
switch (if applicable).
25 | +12V Out Unregulated low power +12V output. Ext_Supply_Current
5_Volts_Output
26 | +5V Out Regulated low power +5V output. Ext._Supply_ Current
27 | Pot2 High Pot high connection for a 3-wire brake pot.
. Serial transmit line for display or flash Setup_Serial()
28 | Serial TX update.
29 | Serial RX Serial receive line for flash update Setup_Serial()
- Low power, low frequency 0Vto 10V Automate_PWM() PWM6
30 | Analog Output analog output. Put_PWM() Analog_Output
Quadrature encoder input phase A (ACIM Motor_RPM
31 Position Feedback A | motors). Sin/Cos sensor input sine (SPM MotorspeedA
motors). Encoder_Sin_Input_Compensated
Quadrature encoder input phase B (ACIM Motor_RPM
32 | Position Feedback B | motors). Sin/Cos sensor input sine (SPM MotorspeedB
motors). Encoder_Cos_Input_Compensated
. Generic switch input #8. Sw_8
33 | Switch8 Typically used as the Reverse switch.
Low connection for the CANbus termination
34 | CANTermL jumper.
Setup_CAN()
Setup_Mailbox()
35 | CANL CANbus low. Send._Mailbox()
etc.

* The related VCL columns are vital when writing VCL code (see Chapter 10). VCL “functions” are used to access the various I/0s; VCL “references” are
predefined names for specific pins. Refer to the 0S Sysinfo file for specific VCL functions, controller system variables, usage, and CAN Object IDs.

** Pin 30 not connected on 1232E/SE controllers.
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CONTROLLER WIRING: BASIC CONFIGURATION

A basic wiring diagram is shown in Figure 3. Throttle and brake are shown in the diagram as 3-wire
potentiometers; other types of throttle and brake inputs are easily accommodated, and are discussed
in the following throttle wiring section.

The main contactor coil must be wired directly to the controller as shown in Figure 3 to meet EEC
safety requirements. The controller can be programmed to check for welded or missing contactor
faults and uses the main contactor coil driver output to remove power from the controller and motor

Figure 3

Basic wiring diagram, Curtis 1232E/SE, 34E/SE, 36E/SE, and 38E/SE motor controllers.

EMERG. REV. .~  J7-24
INTERLOCK % J1-9
5 J1-10
o J1-11
6 J1-12
FORWARD o J1-22
REVERSE oo J1-38
6 J1-14
J1-8
MOTOR
TEMPERATURE
SENSOR
J1-7
Note: KTY sensor shown.
The banded end must be
connected to I/0 ground.
J1-30
] J1-15
o.
w
,—_-é‘ J1-16
=
=)
o
= 5 J1-27
o.
=~ J1-17
<
o
[--]
J1-18

SWITCH 1/ ANALOG 1
SWITCH 3
SWITCH 4
SWITCH 5
SWITCH 6
SWITCH 7
SWITCH 8

SWITCH 16

SWITCH 2/ ANALOG 2

1/0 GROUND

ANALOG OUT (0-10V) *

THROTTLE POT HIGH

THROTTLE POT WIPER

POT2 HIGH

POT2 WIPER

POT LOW

KSI
KSI o o
COIL RETURN o
Vo w
o E
1 - =
DRIVER 1 T 2
VB =
DRIVER 2 poo| O/ E
DRIVER 3 b x
DRIVER 4 %
DIGITAL DRIVER 6 ||-47-79.. S B
DIGITAL DRIVER 7 ||-41-29. .
J1-2
PROP. DRIVER N
MAIN '
B+O IV L : 5§
* 1L LB
u C Vo
AC o
vo MOTOR
wO -
J1-26 ! —
bl | T BATTERY
POSITION FEEDBACK A POSITION (24V-96V)
POSITION FEEDBACK B [[/1-52 FEEDBACK —
1/0 GROUND |[41-7 o T
B-O
** quadrature encoder (ACIM motors)
sin/cos sensor (SPM motors)
J1-21
CANTERMH |frl=l .
. Connect jumper for 120 Q
CANTERM L | |£1-34 __t CAN bus termination
CANH [[/1-25

CAN L

+12V

X

RX

1/0 GROUND

J1-25

N

J1-28

J1-29

Ji-7

1232E/34E/36E/38E, 1232SE/34SE/36SE/38SE
CONTROLLER

*1232E and 1232SE do not include ANALOG OUT.

CURTIS
MODEL 840
DISPLAY

SERIAL PORT
(4-pin Molex)
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in the event of various other faults. If the main contactor coil is not wired to Pin 6 of the 35-pin
connector as shown, the controller will not be able to open the main contactor in serious fault
conditions and the system will therefore not meet EEC safety requirements.

Note that the basic wiring diagram is designed for generic applications and may not fully meet the
requirements of your system. These controllers have very flexible I/O and wiring configurations;
you may wish to contact your Curtis distributor or support engineer to discuss your particular
application.

SWITCH INPUT WIRING

The following inputs are dedicated to specific functions when the parameter settings are as shown:

Switch 1: Emergency Reverse input if the EMR Enable = On and EMR Type = 0 or 2
(see page 65).

Switch 3: Interlock input if Interlock Type = 0 (see page 52).
Switch 5: Lift input (depends on VCL program).

Switch 6: Lower input (depends on VCL program).

Switch 7: Forward input if Throttle Type = 1-3 (see page 46).
Switch 8: Reverse input if Throttle Type = 1-3 (see page 46).

LOW POWER CIRCUIT SPECIFICATIONS

The input/output circuits wired to the 35-pin connector can be grouped by type as follows; their
electrical characteristics are discussed below.

« Digital Inputs

« Digital and PWM Outputs

+ Analog Inputs

+ Analog Output

« Power Supply Outputs

o KSI and Coil Return Inputs

o 'Throttle and Brake Inputs

o Communications Ports I/O

o Position Feedback Inputs

Digital Inputs

These control lines can be used as digital (on/off ) inputs. Normal “on” connection is direct to B+;
“oft” is direct to B—. Input will pull low (off ) if no connection is made. All digital inputs are protected
against shorts to B+ or B—.

Nine of these lines (Switches 1-8, 16) are designed to pull current to keep switch contacts clean and
prevent leakage paths from causing false signals.

The remaining lines are digital inputs associated with driver outputs; note that they have much higher
input impedances. The two digital output lines, Digital Out 6 and 7, can also be read as inputs, and
are therefore included in this group.

The digital inputs at pins 24 and 8 can also be used as analog inputs, and are included in that group as well.
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- ) DIGITAL INPUT SPECIFICATIONS
2§)O.OOOOOOOO.‘3 ] Logic Input
[2.o.o.o.o.ooo.o.o.o.o.oo} Name Pin | trresholds impedance* Voltage ranget ESD Tolerance
Switch 1 24
Switch 2 8
swiens |9 2o ot
Switch 4 10 36-48V models:
swiehs | 1 ppenzie) e
Switch 6 12 25.2 kQ), 27.3 kQ
Switth7 | 22 | Rising edge= | ﬁ;gﬁggﬁogg’s-'
Quick Links: Switch 8 33 4.4V max ’ + 8 kV
Figure 3 wiring diagram p.12 Switch 16 14 Falling edge= (direct strike)
Digital Out6 | 19 1.5V min
Digital Out 7 20
Driver 1 6
Driver 2 > s (Ma;\? e V)
Driver 3 4
Driver 4 3
Prop Driver 2

*The first value is for 1232E/SE and 1234E/SE controllers, and the second value is for 1236E/SE and 1238E/SE controllers.

T “Max\V/” in this and the following tables is the controller’s maximum voltage; see Table D-1 for the maximum voltage of
each model.

NOTE: The voltage at the switch inputs 3-8 and 16 must be above the high threshold or below the low threshold for proper operation.
Allowing these inputs to fall between these thresholds for more than 100 milliseconds could result in a Supervisor Fault (fault code 77).

DIGITAL INPUT IMPEDANCE CIRCUITS

1232E/SE and 1234E/SE o 5V clamp 0 3.3V clamp
controllers ¥ ¥
Supervisor 5V clamp
VA g
i DRIVER INPUTS
SWITCH INPUTS Pri 100 kQ (pins 6, 5, 4, 3, 2)
18,16 . VA rimary A uP
B 83y 100 kQ we DIGOUT INPUTS 100 ko
, 33, (pins 19, 20) 100 kQ
Model %100 kQ %127 kQ
specific * L
* 24-36V models = 7.5 kQ, 36-48V = 12 kQ, 48-80V = 33 kQ
1236E/SE and 1238E/SE o 5V clamp 0 3.3V clamp
I L
controllers 1 t
Supervisor 5V clamp
VA Sk
i DRIVER INPUTS
SWITCH INPUTS Pri 150 kQ (pins 6, 5, 4, 3, 2)
18, 16 : % o % uP
(p.zrls 331 21,42)2, 150 kQ w DIGOUT INPUTS 450 ko
, 33, ins 19, 2
(pins 19, 20) 150 kQ
Model | %150 kQ %191 kQ
specific * L
* 24-36V models = 7.5 kQ, 36-48V = 12 kQ, 48-80V = 33 kQ, 72-96V = 36 kQ
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Digital and PWM Outputs

Seven digital (on/off ) and PWM output drivers are available. One of these, the proportional driver,
can be operated in a current control mode for driving a proportional valve or similar load. The
frequency of this driver is normally 18 kHz, but this output can also serve to drive an electronic
speedometer or tachometer using the VCL function Automate_Frequency_Output(); see page 125.

Each output can be independently turned on continuously (low level) or pulse width modulated to
set the average output voltage. These outputs are intended to drive inductive loads such as contactors
and electromagnetic brakes but could also be used to drive resistive loads if peak current ratings are
not exceeded. All these outputs are protected against shorts to B+ or B—. All inductive loads should
be connected to the coil return (pin 13), which provides flyback diode protection.

These lines can also be used as digital inputs, and are included in that group as well.

DIGITAL and PWM OUTPUT SPECIFICATIONS
5008806060000 Output | Protected | ESD
,00000000008O0, Name Pin PWM PV Current | Frequency B Voltage T
Driver 1 6 2A Max
Driver 2 5 N/A 120 to 1000 3A Max
Driver3 | 4 | 0t0100% Hz*
Driver4 | g | DulvCycle sVl | 8K
0to2Ain 2AMAX | \axy +10V) g:ﬁg
Prop Driver 2 607 nominal 18 kHz
steps
Digital Out6 | 19
— On / Off N/A N/A 1A Max
Digital Qut 7 | 20
*Drivers 1-4 Fequency is set by the PWM Frequency parameter.
Analog Inputs
Quick Links: Two control lines can be used as analog inputs. Both inputs are protected against shorts to B+ or B—.
Figure 3 wiring diagram p.12
Motor Temp Sensor p.61 Typically Analog 2 is used as the input for the motor temperature sensor. This input provides a

constant current appropriate for a thermistor sensor. Some standard predefined motor temperature
sensors are supported in software (see the motor's Sensor Type parameter). Note: The industry
standard KTY temperature sensors are silicon temperature sensors with a polarity band; the polarity
band of a KTY sensor must be the end connected to I/O Ground (pin 7).

These lines can also be used as digital inputs, and are included in that group as well (see page 13).

[ } ANALOG INPUT SPECIFICATIONS
00000000000 0*

000080000000, Signal Name Pin Operating Input Protected Voltage ESD Tolerance

2000080000000, Voltage impedance*
Analog 1 24 24-36 V models:
6.9 kQ, 7.1 kQ
36-48 VV models:
?nt‘;gg)l’ 10.5 k0, 11.0 kO 10V 1o + 8KV
Analog 2 8 Mo | 48-80Vmodels: | (MaxV+ 10V (direct strike)

23.8 kQ, 28.1 kQ
72-96 V models:
n/a, 28.1 kQ

*The first value is for 1232E/SE and 1234E/SE controllers, and the second value is for 1236E/SE and 1238E/SE controllers.
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Analog Outputs

A single line is available as a low power analog output and is intended to drive instrumentation such
as a battery discharge indicator. This output is generated from a filtered PWM signal and has about
1% ripple. The 2% settling time is <25 ms for a 0-5 V step and <30 ms for a 0-10 V step. This output
line is protected against shorts to B+ or B—. Note: The 1232E/SE does not have this analog output.

[ } ANALOG OUTPUT SPECIFICATIONS
*00000@000000*

80000000000 O™ Signal Name Pin Output Output

000000000000, Voltage B Protected Voltage ESD Tolerance

-1Vto +=8KkV

Analog Out 30 Oto10V 10 mA (MaxV + 10V) (direct strike)

Power Supply Outputs

Quick Links:

) A Two lines provide auxiliary output power for low power circuits such as electronic throttles, LED
Figure 3 wiring diagram p.12

indicators, displays, position encoder, and remote I/O boards. I/O Ground (at pin 7) is the return
line for these low power devices. Both power supply outputs are protected against shorts to B+ or B—.

POWER SUPPLY OUTPUT SPECIFICATIONS
SZ?oooooooooo?;“ Outout
1QOOOOOOOOOOOOOOOOOOOOOOO' Signal Name Pin Output Voltage c:""'; e Protected Voltage ESD Tolerance
+12V Out 25 11.5t014.5V 100 mA max
for +12 Qut
100 mA max -1Vto "
0 for +5 Out (MaxV +10V) x
+5V Out 26 5V+10% 200 mA max (direct strike)
(combined total)
I/0 Ground 7 n/a 500 mA max not protected

KSI and Coil Return

The KSI input provides power for all low power control circuits. This includes the microprocessors,
power supply outputs, power for the digital and PWM driver outputs, the power-capacitor
precharge (before main contactor closure). Battery voltage is sensed on the input for the VCL battery
discharge function.

Coil Return (pin 13) should be wired to the positive battery side of the contactors being driven so
that switching noise associated with PWM operation of the contactors is localized to the contactor
wiring only.

It is important to maintain the division between KSI and coil return in order to ensure reverse
polarity protection (e.g., vehicle wiring correct, battery terminals reversed).

- -~ KSland COIL RETURN INPUT SPECIFICATIONS
O0O0O000OO0OO0O0O0O0O q
20000000000 @B . . Operatlng
200000000000, Signal Name | Pin Voltage Input Current Protected Voltage | ESD Tolerance
KSI 1 Between under- | 13 A max * continuous | = (MaxV +10V) 8 KV (direct
+ irec
_ and overvoltage . (KSI-0.3V)to strike)
Coil Return 13 cutbacks 10Aor 12 A max (MaxV + 10V)

* Including current from the coil return (pin 13).
**12 A for 1236E/SE and 1238E/SE; 10 A for 1232E/SE and 1234E/SE.
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*00000000@8000*
200000000000
000000000000,

Quick Links:
Figure 3 wiring diagram p.12
Throttle & Brake

Types p.20-23

“9@0000@®®0000*
2@ O@®@00000000B
,000000000000,

Throttle and Brake Inputs

The two pot inputs are independently programmable to allow use of a voltage throttle or a 2-wire or
3-wire resistance throttle. Voltage throttles require only the Pot Wiper input (with I/O Ground for
the return line). Resistance throttles require Pot Wiper and Pot Low (2-wire) or Pot High, Pot Wiper,
and Pot Low (3-wire). All throttle I/O is protected against shorts to B+ or B—.

Alternatively, these two inputs can be used for analog signals other than the throttle and brake pot
inputs. Configuring the inputs for use with other signals requires VCL programming; see Chapter 10.

THROTTLE INPUT SPECIFICATIONS

. . Operating Input S/Sink Protected ESD
A L Al Voltage Impedance Current Voltage Tolerance
Throttle Pot High 15 | 0V (shorted to ;
Pot Low) 5V N/A 1 ”(‘Qoﬂ‘r’c";;”a'
Pot2 High 27 | (open circuit) _05Vto -
+
Throttle Pot Wiper | 16 . MaxV +10%) | girect
. 0.76 mA nominal '
Pot2 Wiper 17 (source, 2-wire)
Faults if above 15 mA -1Vto
Pot Low 18 0t00.25V 20 Q nom. (sink) (MaxV + 10 V)

Communications Ports

Separate CAN and serial ports provide complete communications and programming capability for
all user available controller information.

The Curtis 1313 handheld programmer and 1314 PC programmer’s 1309-serial-interface-device
plug into a connector* wired to pins 28 and 29, along with ground (pin 7) and the +12 V power
supply (pin 25); see wiring diagram, Figure 3. The Curtis “Spy” Model 840 display will connect the
the serial-port pins as shown in Figure 3.

Wiring the CAN Term H and CAN Term L pins together provides a local CAN termination of
120 Q, 0.5 W; keep the length of these wires short. CAN Term H and CAN Term L should never be
connected to any external wiring.

COMMUNICATIONS PORT SPECIFICATIONS

. . Supported
Signal Name | Pin S RS Data Range | Protected Voltage | ESD Tolerance
CANH 23 | cANopen, other 11-bitor 29- | 1o 1 Mbits 0.5V 1o
CAN L 35 bit identifier protocols (MaxV +10V)
CAN Term H 21 (no connection to +8kV
CAN Term L 34 external wiring) (direct strike)
Serial TX 28 Curtis 840 Display, as required,
1313 Handhelp Programmer, | 9.6 kbit/s to 56 -0.3Vto12V
Serial RX 29 | 1314 PC Programming Station kbit/s

* Molex Mini-Fit Jr. dual-row, 4 circuits, vehicle harness plug (e.g., p/n 39-01-2046)
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*000@®@0000000*
200000000000
000000000000,

Quick Links:
Figure 3 wiring diagram p.12

Position Feedback Input: Quadrature Encoder

Two control lines are internally configured to read a quadrature type position encoder. The encoder
is typically powered from the 5 V supply (pin 26) or 12 V supply (pin 25), but can be powered from
any external supply (from 5 V up to B+) as long as the logic threshold requirements are met. The
quadrature encoder is used in ACIM applications.

QUADRATURE ENCODER INPUT SPECIFICATIONS

. . . Input Max. Protected ESD
Signal Name Pin | Logic Threshold Impedance | Frequency Tolerance
. Rising edge= 2kQ
Position Feedback A | 31 2.9V max (internal 10 KHz -5V to (MaxV aﬁ e|::\tl
Falling edge= pull-up to to trik
Position Feedback B | 32 2.0V min +4.5V) strike)

Phase Shift 90° +30, Duty Cycle 50% +10%, no signal edge can be closer than 10 ps to an adjacent edge.

These signal tolerances must be maintained throughout the application’s operating conditions,
including voltage, temperature, speed and torque ranges.

Channel A —I—I—,—I—
[

Channel B =

360°electrical (1 cycle)

<~—>{90° =30°

180° =18°

I

<—>{>10us
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*000@®@0000000*
200000000000
000000000000,

Quick Links:

Figure 3 wiring diagram p.12

Position feedback input: Sin/Cos sensor

Two control lines are internally configured to read a Sin/Cos sensor. Position Feedback A (pin 31)
provides the sine signal, and Feedback Position B (pin 32) provides the cosine signal. The device
must be set up with one sensor revolution per mechanical revolution. The Sin/Cos sensor is used in

SPM applications.

SIN/COS SENSOR INPUT SPECIFICATIONS

. - Operating Max. Protected ESD
Signal Namg e Voltage Input Impedance Frequency Voltage Tolerance
Position Feedback A | 311 ' . | 150 kQ for voltages <5V | oo | -5V o (MaxV aﬁe'é‘t’
75 KkQ for voltages > 5V +10V) trik
Position Feedback B | 32 strike)

These signal tolerances must be maintained throughout the application’s operating conditions,
including voltage, temperature, speed and torque ranges. The Sin/Cos waveform peaks must be away
from Vas and ground by at least 0.5 V. In the example shown in the timing diagram below, Vaa =5 V.

05V

Vdd

360° mechanical (1 cycle)

90° |

Va

M|§
o

N

|/

N|§
o

b
Gnd 05V

_

N
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Quick Links:
Figure 15 p.105

Figure 4
Wiring for Type 1
throttles.

3 — APPLICATION-SPECIFIC FEATURES

Some features of the 1232E/SE - 1238E/SE controllers affect how the specific controller is wired or
parameter settings. This chapter provides background information on application-specific features,
to assist the vehicle designer in the design process.

THROTTLE WIRING

In this manual, the term throttle is used in two senses: (1) as another name for the drive throttle,
and (2) as a generic term covering both the drive throttle and the brake throttle. Wiring is the same,
whether the throttle in question is used for acceleration or (regen) braking.

Various throttles can be used with these controllers. They are characterized as one of five types in
the programming menu of the 1313/1314 programmer.

Type 1: 2-wire 5kQ-0 potentiometers

Type 2: single-ended 0-5V throttles, current source throttles, 3-wire potentiometers,
and electronic throttles

Type 3: 2-wire 0-5kQ potentiometers
Type 4: wigwag 0-5V throttles and 3-wire potentiometers
Type 5: VCL input (VCL_Throttle or VCL_Brake)

The two throttle inputs (drive throttle and brake throttle) are programmed independently.

For potentiometers, the controller provides complete throttle fault protection that meets all
applicable EEC regulations. For voltage throttles, the controller protects against out-of-range wiper
values, but does not detect wiring faults; it is therefore the responsibility of the OEM to provide full
throttle fault protection in vehicles using voltage throttles.

Throttle types 1-3 use the forward and reverse inputs (switches 7 and 8) in addition to the throttle
pot input to define the throttle command (see Figure 15). Throttle types 4 and 5 do not use the
forward and reverse inputs.

Wiring for the most common throttles is described in the following three pages and shown in the
accompanying illustrations. If a throttle you are planning to use is not covered, contact your Curtis
distributor or support engineer.

Throttle Type 1

For these 2-wire resistive potentiometers, shown in Figure 4, full throttle request corresponds to 0 Q)
measured between the pot wiper pin and the Pot Low pin. A Type 1 throttle requires the Forward &
Reverse Deadbands parameters settings be towards the higher voltage (e.g., 4.50 V) and the Forward
& Reverse Max parameters set to the lower voltage (e.g., 0.5 V). Note, this is the opposite of these
parameters' default setting. With the 2-wire rheostat in place, the throttle-wiper voltage can be check
using the Monitor » Inputs variable Throttle Pot (or Pot2Raw for the brake pot).

Pot Wiper input (Pin 16 or 17)

—T—=> FASTER

_\/\/\/\/\/\/\/ Pot Low input (Pin 18)

5kQ-0

pg. 20
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Broken wire protection is provided by the controller sensing the current flow from the pot wiper
input (pin 16 or 17) through the potentiometer and into Pot Low (pin 18). For Type 1 throttles, if
the Pot Low input current falls below 0.65 mA, a throttle fault is generated and the throttle request
is zeroed. Note: Pot Low (pin 18) must not be tied to ground (pin 7 or B-).

Throttle Type 2

With these throttles, the controller looks for a voltage signal at the wiper input. Zero throttle request
corresponds to 0 V and full throttle request to 5 V.

A variety of devices can be used with this throttle input type, including voltage sources, current
sources, 3-wire pots, and electronic throttles. The wiring for each is slightly different, as shown in
Figure 5, and they have varying levels of throttle fault protection.

When a voltage source is used as a throttle, it is the responsibility of the OEM to provide appropriate
throttle fault detection. For ground-referenced 0-5V throttles, the controller will detect open breaks
in the wiper input but cannot provide full throttle fault protection.

To use a current source as a throttle, a resistor must be added to the circuit to convert the current
source value to a voltage; the resistor should be sized to provide a 0-5V signal variation over the
full current range. It is the responsibility of the OEM to provide appropriate throttle fault detection.

When a 3-wire potentiometer is used, the controller provides full fault protection in accordance
with EEC requirements. The pot is used in its voltage divider mode, with the controller providing
the voltage source and return. Throttle Pot High (pin 15) provides a current limited 5V source to the
3-wire potentiometer, and Pot Low (pin 18) provides the return path. This is the throttle shown in
the basic wiring diagram (Figure 3) for the drive throttle and for the brake throttle.

Complementing the controllers, Curtis offers both Hall-effect and 3-wire potentiometer throttles
which are easily integrated into vehicles.

Hall-effect voltage throttles:

The Curtis FP Series of throttles offers multiple pedal angles and mounting configurations (floor,
suspended, flush) with 0-5 Volt operation with a Idle Validation Switch (IVS).

The ET-XXX electronic throttle is typically used only as a
drive throttle (illustrated in Fig. 5).

These voltage throttles contains no built-in fault detection,
and the controller will detect only open wiper faults. It is the
responsibility of the OEM to provide any additional throttle
fault detection necessary.

3-wire potentiometer throttle:

The FP-10 model offers, besides the controller’s 3-wire fault
detection, two throttle spring detection switches and two
micro-switches to indicate idle validation and full throttle
circuits. This throttle can also be configured from 0-5k
(Type 3) or 5k-0 (Type 1) throttles while retaining the
detection circuits.

For help with a throttle selection, contact your Curtis
distributor or support engineer to discuss your

particular throttle requirements and the application of
Curtis FP-SCV-0022 Hall-effect throttle Curtis throttles.
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Figure 5

Voltage Source
Wiring for Type 2 throttles. 9

Sensor-referenced 0-5V source Ground-referenced 0-5V source
Q + Pot Wiper input (Pin 16 or 17)
- +
8 Pot Wiper input (Pin 16 or 17)
5 SENSOR OUTPUT (0-5V) -
%) 1/0 Ground Return (Pin 7)

I/0 Ground Return (Pin 7)

SENSOR GROUND
Current Source
Pot Wiper input (Pin 16 or 17)
Moo Sh
source throttle
1/0 Ground Return (Pin 7)
3-wire Potentiometer
Pot High output (Pin 15 or 27)

G
x
= P /I\ FASTER Pot Wiper input (Pin 16 or 17)

| -
e |
x

Pot Low input (Pin 18)

NOTE: Pins 15 and 16 are used together in the throttle pot; Pins 27 and 17 in the brake pot.

Curtis ET-XXX Electronic Throttle

B+
T_Kgﬂg'_ KSI (Pin 1)
WHT/GRN

WHT/BRN : !
GREEN : :

ORANGE E E /O Ground Return (Pin 7)

BLACK i E Throttle Pot Wiper input (Pin 16)
BLACK/WHITE E : Forward input (Pin 22)
WHITE : E Reverse input (Pin 33)
""" connector
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Figure 6
Wiring for Type 3
throttles.

Quick Links:

Figure 15 p.105

Throttle Type parameter p.46
Brake Type parameter p.48

Throttle Type 3

For these 2-wire resistive potentiometers, shown in Figure 6, full throttle request corresponds to 5
kQ measured between the pot wiper pin and the Pot Low pin.

Pot Wiper input (Pin 16 or 17)

FASTER <——
\4

_\/\/\/\/\/\/\/ Pot Low input (Pin 18)

0-5kQ

Broken wire protection is provided by the controller sensing the current flow from the wiper input
(pin 16 or 17) through the potentiometer and into Pot Low (pin 18). For Type 3 throttles, if the Pot
Low input current falls below 0.65 mA, a throttle fault is generated and the throttle request is zeroed.
Note: Pot Low (pin 18) must not be tied to ground (pin 7 or B—).

Throttle Type 4

Type 4 throttles operate in wigwag style. No signals to the controller’s forward and reverse inputs
are required; the direction is determined by the wiper input value. Only 0-5V voltage sources and
3-wire potentiometers can be used as Type 4 throttles. The controller interface for Type 4 throttles
is the same as for the corresponding Type 2 throttles; see Figure 5.

In a Type 4 throttle, the neutral point must be set up somewhere in the center of the throw, with
increasing voltage beyond this point providing increasing forward command and voltages below this
point providing increasing reverse command. For example, you might set the Forward Deadband at
2.6 V with Forward Max at 4 V, and Reverse Deadband at 2.4 V with Reverse Max at 1 V.

When a 3-wire pot is used, the controller provides full fault protection. When a voltage throttle
is used, the controller will detect open breaks in the wiper input but cannot provide full throttle
fault protection.

Throttle Type 5

Throttle Type 5 provides a different way of sending the throttle command to the controller. This
throttle type uses VCL to define the throttle signal that will be “input” into the throttle signal chain
as VCL_Throttle (see Figure 15).

This throttle type can be used for either the drive throttle or the brake throttle by using the VCL
variables VCL_Throttle or VCL_Brake (see Brake menu). How the VCL program is written will
determine the source of the throttle signal, making this a very flexible throttle input method. VCL can
be written to use the throttle or brake pot inputs, switch inputs, or CAN communication messages
as the source of the throttle signals.

Setting the Throttle Type to Type 5 also allows the throttle pot input (Pin 16) to be redefined by a
VCL program for uses other than throttle input.

Note: The option also applies to the Brake Type, which when set to Type 5 uses VCL_Brake as signal
chain for the Brake_Command (see the Brake parameter menu and Figure 15)

If you have questions regarding this throttle type, contact your Curtis distributor or support engineer.
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Quick Links:
Max Speed Controller
Limit p.73

MOTOR SPEED CONSTRAINTS

The maximum motor speed is a programmable parameter in each control mode. Regardless of which
control mode is used, the maximum motor speed the controller will allow is constrained by the
number of motor poles, the encoder pulses per motor revolution, and the maximum speed constraint
imposed by the firmware.

NOTE: The overall maximum motor speed* allowed is the least of the following three constraints:

1. Electrical Frequency Constraint

The controller is designed to output fundamental electrical frequencies up to 450 Hz. It
accomplishes this by clamping the Max Speed allowed, using the equation:

Max Speed Frequency Limit = 54000 / Number of Motor Poles

Thus, for example, an 8-pole motor running synchronously at 450 Hz would rotate at 54000/8 =
6730 rpm (max). Therefore the internal control software will limit the max speed to 6750 rpm for
an 8-pole motor. Limited over-speed is allowed, for example if the motor were to go over this speed
going down a hill, the controller will still attempt to produce the correct frequency for maximized
torque and proper control; it will not simply clamp to 450 Hz.

2. Encoder Pulses/Revolution Constraint (quadrature encoder)

The maximum encoder frequency the controller will accept is 10 kHz. To determine how fast this
constraint will allow your motor to spin, use the equation

Max Speed Encoder Limit = 600000 / Encoder Size
(e.g., a motor with a 128-pulse encoder can run up to 4687 rpm).

3. Firmware Max Speed Constraint
The maximum motor speed the controller will allow is 8000 rpm.

Max Speed RPM Limit = 8000*

*This maximum allowed speed is displayed in the Monitor » Motor » Max Speed Controller Limit variable
Note: In the case where the Max Speed parameter is the prevailing constraint, greater RPM may be possible.
Contact your Curtis distributor or support engineer to discuss your particular application.
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VOLTAGE LIMITS

The controller establishes both hardware-based voltage limits and parameter-based user defined
limits. Overvoltage protection cuts back regen braking to prevent damage to batteries and other
electrical system components due to overvoltage. Undervoltage protection prevents systems from
operating at voltages below their design thresholds

The four threshold points are calculated from the Nominal Voltage, Undervoltage Kp and Ki, User
Overvoltage, and User Undervoltage parameter settings and the controller’s minimum voltage and
maximum voltage ratings. Note that both the KSI (pin 1) and the B+ terminal (when the main is
closed) are at battery voltage, and the capacitor bank is precharged via KSI prior to the main closure.

Overvoltage = Either Max Voltage (see Table D-1)
or User Overvoltage x Nominal Voltage, whichever is lower.

Quick Links: Severe Overvoltage = Overvoltage (see previous item) + 10V.

Controller voltage
ratings p.147 Undervoltage = Either Min Voltage (see Table D-1)

User/parameter voltage or User Undervoltage x Nominal Voltage, whichever is higher.
limits p.62

Severe Undervoltage = Either drive current cut back to 0% for 64 ms or Brownout
Voltage * (see Table D-1) is reached, whichever comes first.

* The Brownout Voltage is determined by the controller base type and cannot be changed. When
the controller's capacitor voltage falls below the Brownout voltage the bridge is switched off (i.e.,
motor current is switched off). If the capacitor voltage stays below the Brownout voltage for > 64
milliseconds the controller will reset (equivalent to cycling the keyswitch). If the capacitor voltage
rises above the Brownout voltage before 64 ms have passed the bridge will be re-enabled. The Severe
Undervoltage point cannot be set lower than the Brownout voltage.

BATTERY DISCHARGE INDICATOR

The lead-acid battery discharge indicator (BDI) algorithm continuously calculates the battery state-
of-charge from the B+ voltage, whenever the main contactor is closed. The result of the BDI algorithm
is the variable BDI Percentage, which is viewable in the 1313/1314 menu Monitor » Battery. When
KSI is turned off, the present BDI Percentage is stored in nonvolatile memory.

The standard values for volts per cell are as follows, for flooded lead-acid batteries and sealed
maintenance-free lead-acid batteries.

Battery Type
Flooded Sealed
Reset Volts Per Cell 2.09 2.09
Full Volts Per Cell 2.04 2.04
Empty Volts Per Cell 1.73 1.90

Use the standard values for your type of batteries as the starting point in setting the reset, full,
and empty volts-per-cell parameters. Note: For non lead-acid batteries, including Lithium-Ion
battery packs, use the pack's or cell manufacturer's approved Battery Management System (BMS)
for determining BDI.
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4 — PROGRAMMABLE PARAMETERS

These controllers have a number of parameters that can be programmed using a Curtis 1313 handheld
programmer or 1314 PC Programming Station. The programmable parameters allow the vehicle’s
performance to be customized to fit the needs of specific applications.

PROGRAMMING MENUS

The programmable parameters are grouped into nested hierarchical menus, as shown in Table 3.

Motor response tuning

Motor response characteristics can be tuned through speed control or through torque control,
depending on the application. Use the Control Mode Select parameter (page 31) to select which
tuning mode you will use:

o Speed Mode Express
o Speed Mode

» Torque Mode.

Speed Mode Express is a simplified version of Speed Mode with a reduced set of parameters that is
adequate for most speed-controlled applications.

Use Speed Mode or Speed Mode Express for applications where throttle input corresponds to motor
speed output.

Use Torque Mode for applications where throttle input corresponds to motor torque output.

Note: You can tune using torque control or speed control, but not both. For example, if you adjust a
torque control parameter while Speed Mode or Speed Mode Express has been selected as your tuning
mode, the programmer will show the new setting but it will have no effect.

We strongly urge you to read Chapter 6, Initial Setup, before adjusting any of the parameters.

Even if you opt to leave most of the parameters at their default settings, it is imperative that you
N OTI c E perform the procedures outlined in Chapter 6, which set up the basic system characteristics for
your application.

Parameter change faults

Parameters marked PCF in the menu charts will set a Parameter Change Fault (code 49) if they are
changed while the motor bridge is enabled (interlock = On). Although the parameter will be changed,
the fault will prevent motor control functions until the fault is cleared by cycling the keyswitch. If
the motor bridge is disabled (interlock = Oft ), changing these parameters will not cause a fault and
the changes will take effect immediately.
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Table 3 Programmable Parameters Menus: 1313/1314 Programmer

CONTROL MODE SELECT................ p. 31

0 - SPEED MODE EXPRESS............. p. 31
— Max Speed
—Kp
—Ki
— Accel Rate
— Decel Rate
— Brake Rate
— Pump Enable
— Regen Lower Enable

1 - SPEED MODE MENU...................... p.32
— SPEED CONTROLLER........... p. 32
— Max Speed

—Kp
—Ki LS
— Ki HS
—VEL FEEDFORWARD.....p. 33
— Kvff
— Build Rate
— Release Rate
—ACC FEEDFORWARD..... p. 34
— Kaff
— Kbff
— Build Rate
— Release Rate
— RESPONSE..........cccovvveirinnne p. 35
— Full Accel Rate HS
— Full Accel Rate LS
— Low Accel Rate
— Neutral Decel Rate HS
— Neutral Decel Rate LS
— Full Brake Rate HS

— Full Brake Rate LS
— Low Brake Rate

— FINE TUNING............ p. 36
— Partial Decel Rate
— HS (High Speed)
— LS (Low Speed)
— Reversal Soften

— Max Speed Accel

— Max Speed Decel

4 — PROGRAMMABLE PARAMETERS

— RESTRAINT.......cooriiiiie p. 37

CURRENT LIMITS MENU................. p. 43

— Restraint Forward

— Restraint Back

— Soft Stop Speed

— POSITION HOLD............... p. 38

— Position Hold Enable

— Position Hold Timeout Time

—Kp

— Kd

— Zero Speed Threshold

— Zero Speed Threshold Time

— Position Hold Settling Time

— Entry Rate

— Exit Rollback Reduction
—Pump Enable..................... p.39

—Regen Lower Enable.......... p.39

2 - TORQUE MODE MENU

— SPEED LIMITER..........ccccoeuneeee. p. 39

— Max Speed
—Kp
— Ki
— Kd
—RESPONSE .........cccevevvrreiirernee p.40

— Drive Current Limit

— Regen Current Limit

— Brake Current Limit

— EMR Current Limit

— Interlock Brake Current Limit

— POWER LIMITING MAP.......... p.43
— PL Nominal Speed

— Delta Speed
— DRIVE LIMITING MAP..... p. 44
— Nominal

— Plus Delta

— Plus 2x Delta

— Plus 4x Delta

— Plus 8x Delta

— REGEN LIMITING MAP... p. 45

— Nominal

— Plus Delta

— Plus 2x Delta

— Plus 4x Delta

— Plus 8x Delta

THROTTLE MENU........c.ccorereinrrrnnnee p. 46

— Accel Rate

— Accel Release Rate

— Brake Rate

— Brake Release Rate

— Neutral Braking

— Neutral Taper Speed

— Forward Full Restraint Speed

— Throttle Type

— Forward Deadband
— Forward Map

— Forward Max

— Forward Offset

— Reverse Deadband
— Reverse Map

— Reverse Max

— Reverse Offset

— Throttle Filter

— HPD SRO Type
— Back Full Restraint Speed — Sequencing Delay
— FINETUNING......covvvrerrrrnes p. 41 —VICL Throttle Enable
— Creep Torgue BRAKE MENU...o e p. 48
— Brake Full Creep Cancel — Brake Pedal Enable
— Creep Build Rate — Brake Type
— Creep Release Rate — Brake Deadband
— Gear Soften — Brake Map
— Brake Taper Speed — Brake Max
— Reversal Soften — Brake Offset
— Max Speed Decel — Brake Filter
— VCL Brake Enable
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Table 3 Programmable Parameters Menus: 1313/1314 Programmer continued

EM BRAKE CONTROL MENU..... p. 49

— Brake Type

— Pull In Voltage

— Holding Voltage

— Battery Voltage Comp.

— Set EM Brake On Fault

— Zero Speed Threshold

— Zero Speed Threshold Time
— Position Hold Settling Time
— Brake Set Time

— Torque Release Time

— Brake Release Time

— Torque Preload Time

— Torque Preload Enable

— Save Torque Preload

— Torque Preload Cancel Delay
— EM Brake Fault Motor Revs

— FAULT CHECKING............ccccvneee. p.54 —MOTOR FEEDBACK OPTIONS.............. p.59
— Driver1 Checks Enable — Feedback Type
— Driver2 Checks Enable — Swap Feedback Direction
— Driver3 Checks Enable — 1-ENCODER.........cccoveverrcrerrrnene. p 59
— Driver4 Checks Enable — Encoder Steps

— PD Checks Enable
— External Supply Max
— External Supply Min

DRIVERS MENU.........coveveernne p.51
— MAIN CONTACTOR......... p. 51
— Main Enable

— Main Interlock Type
— Pull In Voltage
— Holding Voltage
— Battery Voltage Comp.
— Interlock Type
— Open Delay
— Weld Check Enable
— Main DNC Check Enable
— Main DNC Check Threshold
— Precharge Enable
— PROPORTIONAL DRIVER... p. 53

— PD Enable
— Hyd Lower Enable
— PD Max Current
— PD Min Current
— PD Dither %
— PD Dither Period
— PD Kp
— PD Ki
—DRIVER 3.....cceiiiine. p. 53

— Contactor Enable
— Pull In Voltage

— Holding Voltage
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— PWM FREQUENCY........c.cocuevennee. p.54
MOTOR MENU........coeerrrerererererere e p. 54
— Typical Max Speed
— CONTROL ALGORITHMS................... p.55

— Motor Technology

— 0-ACIM (INDUCTION MOTOR)........ p.55

— CHARACTERIZATION TEST........ p. 55

— Test Enable

— Test Throttle

— Motor Poles

— Max Test Speed

— Max Text Current

— SlipGain

— Current Reg Tuning Test Enable
— FIELD WEAKENING CONTROL.... p. 56

— FW Base Speed

— Field Weakening Drive

— Weakening Rate Drive

— Min Field Current
— Swap Two Phases................... p. 57
— MotorType.....ccooevveieiierie, p. 57
— LOS (Limited Operating Strategy)... p. 58

— ENCODER FAULT SETUP.......... p. 60
— Fault Detection Enable

— Encoder Pulse Fault Detect Time
— Fault Stall Time
— 2-SIN/COS.......coovevvereerererererne, p. 60
— Sin Cos Fault Threshold
— Sin Cos Fault Threshold High
— Sin Cos Fault Time
— Sin Min
— Sin Max
— Cos Min
— Cos Max
— TEMPERATURE CONTROL............. p. 61
— Sensor Enable

— Sensor Type

— Sensor Offset

— Braking Thermal Cutback Enable
— Temperature Hot

— Temperature Max

— MotorTemp LOS Max Speed

BATTERY MENU...........ccoociiiiniiinne. p. 62

— LOS Upon Encoder Fault
— LOS Max Speed
— LOS Max Current
— LOS Max Mod Depth
— LOS Accel Rate
— LOS Decel Rate
— 1-SPM (SURFACE PM MOTOR)...... p. 59

— Nominal Voltage

— Kp UV

— Ki UV

— User Overvoltage
— User Undervoltage
— Reset Volts Per Cell
— Full Volts Per Cell
— Empty Volts Per Cell
— Discharge Time

— BDI Reset Percent

— CHARACTERIZATION TESTS...... p. 59

— Test Enable

— Test Throttle

— Max Test Speed
— Max Test Current

DUAL DRIVE MENU ............ see Dual Drive
addendum,
Document number:
53097 DUAL-DRIVE
SUPPLEMENT_0s31.
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Table 3 Programmable Parameters Menus: 1313/1314 Programmer continued

VEHICLE MENU.............cccoevvrieriienne. p. 64
— Metric Units
— Speed to RPM
— Capture Speed 1
— Capture Speed 2
— Capture Distance 1
— Capture Distance 2
— Capture Distance 3

EMERGENCY REVERSE MENU ............ p. 65
—EMR Enable
—EMR Type
—EMR Dir Interlock
—EMR Time Limit
—EMR Speed
—EMR Accel Rate
—EMR Decel Rate

INTERLOCK BRAKING MENU.............. p. 66
— Enable
— Decel Rate HS
— Decel Rate LS
— Interlock Brake Timeout

CAN INTERFACE MENU...................... p. 67
— CANopen Interlock
— CAN Node ID 1
— CAN Node ID 2
— CAN Node ID 3
— CAN Node ID 4
— Supervisor Node ID
— Baud Rate
— Heartbeat Rate
— PDO Timeout Period
— Emergency Message Rate
— Suppress CANopen Init

RESET CONTROLLER..............cccc..... p. 68
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Parameter name
as it appears in the
programmer display.

—

CAN object index
and subindex.

CAUTION

Individual parameters are presented as follows in the menu charts:

Max Speed 100 — 8000 rpm Defines the maximum allowed motor rpm at full throttle.
Max_Speed_SpdM 100 - 8000
0x3011 0x00
N2
Allowable range l
in VL units. Description of parameter’s function and,
Allowable range in the where applicable, suggestions for setting it.
programmer’s units.

Note: All bit variables have two VCL parameter names. The first is the name of the bit, and the second
is the name of the byte containing the bit. The bit position within the byte is indicated in brackets
after the byte name.

Examples:
BIT NAME: Metric_Units
BYTE NAME: OptionBits3 [Bit 5]
BIT NAME: EMR_Dir_Interlock
BYTE NAME: EMR_DIR_INTERLOCK_BITO [Bit 0]

In the second example, “_Bit0” is part of the byte name, and does not indicate the bit position; this
byte, like all bytes, has 8 available bits.

Within the menu charts, each pair of bit variable names is shown as a grouped set, with the bit name
appearing first and then the byte name:

Metric Units  On/Off

|Metric_Units  On/Off
|OptionBits3  [Bit 5]

SDO Write Message

To retain parameter values changed via CANopen SDO write messages following a key-cycle, write a
non-zero value to CAN_EE_Writes_Enabled (object index 0x332F, subindex 0x00) before changing
parameter values. This will cause changes to be written to non-volatile memory immediately. After
completing the changes, write the value zero to CAN_EE_Writes_Enabled.

Do not leave CAN_EE_Writes_Enabled at a non-zero value during normal operation, because
damage to the controller’s EEPROM may occur.

CAN SDO and PDO message transmission nomenclature:

Throughout this manual and VCL, CAN messages from the master (server) and messages from the slave
(client) controllers are noted as MOSI and MISO versus Rx and Tx. Use the MOSI and MISO in the PDO
Byte Map variables as shown on page 78, Monitor » CAN STATUS.

MOSI (Master Out Slave In) = RX (Server to Client), as per CANopen nomenclature.
MISO (Master In Slave Out) = TX (Client to Server), as per CANopen nomenclature.

If you have questions regarding the CAN features, contact your Curtis distributor or support engineer.
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CONTROL MODE SELECT

PARAMETER ALLOWABLE RANGE DESCRIPTION

Control Mode Select PCF 0-2 This parameter determines which control method will be in effect when
Control Mode Select 0-2 programming motor response:
B - 0 = SPEED MODE EXPRESS
0x3010 0x00 1 = SPEED MODE
2 = TORQUE MODE

Contact your Curtis distributor or support engineer if you are interested in a
custom control method.

NOTE: Do not change this parameter while the controller is powering the motor. Any
time this parameter is changed a Parameter Change Fault (fault code 49) is set and
must be cleared by cycling power; this protects the controller and the operator.

0 - SPEED MODE EXPRESS — SPEED MODE EXPRESS MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Max Speed 100 - 8000 rpm Defines the maximum requested motor rpm at full throttle. Partially-
Max_Speed_SpdMx 100 - 8000 applied throttle is scaled proportionately; e.g., 40% applied throttle
0x3840 0x00 corresponds to a request for 40% of the set Max Speed Value.

If Max_Speed_SpdMx is set <10 rpm (through VCL or CAN), the throttle
request is zeroed

NOTE: The maximum motor rpm is subject to the constraints on page 24.

Kp 0-100% Determines how aggressively the speed controller attempts to match
Kp_SpdMx 0-28192 the speed of the motor to the commanded speed. Larger values provide
0x3841 0x00 tighter control.

If the gain is set too high, you may experience oscillations as the controller
tries to control speed. If it is set too low, the motor may behave sluggishly
and be difficult to control.

Ki 5-100% The integral term (Ki) forces zero steady state error, so the motor will run
Ki_SpdMx 50 — 1000 at exactly the commanded speed. Larger values provide tighter control.
0x3842 0x00 If the gain is set too high, you may experience oscillations as the controller

tries to control speed. If it is set too low, the motor may take a long time to
approach the exact commanded speed.

Accel Rate 0.1-30.0s Sets the rate (in seconds) at which the speed command increases when
Accel_Rate_SpdMx 100 — 30000 throttle is applied. Larger values represent slower response.

0x3843 0x00

Decel Rate 0.1-30.0s Sets the rate (in seconds) that is used to slow down the vehicle when the
Decel_Rate_SpdMx 100 - 30000 throttle is reduced. Larger values represent slower response.

0x3847 0x00

Brake Rate 0.1-30.0s Sets the rate (in seconds) at which the vehicle slows down when brake is
Brake_Rate_SpdMx 100 - 30000 applied or when throttle is applied in the opposite direction. Larger values
0x3848 0x00 represent slower response.

Pump Enable* On/ Off This parameter should be programmed On to operate a pump motor rather
|AC_Pump_Enable_SpdM On/ Off than a vehicle drive motor. The speed-controller responsiveness and
|AC_Pump_Enable_SpdM_Bit0 [Bit 0] stability are enhanced for pump-motor applications.

0x3896 0x00

Regen Lower Enable* On/ Off This parameter works together with Pump Enable as follows:
Regen_Lower_Enable_SpdM On/ Off 1) When Pump Enable = On and Regen Lower Enable = On, the pump
Regen_Lower_Enable_SpdM_Bit0 motor can turn in both the forward and the reverse direction. In this
[Bit 0] case, the pump can be used as the Lower function (reverse). The pump
0x3877 0x00 motor, when “driven in reverse by a load” will also regen current in a

similar fashion to a drive-motor regenerative braking.

2) When Pump Enable = On and Regen Lower Enable = Off, the pump
motor can turn only in the forward direction. In this case, a hydraulic
valve is typically used for the Lower function.

3) When Pump Enable = Off, the Regen Lower Enable parameter has no
effect on the control system.

* This parameter appears twice in the parameter menu structure. Changing the value of this parameter affects the same parameter in Speed Mode.
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1- SPEED MODE — SPEED CONTROLLER MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Max Speed 100 — 8000 rpm Defines the maximum requested motor rpm at full throttle. Partially-applied
Max_Speed_SpdM 100 - 8000 throttle is scaled proportionately; e.g., 40% applied throttle corresponds to a
0x3011 0x00 request for 40% of the set Max Speed Value.
If Max_Speed_SpdM is set <10 rpm (through VCL or CAN), the throttle request
is zeroed.
NOTE: The maximum motor rpm is subject to the constraints on page 24.
Kp 0-100% Determines how aggressively the speed controller attempts to match the
Kp_Spdm 0-28192 speed of the motor to the commanded speed. Larger values provide tighter
0x3012 0x00 control.

If the gain is set too high, you may experience oscillations as the controller
tries to control speed. If it is set too low, the motor may behave sluggishly and
be difficult to control.

Ki LS 5-100% The Ki LS parameter sets the Ki for low vehicle speeds. The integral term (Ki)
Ki_SpdM 50 — 1000 forces zero steady state error, so the motor will run at exactly the commanded
0x3015 0x00 speed. Larger values provide tighter control.

If the gain is set too high, you may experience oscillations as the controller
tries to control speed. If it is set too low, the motor may take a long time to
approach the exact commanded speed.

Ki HS 5-100% The Ki HS parameter sets the integral term (Ki) for high vehicle speeds; see
Ki_HS_Spdm 50 - 1000 description of Ki LS.
0x301D 0x00
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1- SPEED MODE — VELOCITY FEEDFORWARD MENU [OPTIONAL]

PARAMETER ALLOWABLE RANGE DESCRIPTION
Kvff 0-500A This velocity feedforward term is designed to improve throttle responsiveness
Kvff_SpdM 0 - 5000 and speed controller performance, especially at low speeds.
0x3014 0x00 For traction systems, set it to 50-70% of the current needed to maintain a

very low speed, unloaded, on flat ground.

For a pump system, set it to the lowest load current (i.e., the current running
at the minimum load). Alternatively, the responsiveness of a pump speed
control loop can be significantly enhanced by using a VCL program to
continuously update this parameter to the appropriate value as each pump
load is requested.

Build Rate 0.1-50s Determines how fast the Kvff term builds up.
Vel_FF_Build_Rate_SpdM 100 - 5000 For traction systems, if you feel or hear the mechanical slop pick up abruptly
0x3093 0x00 when you move the throttle from neutral to a very small value, slowing the

build rate (i.e., setting it to a higher value) will soften the feel.

For a pump system, start with this parameter at the minimum setting. Slowing
it down (i.e., setting it to a higher value) will reduce speed overshoot if too
much feedforward has been commanded.

Release Rate 0.1-5.0s Determines how fast the Kvff term releases. If the release seems too abrupt,
Vel_FF_Release_Rate_SpdM 100 - 5000 slowing the release rate (i.e., setting it to a higher value) will soften the feel.
0x3094 0x00 It should be set fast enough (i.e., at a low enough value) to prevent the

vehicle from running on after throttle release.
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1- SPEED MODE — ACCELERATION FEEDFORWARD MENU [OPTIONAL]

PARAMETER ALLOWABLE RANGE DESCRIPTION
Kaff 0-500A This acceleration feedforward term is designed to improve throttle
Kaff_Spdm 0 - 5000 responsiveness and speed controller performance at all speeds. It can be
0x3013 0x00 thought of as a “quick start” function which can enhance responsiveness at
all speeds.
Using your present accel and decel rates, observe the average current you are
running at full throttle at low speeds while accelerating without load on flat
ground, and set Kaff to 50-70% of that value.
NOTE: If any accel rate parameters get changed, this parameter will need
to be changed also.
Kbff 0-500A This braking feedforward term is designed to improve braking responsiveness
Kbff_SpdM 0 - 5000 at all speeds.
0x3019 0x00 Using your present decel rates, observe the average current you are running
at full throttle braking, and set Kbff to that value.
Build Rate 0.1-50s Determines how fast the Kaff and Kbff terms build up.
Acc_FF_Build_Rate_SpdM 100 - 5000 For traction systems, if you feel or hear the mechanical slop pick up abruptly
0x3095 0x00 when you move the throttle from neutral to a very small value, slowing the
build rate (i.e., setting it to a higher value) will soften the feel.
For a pump system, start with this parameter at the minimum setting. Slowing
it down (i.e., setting it to a higher value) will reduce over-shoot if too much
feedforward has been commanded.
Release Rate 0.1-5.0s Determines how fast the Kaff and Kbff terms release. It should be set fast
Acc_FF_Release_Rate_SpaM 100 - 5000 enough (i.e., at a low enough value) to prevent the vehicle from running on

0x3096 0x00

after throttle release.
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1- SPEED MODE —RESPONSE MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Full Accel Rate HS 0.1-30.0s Sets the rate (in seconds) at which the speed command increases when full
Full_Accel_Rate_HS_SpdM 100 - 30000 throttle is applied at high vehicle speeds. Larger values represent slower
0x307F 0x00 response. See Figure 7 for relationship between Full Accel Rate HS, Full Accel
Rate LS, and Low Accel Rate.
Full Accel Rate LS 0.1-30.0s Sets the rate (in seconds) at which the speed command increases when full
Full_Accel_Rate LS _SpdM 100 - 30000 throttle is applied at low vehicle speeds.
0x3016 0x00
Low Accel Rate 0.1-30.0s Sets the rate (in seconds) at which the speed command increases when a
Low_Accel_Rate_SpdM 100 - 30000 small amount of throttle is applied. This rate is typically adjusted to affect low
0x3081 0x00 speed maneuverability.
Neutral Decel Rate HS 0.1-30.0s Sets the rate (in seconds) that is used to slow down the vehicle when the
Neutral_Decel_Rate_HS_SpaM 100 — 30000 throttle is released to neutral at high vehicle speeds.
0x3018 0x00
Neutral Decel Rate LS 0.1-30.0s Sets the rate (in seconds) that is used to slow down the vehicle when the
Neutral_Decel Rate LS _SpdM 100 - 30000 throttle is released to neutral at slow vehicle speeds.
0x3070 0x00
Full Brake Rate HS 0.1-30.0s Sets the rate (in seconds) at which the vehicle slows down from high speeds
Full_Brake_Rate_HS_SpdM 100 - 30000 when full brake is applied or when full throttle is applied in the opposite
0x301B 0x00 direction. See Figure 8 for relationship between Full Brake Rate HS, Full Brake
Rate LS, and Low Brake Rate.
Full Brake Rate LS 0.1-30.0s Sets the rate (in seconds) at which the vehicle slows down from low speeds
Full_Brake_Rate_LS_SpdM 100 - 30000 when full brake is applied or when full throttle is applied in the opposite
0x3077 0x00 direction.
Low Brake Rate 0.1-30.0s Sets the rate (in seconds) at which the vehicle slows down at all speeds when
Low_Brake_Rate_SpdM 100 - 30000 a small amount of brake is applied or when a small amount of throttle is
0x301A 0x00 applied in the opposite direction.
The Low Brake Rate parameter should always be set less than or equal to
the Neutral Decel Rate LS, Neutral Decel Rate HS, Full Brake Rate LS and Full
Brake Rate HS.
Figure 7
Acceleration response rate FASTER
diagram. In this example, ACCEL ANTE
HS =70%, ! ! !
LS = 30%, Full Accel Rate LS = 1.5 — [ 1
= R R L SRt PR - : % Throttl
Typ Max Spd = 5000 rpm. Full Accel Rate HS = 3.0 ! ) o 90% Throttle
s
-
P2
-
! ! |2
Low Accel Rate = 20.0 : 1 —— 10% Throttle
MOTOR SPEED " sten
LOW SPEED HIGH SPEED TYPICAL
(LS X Typical_Max_Speed)  (HS X Typical_Max_Speed)  gMenp
=30% X 5000 rppm = 1500 = 70% X 5000 rpm = 3500
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1- SPEED MODE — FINE TUNING MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Partial Decel Rate 0.1-30.0s Sets the rate (in seconds) that is used to slow down the vehicle when the
Partial_Decel_Rate_SpdM 100 - 30000 throttle is reduced without being released to neutral. Larger values represent
0x3082 0x00 slower response.
HS (High Speed) 0-100% Sets the percentage of the Typical Max Speed above which the “HS”
HS 0- 32767 parameters will be used.
0x3076 0x00
LS (Low Speed) 0-100% Sets the percentage of the Typical Max Speed below which the “LS”
LS 0- 32767 parameters will be used.
0x3075 0x00
Reversal Soften 0-100% Larger values create a softer reversal from regen braking to drive when near
Reversal_Soften 0 - 30000 zero speed. This helps soften the transition when the regen and drive current
0x3074 0x00 limits are set to different values.

Note: This parameter is not mode-specific and appears in two places.
Changing the value of this speed-mode parameter affects the parameter listed
in: Program » Torque Mode » Response » Fine Tuning » Reversal Soften.

Max Speed Accel 0.1-30.0s In some applications, the Max Speed value is changed frequently, through
Max_Speed_Accel_SpdM 100 - 30000 VCL or over the CANbus. The Max Speed Accel parameter controls the rate at
0x384A 0x00 which the maximum speed setpoint is allowed to change when the value of

Max Speed is raised. The rate set by this parameter is the time to ramp from 0
rpm to Typical Max Speed rpm.

For example, suppose Max Speed is raised from 1000 rpm to 4000 rpm. If Typical
Max Speed is 5000 rpm and the rate is 10.0 seconds, it will take

10.0 X (4000—1000) + 5000 = 6.0 seconds to ramp from 1000 rpm to 4000 rpm.

Max Speed Decel 0.1-30.0s This parameter works like the Max Speed Accel parameter, except that it
Max_Speed_Decel_SpdM 100 — 30000 controls the rate at which the maximum speed setpoint is allowed to change
0x3846 0x00 when the value of Max Speed is lowered.

For example, suppose you change Max Speed from 4500 rpm to 2500 rpm. If
Typical Max Speed is 5000 rpm, and the rate is 5.0 seconds, it will take
5.0 X (4500-2500) + 5000 = 2.0 seconds to ramp from 4500 rpm to 2500 rpm.

Quick Links:
Typical Max Speed p.54

Figure 8
Braking response rate FASTER
diagram. In this example, BRAKE RATE ‘ ‘
HS = 70%, | | |
Full Brake Rate HS =15 ----------qmmmmm oo » ‘ 100% Brake
LS = 30%, R ‘ |
Ful Brake Rate LS = 3.0 G R R R R R A
Typ Max Spd = 5000 rpm. ! ! !
| | oW
X
| | g
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| | (Y]
| | : 5
=
Low Brake Rate = 20.0 . . —— 1% Brake
' MOTOR SPEED " msten
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1- SPEED MODE — RESTRAINT MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Restraint Forward 0-100% Increases torque when on a steep hill in order to limit roll-forward speed.
Restraint_Forward_SpdM 0—- 32767 Setting this parameter too high may cause oscillations in the motor as it
0x3020 0x00 attempts to limit the roll-forward speed.
Restraint Back 0-100% Increases torque when on a steep hill in order to limit roll-back speed. Setting
Restraint_Back_SpdM 0- 32767 this parameter too high may cause oscillations in the motor as it attempts to
0x301F 0x00 limit the roll-back speed.
Soft Stop Speed 0-500 rpm Defines the speed below which a much slower decel rate is used.
Soft_Stop_Speed 0-500 A setting of zero disables the function. NOTE: This parameter works only in
0x3027 0x00 Speed Mode and Speed Mode Express.

Soft Stop Speed is useful for vehicles that have fast deceleration and vehicles
operating on ramps using the Position Hold function.

With vehicles that have fast deceleration, the driver may find the final speed
reduction to zero rpm uncomfortable; the vehicle may even rock back as a
result of tire wind-up. Soft Stop Speed allows the vehicle to slow at the same
fast rate until it reaches the set threshold, at which point it changes to a
slower (softer) deceleration rate. However, if the threshold is set too high, the
vehicle will feel like it is “running on.”

When throttle is released on a ramp, the vehicle may roll back before Position
Hold (see below) takes control. Soft Speed Stop can be used to reduce the
amount of rollback, but shouldn’t be set so high the vehicle drives up the
ramp after the throttle is released.
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1- SPEED MODE — POSITION HOLD MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION

Position Hold Enable PCF On / Off Allows the Position Hold mode to be entered at zero throttle when the vehicle

|Position_Hold_Enable on/Off comes to a stop.

|Position_Hold_Enable_Bit0 [Bit 0]

0x3893 0x00 NOTE: EM Brake Type = 2 also enables the Position Hold function

Position Hold Timeout Time 0.0-20.0s This parameter plus the Position Hold Settling Time parameter sets the maximum

Position_Hold_Timeout_Time 0-625 time the vehicle will stay in Position Hold before releasing the hold and going into

0x388C 0x00 Restraint mode. Setting the parameter to zero disables this timeout function, which
means the Position Hold will be held. Activating the interlock resets the timer.

Kp 2-100% Determines the stiffness with which position is regulated when in Position Hold

Kp_Position_Hold 82 — 2048 mode. High Kp will produce less rollback on a ramp, but more bouncing; see Kd

0x388A 0x00 below. Too much Kp will cause instability.

Kd 0-100% Determines the damping in Position Hold mode. Some damping must be present

Kd_Position_Hold 0-28192 in the control system to keep the vehicle from oscillating slowly (“bouncing”).

0x388D 0x00 High Kd will improve the dynamic response of the Position Hold controller, but too
much Kd will cause fast instability.

Zero Speed Threshold 5-100 rpm Determines the speed below which the EM brake will be commanded to set.

Zero_Speed_Threshold 5-100 Setting this speed too high may cause a jerky stop when the EM brake sets and

0x306F 0x00 stops the motor.

This parameter appears twice in the menu structure. Changing the value of this
parameter affects this (same) parameter in the EM Brake Control menu, page 49.
This parameter is re-named for 0s31. It is the same as the previous Set
Speed Threshold parameter.

Zero Speed Threshold Time 0-480 ms Determines how long motor speed must be below Zero_Speed_Threshold to
Zero_Speed_Threshold_Time 0- 60 declare zero speed.
0x30DA 0x00 This parameter appears twice in the menu structure. Changing the value of this

parameter affects this (same) parameter in the EM Brake Control menu, page 49.
This is a new parameter for 0s31

Position Hold Settling Time 0-5000 ms Determines how long the position hold function is allowed to operate before the EM
Position_Hold_Settling_Time 0-156 brake is set. This time should be set long enough for the position hold to settle.
0x3024 0x00 This parameter appears twice in the menu structure. Changing the value of this

parameter affects this (same) parameter in the EM Brake Control menu, page 50.

This parameter is re-named in 0s31. It is the same as the previous Set Speed
Settling Time parameter.

Entry Rate 5-100% When the vehicle transitions from forward speed to reverse speed or from
Entry_Rate_Position_Hold 50— 1000 reverse speed to forward speed (for example when coming to a stop going up
0x383B 0x00 a steep ramp) Position Hold is automatically entered immediately at zero speed

regardless of this parameter.

This parameter applies when the vehicle needs to be brought to a stop without
the assistance of gravity (for example when moving forward down a ramp).
This rate determines how quickly zero speed is attained after the ramped
speed request reaches zero. Setting this parameter too high will make the stop
seem very abrupt and may even cause the vehicle to roll back slightly. When
the parameter is set lower the vehicle take longer to come to a stop and enter
Position Hold mode.

Exit Rollback Reduction 0-100% This function is applicable when the Torque Preload Enable function has been
Exit_Rollback_Reduction 0-2048 Disabled (Off) or the Torque Preload Cancel Delay timer has expired (see EM
0x3844 0x00 Brake menu). Exit Rollback Reduction is only intended for use with EM Brake

Type = 2, for EM Brake Type = 1 (or 0) set Exit Rollback Reduction = 0.

Exit Rollback Reduction introduces an additional control function for the speed
controller to reduce rollback on a ramp after a throttle command is applied from

a stop. For example, suppose the vehicle is on a ramp facing upwards and, after

a forward throttle request, the vehicle rolls back slightly before climbing the ramp
(again, assuming the torque preload function is inactive). As the vehicle rolls back,
this additional term will be added to the torque request until forward speed is sensed,
to attempt to minimize rollback. The effect increases with percentage, and is disabled
when = 0%. Setting the value too high may introduce temporary oscillations.

If the Torque Preload Cancel Delay parameter expires before the throttle is re-
engaged, the torque preload [Position Hold] memory will be cleared. In such a
case, setting Exit Rollback Reduction to > 0% will reduce unintended roll. (see
page 51).
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1- SPEED MODE — PUMP PARAMETERS

PARAMETER ALLOWABLE RANGE DESCRIPTION

Pump Enable* On / Off This parameter should be programmed On to operate a pump motor

|AC_Pump_Enable_SpdM on/Off rather than a vehicle drive motor. Speed controller responsiveness and

|AC_Pump_Enable_SpdM_Bit0 [Bit 0] stability are enhanced.

0x3896 0x00

Regen Lower Enable* On / Off This parameter works together with Pump Enable as follows:

Regen_Lower_Enable_SpdM On/ Off 1) When Pump Enable = On and Regen Lower Enable = On, the pump

Regen_Lower_Enable_SpdM_Bit0 motor can turn in both the forward and the reverse direction. In this

[Bit 0] case, the pump can be used as the Lower function (reverse). The

0x3877 0x00 pump motor, when “driven in reverse by a load” will also regen current
in a similar fashion to a drive-motor regenerative braking.

2) When Pump Enable = On and Regen Lower Enable = Off, the pump
motor can turn only in the forward direction. In this case, a hydraulic
valve is typically used for the Lower function.

3) When Pump Enable = Off, the Regen Lower Enable parameter has no
effect on the control system.

*This parameter appears twice in the parameter menu structure. Changing the value of this parameter affects the same parameter in Speed Mode

Express.
2 - TORQUE MODE — SPEED LIMITER MENU
PARAMETER ALLOWABLE RANGE DESCRIPTION

Max Speed 500 - 8000 rpm Defines the maximum allowed motor rpm for torque control mode

Max_Speed_TrgM 500 — 8000 (independent of throttle position). In torque control mode, full throttle

0x3021 0x00 requests 100% of the available torque. Partially-applied throttle is scaled
proportionately; e.g., 40% applied throttle corresponds to a request for 40%
of the available torque.
NOTE: The maximum motor rpm is subject to the constraints on page 24.

Kp 0-100% Determines how aggressively the speed controller attempts to limit the speed

Ko_TrgM 0-28192 of the motor to Max Speed. Larger values provide tighter control.

0x3023 0x00 If Kp is set too high, you may experience oscillations as the controller tries to
control speed. Setting Kp too low may result in a top speed much higher than
Max Speed.

Ki 5-100% The integral term (Ki) forces zero steady state error, so the motor speed will

Ki_TrgM 50 — 1000 be limited to Max Speed. Larger values provide faster control.

0x3025 0x00 If the gain is set too high, you may experience oscillations as the controller
tries to limit speed. If it is set too low, it may take a long time for the motor to
approach Max Speed from overspeed.

Kd 0-100% Provides damping as the vehicle approaches top speed, thereby reducing

Kd_TrgM 0-28192 overshoot. If Kd is set too high, the vehicle may take too long to reach top

0x3836 0x00 speed. If Kd is set too low, the vehicle may overshoot top speed, especially
when traveling downhill.
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2 - TORQUE MODE — RESPONSE MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION

Accel Rate 0.1-30.0s Sets the rate (in seconds) at which the motor torque increases to full when

Accel_Rate_TrgM 100 - 30000 full throttle is applied. Larger values represent slower response.

0x3026 0x00

Accel Release Rate 0.1-20s Determines how quickly deceleration will be initiated when the throttle

Accel_Release_Rate_TrgM 100 - 2000 is released while the vehicle is still accelerating. If the release rate

0x3028 0x00 is fast (i.e., set to a low value), the transition is initiated abruptly. The
transition is smoother if the release rate is set to a higher value (slower
transition); however, setting the rate too high can cause the vehicle to feel
uncontrollable when the throttle is released, as it will continue to drive for
a short time.

Brake Rate 0.1-5.0s Adjusts the rate (in seconds) at which braking torque builds as the vehicle

Brake_Rate_TrgM 100 - 5000 transitions from drive to braking when direction is reversed, the brake

0x3029 0x00 pedal is applied, or neutral braking begins. Lower values represent faster
times and therefore faster braking; gentler braking is achieved by setting
the braking rate to a higher value.

Brake Release Rate 0.1-20s Adjusts the rate (in seconds) at which braking torque releases as as the

Brake_Release_Rate_TrgM 100 — 2000 vehicle transitions from braking to drive.

0x3831 0x00

Neutral Braking 0-100% Neutral braking occurs progressively when the throttle is reduced toward

Neutral_Braking_TrqM 0—- 32767 the neutral position or when no direction is selected. The neutral braking

0x302E 0x00

parameter is adjustable from 0 to 100% of the regen current limit (see
Current Limits menu, page 43).

Neutral Taper Speed
Neutral_Taper_Speed_TrgM
0x302F 0x00

200 - 6000 rpm
200 - 6000

Determines the motor speed below which neutral braking current is
adjusted when throttle is reduced; see Figure 9.

The neutral braking current is linearly reduced by the product of the
parameters, Neutral Braking x Regen Current Limit, at the Neutral Taper
Speed to the Creep Torque current at zero rpm motor speed.

NOTE: Setting the taper speed too low may cause oscillations in the motor.

Forward Full Restraint Speed
Forward_Full_Restraint_Speed _TrgM
0x386D 0x00

100 - 32000 rpm
100 — 32000

Sets the speed point at which the full regen current will be applied to
restrain the vehicle from rolling forward. Although this speed is never
actually reached, it does set the slope of the restraint strength and can
be thought of as a gain; see Figure 9. Setting this parameter too low can
cause oscillations.

Back Full Restraint Speed
Back_Full_Restraint_Speed_TrgM _TrqM
0x386E 0x00

100 - 32000 rpm
100 - 32000

Sets the speed point at which the full regen current will be applied to
restrain the vehicle from rolling in reverse (backward). Although this speed
is never actually reached, it does set the slope of the restraint strength and
can be thought of as a gain; see Figure 9. Setting this parameter too low
can cause oscillations.
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2 - TORQUE MODE — FINE TUNING MENU

0x302A 0x00

PARAMETER ALLOWABLE RANGE DESCRIPTION
Creep Torque 0-100% Determines the amount of torque applied to the vehicle at a stop with no
Creep_Torque_TrqgM 0—- 32767 throttle input, to emulate the feel of an automatic transmission automobile;
0x3071 0x00 see Fig. 9.
WARNING! When interlock is engaged, creep torque allows vehicle propulsion
if a direction is selected even though no throttle is applied. Care should be
taken when setting up this parameter.
If pedal braking is enabled (page 48), creep torque is progressively disabled
as brake is applied so as to prevent the motor from driving into the brakes and
thus wasting energy.
Creep Torque and Neutral Taper Speed interact to create the slope of the
torque response as the vehicle approaches zero speed; see Figure 9. If the
vehicle oscillates as it coasts down toward zero speed, try lowering Creep
Torque or increasing Neutral Taper Speed.
Brake Full Creep Cancel 25-100% Determines the amount of brake pedal input that will fully cancel the creep
Brake_Full_Creep_Cancel_TrgM 8192 — 32767 torque. Amount of cancellation is proportional to the brake input.
0x3837 0x00
Creep Build Rate 0.1-50s Determines how fast the programmed creep torque builds when a direction
Creep_Build_Rate_TrgM 100 - 5000 is selected.
0x3832 0x00
Creep Release Rate 0.1-50s Determines how fast the programmed creep torque releases when the brake
Creep_Release_Rate_TrqM 100 — 5000 is cancelling the creep torque or when the direction switches are cleared
0x3833 0x00 (neutral).
Gear Soften 0-100% Adjusts the throttle take-up from linear (0% setting) to an S curve. Larger
Gear_Soften_TrqM 0 - 5000 values create softer throttle take-up, in forward and reverse. Softening is

progressively reduced at higher speeds; see Figure 10.

Brake Taper Speed
Brake_Taper_Speed_TrgM
0x300F 0x00

200 - 6000 rpm
200 - 6000

Determines the motor speed below which the maximum braking current is
linearly reduced from 100% to 0% at zero speed; see Figure 11. Setting the
taper speed too low for the braking current will cause oscillations in the motor
as it attempts to brake the vehicle to a stop on very steep slopes.

Taper speed is applicable only in response to brake pedal input; it does not
affect direction reversal braking or neutral braking.

If the vehicle is in restraint when the brake is pressed, the applied braking
torque is affected by both Brake Taper Speed and Forward (or Back) Full
Restraint Speed. If the vehicle oscillates in this mode, it may be necessary to
increase one or more of these parameters.

Reversal Soften
Reversal_Soften
0x3074 0x00

0-100%
0-3000

Larger values create a softer reversal from regen braking to drive when near
zero speed. This helps soften the transition when the regen and drive current
limits are set to different values

Note: This parameter is not mode-specific and appears in two places.
Changing the value of this torque-mode parameter affects the parameter
listed in: Program » Speed Mode » Response » Fine Tuning » Reversal Soften.

Max Speed Decel
Max_Speed_Decel_TrgM
0x3835 0x00

0.1-30.0s
100 - 30000

In some applications, the Max Speed value is changed frequently, through
VCL or over the CANbus. The Max Speed Decel parameter controls the rate at
which the maximum speed setpoint is allowed to change when the value of
Max Speed is lowered. The rate set by this parameter is the time to ramp from
Typical Max Speed rpm to O rpm.

For example, suppose you change Max Speed from 3000 rpm to 1000 rpm. If
Typical Max Speed is 5000 rpm, and the rate is 5.0 seconds, it will take

5.0 X (3000-1000) + 5000 = 2.0 seconds to ramp from 3000 rpm to 1000 rpm.
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CURRENT LIMITS MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Drive Current Limit 5-100% Sets the maximum RMS current the controller will supply to the motor
Drive_Current_Limit 1638 — 32767 during drive operation, as a percentage of the controller’s full rated current.*
0x305B 0x00 Reducing this value will reduce the maximum drive torque.
NOTE: Changing this parameter requires the re-setting of the ACIM FW
Base Speed parameter (page 56).
Regen Current Limit 5-100% Sets the maximum RMS regen current, as a percentage of the controller’s full
Regen_Current_Limit 1638 — 32767 rated current.* The regen current limit applies during neutral braking, direction
0x305C 0x00 reversal braking, and speed limiting when traveling downhill.
Brake Current Limit 5-100% Sets the maximum RMS regen current during braking when a brake command
Brake_Current_Limit 1638 — 32767 is given, as a percentage of the controller’s full rated current.* Typically the
0x305D 0x00 brake current limit is set equal to the regen current limit. The brake current
limit overrides the regen current limit when the brake input is active.
EMR Current Limit 5-100% Sets the maximum RMS current allowed for braking and drive when in
EMR_Current_Limit 1638 — 32767 emergency reverse. The emergency reverse current limit is a percentage of
0x3037 0x00 the controller’s full rated current.”
Interlock Brake Current Limit 5-100% Sets the maximum RMS regen current during interlock braking, as a
Interlock_Brake_Current_Limit 1638 — 32767 percentage of the controller’s full rated current.”

0x309D 0x00

*The full rated current depends on the controller model;

see specifications in Table D-1 for the rated current of your model.

POWER LIMITING MAP MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
PL Nominal Speed 100 — 4000 rpm Sets the base speed that will be used in the drive limiting map and regen
PL_Nominal_Speed 100 - 4000 limiting map.
0x305E 0x00 NOTE: Changing this parameter requires the re-setting of the ACIM FW
Base Speed parameter (page 56).
Delta Speed 50 -1000 rpm Sets the width of the delta increment that will be used in the drive limiting
PL_Delta_Speed 50 — 1000 map and regen limiting map.

0x305F 0x00
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DRIVE LIMITING MAP MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Nominal 0-100%
PL_Drive_Nominal 0- 32767
0x3060 0x00
,F:’ILusD[r)/sltaN minal Plus Delt 0-100% These parameters define the percentage of drive current limit that
—brive_Nominal_rius_belia 0-32767 will be applied at the speeds defined by the nominal speed and delta
0x3061 0x00 speed parameters. The resulting map allows the controller to reduce
Plus 2xDelta 0-100% the drive current as a function of speed.
PL_Drive_Nominal_Plus_2xDelta 0- 32767 Reducing the power requirements at certain speeds restricts
0x3062 0x00 performance. This can be useful for reducing motor heating. It can
Plus 4xDelta 0—100% :g(t)et-)gffr?grt% keep consistent vehicle power with changing battery
PL_Drive_Nominal_Plus_4xDelta 0— 32767 \ narge. o
0x3063 0x00 Figure 12 illustrates these parameters’ typical usage.
Plus 8xDelta 0-100%
PL_Drive_Nominal_Plus_8xDelta 0- 32767
0x3064 0x00
Figure 12
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REGEN LIMITING MAP MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Nominal 0-100%
PL_Regen_Nominal 0- 32767
0x3065 0x00
Plus Delta 0-100%
PL_Regen_Nominal_Plus_Delta 0-32767 These parameters define the percentage of regen current limit or
0x3066 0x00 braking current limit that will be applied at the speeds defined by the
Plus 2xDelta 0-100% nominal speed and delta speed parameters.
PL_Regen_Nominal_Plus_2xDelta 0- 32767 The curve can be shaped to limit the available torque at various
0x3067 0x00 speeds. One possible use is to compensate for the torque-speed
Plus 4xDelta 0—100% characteristic of the motor.
PL_Regen_Nominal_Plus_4xDelta 032767 Figure 13 illustrates two typical usages of these parameters.
0x3068 0x00
Plus 8xDelta 0-100%
PL_Regen_Nominal_Plus_8xDelta 0-32767
0x3069 0x00
Figure 13
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THROTTLE MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Throttle Type PCF 1-5 These E and SE controllers accept a variety of throttle inputs. The throttle type
Throttle_Type 1-5 parameter can be programmed as follows:
0x3000 0x00 1. 2-wire rheostat, 5 kQ-0 input
2. single-ended 3-wire 1 kQ—-10 kQ potentiometer, or 0-5 V voltage source
3. 2-wire rheostat, 0-5 kQ input
4. wigwag 3-wire 1 kQ-10 kQ potentiometer, or 0-5 V voltage source
5. VCL input (VCL_Throttle)
NOTE: Do not change this parameter while the controller is powering the
motor. Any time this parameter is changed a Parameter Change Fault (fault
code 49) is set and must be cleared by cycling power; this protects the
controller and the operator.
Forward Deadband 0.00-5.00V Defines the wiper voltage at the throttle deadband threshold. Increasing the
Forward_Deadband 0—- 32767 throttle deadband setting will increase the neutral range. This parameter
0x3001 0x00 is especially useful with throttle assemblies that do not reliably return to a
well-defined neutral point, because it allows the deadband to be defined
wide enough to ensure that the controller goes into neutral when the throttle
mechanism is released.
Forward Map 0-100% Modifies the vehicle’s response to the throttle input. Setting the throttle map
Forward_Map 0- 32767 at 50% provides a linear output response to throttle position. Values below
0x3002 0x00 50% reduce the controller output at low throttle settings, providing enhanced
slow speed maneuverability. Values above 50% give the vehicle a faster, more
responsive feel at low throttle settings.
The map value is the percentage of controller output at half throttle
[(deadband + max)/2].
Forward Max 0.00-5.00V Defines the wiper voltage required to produce 100% controller output.
Forward_Max 0- 32767 Decreasing the throttle max setting reduces the wiper voltage and therefore
0x3003 0x00 the full stroke necessary to produce full controller output. This parameter
allows reduced-range throttle assemblies to be accommodated
Forward Offset 0-100% Defines the initial controller output generated when the throttle is first rotated
Forward_Offset 0-32767 out of the neutral deadband. For most vehicles, a setting of 0 is appropriate.
0x3004 0x00 For heavy vehicles, however, increasing the offset may improve controllability
by reducing the amount of throttle required to start the vehicle moving.
Reverse Deadband 0.00-5.00V
Reverse_Deadband 0—- 32767
0x3005 0x00
Reverse Map 0-100%
Reverse_Map 0- 32767
0x3006 0x00 The four Throttle Reverse parameters are the same as their Throttle Forward
Reverse Max 0.00-5.00V counterparts, and apply when the throttle direction is reversed.
Reverse_Max 0- 32767
0x3007 0x00
Reverse Offset 0-100%
Reverse_0Offset 0-32767
0x3008 0x00
Throttle Filter 0.5-125.0 Hz Sets the low pass filter cutoff frequency for the throttle pot wiper input. Higher
Throttle_Filter 131 - 32767 values will make the throttle more responsive to quick changes. Lower values

0x3030 0x00

will make the throttle less responsive to electrical noise.

NOTE: All four throttle adjustment parameters — Deadband, Map, Max, Offset — condition the raw throttle voltage into a single % throttle commana,
as shown in Figure 14 on the previous page.
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THROTTLE MENU, cont’d

PARAMETER

HPD SRO Type PCF
HPD_SRO_Type
0x30CF 0x00

ALLOWABLE RANGE
0-3
0-3

DESCRIPTION

Determines the type of HPD (High Pedal Disable) / SRO (Static Return to Off)
protection. One type of checks is available for material-handling vehicles, and
two types for golf-style vehicles.

If any of the HPD/SRO checks finds an input sequencing problem, an HPD/
Sequencing Fault (flash code 47) is set.

0. HPD/SRO feature is disabled.

1. HPD/SRO enabled for material-handling vehicles.
HPD: If throttle input is received before interlock input.
SRO: If direction input is received before interlock input.
The HPD/SRO check is made when the interlock input changes from
Off to On. If the throttle input >25% or a direction input is On, an HPD/
Sequencing Fault is set.
The HPD/Sequencing Fault is cleared by returning the throttle input to
<25% or the direction inputs to Off.

2. Golf-style HPD that allows direction reversal while driving.
HPD: Throttle input received before interlock, or throttle input received
before direction input while vehicle is stationary.
SRO: None.
The HPD check is made when the interlock input or direction inputs
are Off and the vehicle is stationary. If the throttle input >25%, an HPD/
Sequencing Fault is set.
No SRO check is made with this type, so the order of the interlock and
direction inputs does not matter.
The HPD/Sequencing Fault is cleared by returning the throttle input to
<25% or the direction inputs to Off.

3. Golf-style HPD that prevents direction reversal while driving.
HPD: I throttle input is received before interlock or direction input.
SRO: None.
HPD check is made when the interlock input or direction inputs are Off.
If the throttle input >25%, an HPD/Sequencing Fault is set. The check is
done regardless of vehicle speed, so reversing direction with throttle input
>25% will result in a fault.
No SRO check is made with this type, so the order of the interlock and
direction inputs does not matter
The HPD/Sequencing Fault is cleared by returning the throttle input to
<25% or the direction inputs to Off.

Sequencing Delay
Sequencing_Delay
0x3009 0x00

0.0-5.0s
0-1250

Typically the sequencing delay feature allows the interlock switch to be cycled
within a set time (the defined sequencing delay), thus preventing inadvertent
activation of HPD/SRO. This feature is especially useful in applications where
the interlock switch may bounce or be momentarily cycled during operation.

VCL Throttle Enable
|VCL_Throttle_Enable
|VCL_Throttle_Enable_Bit0 [Bit 0]
0x3099 0x00

On / Off
On/ Off

When programmed On, the throttle processing with fault detection will
operate normally; however, the throttle command will require VCL to define
the connection between the 0S_Throttle and VCL_Throttle variables. This
allows VCL flexibility and customization of throttle processing, while still
allowing Throttle_Type 1—4 with throttle fault detection. Figure 15 (page 105)
illustrates these throttle chains.
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BRAKE MENU
PARAMETER ALLOWABLE RANGE DESCRIPTION
Brake Pedal Enable On / Off Determines whether the brake input and algorithm are enabled, making the
|Brake_Pedal_Enable on/Off brake throttle part of the motor control command.
| OptionBits1 [Bit 3]
0x306A 0x00
Brake Type PCF -5 These E and SE controllers accept a variety of brake inputs. The brake type
Brake_Type 1-5 parameter can be programmed as follows:
0x300A 0x00 1. 2-wire rheostat, 5 kQ-0 input
2. Single-ended 3-wire 1 kQ—10 kQ potentiometer, 0-5 V voltage source
3. 2-wire rheostat, 0-5 kQ input
4. (not applicable)
5. VCL input (VCL_Brake)
NOTE: Do not change this parameter while the controller is powering the
motor. Any time this parameter is changed a Parameter Change Fault (fault
code 49) is set and must be cleared by cycling power; this protects the
controller and the operator.
Brake Deadband 0.00-5.00V
Brake_Deadband 0- 32767
0x300B 0x00
Brake Map 0-100%
Brake_Map 0-32767
0x300C 0x00 The four Brake throttle adjustment parameters are the same as their
Brake Max 0.00-5.00V Drive throttle counterparts; see descriptions and Figure 14.
Brake_Max 0- 32767
0x300D 0x00
Brake Offset 0-100%
Brake_0Offset 0- 32767
0x300E 0x00
Brake Filter 0.5-125.0 Hz Sets the low pass filter cutoff frequency for the pot2 wiper input. Higher
Brake_Filter 131 - 32767 values will make the brake more responsive to quick changes. Lower values
0x3031 0x00 will make the brake less responsive to electrical noise.
VCL Brake Enable On / Off When programmed On, the brake processing with fault detection will
VCL_Brake_Enable On/ Off operate normally; however, the brake command will require VCL to define

VCL_Brake_Enable_Bit0 [Bit 0]

0x301E 0x00

the connection between the 0S_Brake and VCL_Brake variables. This allows
VCL flexibility and customization of throttle processing, while still allowing
Brake_Type 1-3 with brake fault detection. Figure 15 (page 105) illustrates
these brake chains.
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EM BRAKE CONTROL MENU

0x30DA 0x00

PARAMETER ALLOWABLE DESCRIPTION
RANGE
Brake Type PCF 0-2 This brake type parameter determines how the EM brake responds to
EM_Brake_Type 0-2 the interlock input, throttle, and vehicle motor speed.
0x3097 0x00 0. EM brake function disabled. The EM brake driver (PWM?2) is
released to general I/0 use with VCL.

1. EM brake controlled by interlock. The controller will command
the EM brake to release whenever the interlock is closed
(Interlock = On). If interlock braking is enabled and the interlock
opens when the vehicle is moving at motor speed greater than
Set_Speed_Threshold, the controller will brake the vehicle to a
stop (with interlock braking) and then command the EM brake to
set. If the vehicle motor speed is less than this threshold, the EM
brake will engage after the Sequencing_Delay has expired.

If interlock braking is disabled, the EM brake will engage after
the Sequencing_Delay has expired.

2. EM brake controlled by interlock and neutral. The controller will
command the EM brake to set whenever the throttle command
is zero and motor speed is less than Set_Speed_Threshold.
Position Hold will be enabled automatically.

Pull In Voltage 0-100% The EM brake pull-in voltage allows a high initial voltage when the
EM_Brake_Pull_In_Voltage 0- 32767 EM brake first turns on, to ensure brake release. After 1 second, this
0x3072 0x00 peak voltage drops to the EM brake holding voltage.
Note: The Battery Voltage Compensated parameter controls whether
the pull-in and holding voltages are battery voltage compensated.
Holding Voltage 0-100% The EM brake holding voltage allows a reduced average voltage to
EM_Brake_Holding_Voltage 0- 32767 be applied to the brake coil once the brake has been released. This
0x3098 0x00 parameter must be set high enough to hold the brake released under
all shock and vibration conditions the vehicle will be subjected to.
Note: The Battery Voltage Compensated parameter controls whether
the pull-in and holding voltages are battery voltage compensated.
Battery Voltage Compensated On/ Off This parameter determines whether the EM brake pull-in and holding
EM_Brake_Battery_Voltage_Compensated On/ Off voltages are battery voltage compensated. When set On, the pull-in and
EM_Brake_Battery_Voltage_Compensated_Bit0 holding voltages are compensated relative to the set Nominal Voltage
[Bit 0] (see Battery Menu, page 62). In other words, the output voltage is
0x302D 0x00 adjusted to compensate for swings in battery voltage, so the percentage
is relative to the set Nominal Voltage—not to the actual voltage.
For example, suppose Nominal Voltage is set to 48V and Holding
Voltage is set to 75% (36V) to the output driver. Now suppose the
bus voltage dips to 40V. If Battery Voltage Compensated = On, the
output will still be 36V (Nominal Voltage x Holding Voltage) to the
coil. If Battery Voltage Compensated = Off, the output will be 30V
(Actual Voltage x Holding Voltage) to the coil.
Set EM Brake On Fault On / Off When programmed On, the controller’s operating system will set the
|EM_Brake_Set_Upon_Fault On/ Off electromagnetic brake when a fault occurs that has a fault action of
|EM_Brake_Set_Upon_Fault_Bit0 [Bit 0] ShutdownEMBrake. See the Troubleshooting Chart, Chapter 10, for a
0x309B 0x00 list of all the faults that have a fault action of ShutdownEMBrake.
Zero Speed Threshold 5-100 rpm Determines the speed below which the EM brake will be
Zero_Speed_Threshold 5-100 commanded to set. Setting this speed too high may cause a jerky
0x306F 0x00 stop when the EM brake sets and stops the motor.
This parameter appears twice in the menu structure. Changing the
value of this parameter affects this (same) parameter in the Position
Hold menu, page 38.
This parameter is re-named for 0s31. It is the same as the
previous Set Speed Threshold parameter.
Zero Speed Threshold Time 0-480ms Determines how long motor speed must be below Zero_Speed_
Zero_Speed_Threshold_Time 0-60 Threshold to declare zero speed.

This parameter appears twice in the menu structure. Changing the
value of this parameter affects this (same) parameter in the Position
Hold menu, page 38.

This is a new parameter for 0s31
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EM BRAKE CONTROL MENU, cont’d

PARAMETER ALLOWABLE DESCRIPTION
RANGE
Position Hold Settling Time 0-5000 ms Determines how long the position hold function is allowed to operate
Position_Hold_Settling_Time 0-156 before the EM brake is set. This time should be set long enough for
0x3024 0x00 the position hold to settle.

This parameter appears twice in the menu structure. Changing the

value of this parameter affects this (same) parameter in the Position

Hold menu, page 38.

This parameter is re-named for 0s31. It is the same as the

previous Set Speed Settling Time parameter.

NOTE *

Brake Set Time 40 —2000 ms Estimated time for the EM brake to physically set after the holding
EM_Brake Set Time 5- 250 voltage is released. This determines how long the controller waits,
0x30DB 0x00 after removing voltage from the brake, before released the torque.

This should be set longer than the actual brake setting time to

ensure the vehicle doesn’t move before the brake fully engages.

This is a new parameter for 0s31.

Torque Release Time 40 -2000 ms Time to release torque after EM Brake has set and motor has

EM_Brake_Torque_Release_Time 5- 250 stopped (EMBrakeEngagedAndStopped state).

0x30DC 0x00 This is a new parameter for 0s31.

Brake Release Time 40 -2000 ms Estimated time for the EM brake to physically release after the pull-

EM_Brake_Release_Time 5- 250 in voltage is applied. This is used to ensure the position hold torque

0x3073 0x00 buildup is complete before the brake releases. When set too low, the
vehicle may experience rollback on EM brake release.

This parameter is re-named for 0s31. It is the same as the

previous Release Delay parameter

Torque Preload Time 0-800 ms Estimated worst-case time to build up the torque required to hold

EM_Brake_Torque_Preload_Time 0- 100 the vehicle stationary on a hill prior to EM brake release.

0x3090 0x00 This is used in conjunction with Release Delay to determine when
to release the brake and allow the speed request to slew away from
zero.

This parameter is re-named for 0s31. It is the same as the

previous Torque Preload Delay parameter

NOTE *

Torque Preload Enable On / Off When enabled, this function eliminates rollback when the throttle is
|EM_Brake_Torque_Preload_Enable On/ Off re-engaged on a ramp by forcing the vehicle to first enter position-
|EM_Brake_Torque_Preload_Enable_Bit0 [Bit 0] hold before setting the EM brake, and then “remembering” the
0x389D 0x00 amount of torque that was necessary to hold it on the ramp. When
throttle is re-engaged, this value is loaded in the motor before the

EM brake is released. The torque value is cleared automatically

when KSI power is cycled.

0ff = When a valid throttle input is received, the speed controller
will start with no torque preload as soon as the Release Delay
expires. This will allow some rollback when the EM brake
releases. This rollback can be reduced by raising the Exit
Rollback Reduction parameter in the Position Hold Menu
(page 38).

On = When a valid throttle input is received, the speed controller will
start with a pre-set torque as measured by position-hold when
the vehicle came to a stop.

NOTE *

Save Torque Preload On/Off This parameter controls whether the EM Brake torque preload is
|Save_ Torque_Preload On/Off saved over a keyswitch cycle. If Torque_Preload_Cancel_Delay

|Save_Torque_Preload_Bit0 [Bit 0]
0x38C9 0x00

is nonzero and this parameter = On, the timer starts again upon
startup (KSI cycle) such that the countdown is from the full value of
the Torque_Preload_Cancel_Delay parameter.

This is a new parameter for 0s31.

NOTE: *This parameter is applicable only when Speed Mode or Speed Mode Express is selected and either Position Hold Enable = On or EM Brake Type = 2.

4 — PROGRAMMABLE PARAMETERS



Return to TOC Curtis 1232E/34E/36E/38E & 1232SE/34SE/36SE/38SE Manual, os 31 — May 2017

EM BRAKE CONTROL MENU, cont’d

PARAMETER ALLOWABLE DESCRIPTION
RANGE
Torque Preload Cancel Delay 0-120s The timer starts after the EM brake is set. If the timer expires before
EM_Brake_Torque_Preload_ Cancel_Delay 0 - 15000 the throttle is re-engaged, the torque preload memory will be
0x3091 0x00 cleared. Setting this parameter to zero disables the timer, i.e., the

preload is never cancelled. The purpose of this delay is to prevent
the vehicle from lunging forward if it is unloaded on a hill such that
the torque measured by position-hold is no longer valid.

NOTE: This parameter is applicable only when Torque Preload Enable
= 0n (see parameter, previous page).

EM Brake Fault Motor Revs 1.0-20.0 Defines the allowable number of motor revolutions after the EM
EM_Brake_Fault_Motor_Revs 10 - 200 brake is set before an EM Brake Failed to Set fault is issued (fault
0x3894 0x00 code 92).

DRIVERS: MAIN CONTACTOR MENU

PARAMETER ALLOWABLE DESCRIPTION
RANGE
Main Enable On/ Off When programmed On, the controller’s native software
Main_Enable on/Off controls the main contactor when the interlock is enabled;
OptionBits1 [Bit 0] when programmed Off, the contactor is controlled by VCL.
0x306A 0x00 NOTE: With Main Enable programmed Off, the controller

will not be able to open the main contactor in serious
fault conditions and the system will therefore not meet
EEC safety requirements.

Main Interlock Type 0-1 When set to 0, the main contactor and interlock each work
Main_Interlock_Type 0-1 as determined by their respective parameters.
0x386F 0x00 When set to 1, the main contactor will pull in with KSI (like

a Type 2 interlock) but the interlock input (pin 9, Switch 3)
enables/disables drive and engages interlock braking (like a
Type 0 or Type 1 interlock).

Pull In Voltage 0-100% The main contactor pull-in voltage parameter allows a high
Main_Pull_In_Voltage 0- 32767 initial voltage when the main contactor driver first turns on,
0x303C 0x00 to ensure contactor closure. After 1 second, this peak voltage

drops to the contactor holding voltage.

NOTE: The Battery Voltage Compensated parameter (below)
controls whether the pull-in and holding voltages are battery
voltage compensated.

Holding Voltage 0-100% The main contactor holding voltage parameter allows a
Main_Holding_Voltage 0- 32767 reduced average voltage to be applied to the contactor coil
0x303D 0x00 once it has closed. This parameter must be set high enough

to hold the contactor closed under all shock and vibration
conditions the vehicle will be subjected to.

NOTE: The Battery Voltage Compensated parameter (below)
controls whether the pull-in and holding voltages are battery
voltage compensated.
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DRIVERS: MAIN CONTACTOR MENU, cont’'d

PARAMETER ALLOWABLE DESCRIPTION
RANGE

Battery Voltage Compensated On/ Off This parameter determines whether the main pull-in and
Main_Driver_Battery_Voltage_Compensated on/Off holding voltages are battery voltage compensated. When set
Main_Driver_Battery_Voltage_Compensated_Bit0 [Bit 0] 0On, the pull-in and holding voltages are set relative to the

0x302C 0x00 set Nominal Voltage (see Battery Menu, page 62). In other

words, the output voltage is adjusted to compensate for
swings in battery voltage, so the percentage is relative to the
set Nominal Voltage—not to the actual voltage.

For example, suppose Nominal Voltage is set to 48V and
Holding Voltage is set to 75% (36V) to the output driver.

Now suppose the bus voltage dips to 40V. If Battery Voltage
Compensated = On, the output will still be 36V (Nominal
Voltage x Holding Voltage) to the coil. If Battery Volt- age
Compensated = Off, the output will be 30V (Actual Voltage x
Holding Voltage) to the coil.

Interlock Type 0-2 Three interlock options are available:

Interlock_Type 0-2 0 = interlock turns on with switch 3.

0x303E 0x00 1 = interlock controlled by VCL functions.

2 = interlock turns on with KSI.

Open Delay 0.0-40.0s Applicable only when Interlock Type = 0 or 1. The delay can

Open_Delay 0- 10000 be set to allow the contactor to remain closed for a period

0x303F 0x00 of time (the delay) after the interlock switch is opened. The

delay is useful for preventing unnecessary cycling of the
contactor and for maintaining power to auxiliary functions
that may be used for a short time after the interlock switch
has opened.

Weld Check Enable On/ Off When programmed On, the controller performs a test to
Weld_Check_Enable on/Off make sure the main contactor is open (not welded shut)
OptionBits1 [Bit 2] before it is commanded to close. This test is not performed if

0x306A 0x00 this parameter is Off. The main contactor driver, however, is

always protected from short circuits.

Main DNC Check Enable On/ Off When programmed On, the controller performs a test
Main_DNC_Check_Enable on/ Off immediately after the main contactor is commanded to
OptionBits4 [Bit 7] close, to make sure the contactor has in fact closed. The test

0x306D 0x00 is not performed if this parameter is programmed Off. The

main contactor driver, however, is always protected from
short circuits.

Main DNC Runtime Threshold 0.0-200.0V Sets the threshold used for the ongoing check that ensures

Main_DNC_Runtime_Threshold 0—- 12800 the main contactor remains closed while in operation. The

0x3032 0x00 Main DNC Runtime Threshold is the maximum voltage

difference between the Keyswitch and Capacitor voltages.
When the voltage difference is above this threshold, and the
battery current is low, a Main Did Not Close fault will be set.
Setting this parameter lower will increase the sensitivity of
the fault detection. Setting this parameter too low may cause
false fault trips due to normal voltage drops between the
keyswitch and capacitor voltages.

Setting this parameter = 0 V will disable the Main Did Not
Close fault check.

Precharge Enable On / Off Turns the precharge feature on and off. Precharge provides

|Precharge_Enable on/Off a limited current charge of the controller’s internal capacitor

| OptionBits2 [Bit 6]
0x306B 0x00

bank before the main contactor is closed. This decreases
the arcing that would otherwise occur when the contactor is
closed with the capacitor bank discharged.
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DRIVERS: PROPORTIONAL DRIVER MENU

PARAMETER ALLOWABLE DESCRIPTION
RANGE

PD Enable PCF On/ Off Determines how the PWM of the proportional driver is controlled.

PD_Enable On/ Off When programmed On, it is controlled by the controller’s PD current control software. When

OptionBits1 [Bit 6] programmed Off, it is controlled by the VCL function Put_PWM (PWMS5, value); see Figure
0x306A 0x00 17, page 1009.
Hyd Lower Enable On / Off When programmed On, lowering is controlled by throttle position.

|HydTL0|{ver_E/_73b/e On/ Off When programmed Off, lowering is controlled by the VCL variable VCL_PD_Throttle; see

| OptionBits1 [Bit 7] Figure 17, page 109.
0x306A 0x00
PD Max Gurrent 0.00-2.00A *The lift-lowering speed is determined by the aperture of the proportional valve. This
PD_Max_Current 0-607 parameter sets the maximum allowed current through the valve, which in turn defines its
0x3040 0x00 aperture.
PD Min Current 0.00-2.00A *Sets the minimum allowed current through the proportional valve. Most proportional
PD_Min_Current 0-607 valves need a non-zero closed current in order to start opening immediately when Lower is
0x3041 0x00 requested.
PD Dither % 0-100 % *Dither provides a constantly changing current in the coil to produce a rapid back-and-
PD_Dither._Percent 0- 32767 forth motion of the valve; this keeps the valve lubricated and allows low-friction, precise
0x3042 0x00 movement. The PD Dither % parameter specifies the amount of dither as a percentage of

the PD max current, and is applied in a continuous cycle of add%-subtract%.

PD Dither Period 16-112 ms *Sets the period for proportional valve dither.
PD_Dither_Period 1-7
0x3043 0x00
PD Kp 1-100 % *Sets the proportional gain of the current feedback controller. Higher gains force the control
PD_Kp 828192 loop to respond quickly but may cause oscillations.
0x3044 0x00
PD Ki 1-100 % *Sets the integral gain of the current feedback controller. Integral gain tries to force
PD_Ki 327 — 32767 the error to zero. Higher gains force the control loop to respond quickly but may cause

0x3045 0x00

oscillations.

*These parameter descriptions assume the proportional driver

is being used to drive a proportional valve, and that the PD

current control software is active (PD_Enable = On).

DRIVERS: DRIVER 3 MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Contactor Enable On / Off When programmed On, VCL functions control Driver 3 as the hydraulic pump
|Hydraulic_Contactor_Enable on/0ff contactor.
|OptionBits4 [Bit 1] On: The VCL function Start_Pump() will close the pump contactor according to the
0x306D 0x00 defined pull-in and holding voltages. The VCL function Stop_Pump() will open
the pump contactor.
Off: Driver 3 will be available for general VCL usage. Start_Pump() and Stop_
Pump() will not have any effect.
Pull In Voltage 0-100% The pull-in voltage parameter allows a high initial voltage when the contactor
Driver3_Pull_In_Voltage 0- 32767 driver first turns on, to ensure contactor closure. After 1 second, this peak voltage
0x3864 0x00 drops to the contactor holding voltage.
NOTE: This voltage will be battery voltage compensated.
Holding Voltage 0-100% The holding voltage parameter allows a reduced average voltage to be applied to
Driver3_Holding_Voltage 0- 32767 the contactor coil once it has closed. This parameter must be set high enough to
0x3865 0x00 hold the contactor closed under all shock and vibration conditions the vehicle will
be subjected to.
NOTE: This voltage will be battery voltage compensated.
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DRIVERS: FAULT CHECKING MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Driver1 Checks Enable On / Off
Driver1_Checks_Enable on/ Off
OptionBits2 [Bit 1]
0x306B 0x00
Driver2 Checks Enable On/ Off
Driver2_Checks_Enable On/ Off The five Checks Enable parameters are used to enable driver and coil fault
OptionBits2 [Bit 2] detection at the five individual drivers (at Pins J1-6, J1-5, J1-4, J1-3, and J1-
0x306B 0x00 2). When a Driver Checks parameter is enabled, the associated driver, driver
. wiring, and driver load are checked to verify that the driver correctly drives the
Drn(er3 Checks Enable On/ Off load both high and low. The checks will occur regardless of the PWM output
Driver3_Checks_Enable On/ Off of the driver. The checks will detect both open and shorted conditions. When a
OptionBits2 [Bit 3] fault is detected, the controller opens the driver and issues a fault code.
0x306B 0x00 If nothing is connected to a driver, its Checks Enable parameter should be set
Driver4 Checks Enable On/ Off Off.
Driver4_Checks_Enable On/ Off NOTE: Short circuit protection is always active at these five drivers, regardless
OptionBits2 [Bit 4] of how Checks Enable is set.
0x306B 0x00
PD Checks Enable On / Off
PD_Checks_Enable On/ Off
OptionBits2 [Bit 5]
0x306B 0x00
External Supply Max 0-200 mA Sets the upper threshold of the combined current of the 5V and 12V external
External_Supply_Max 0- 800 supplies. At or above this threshold a fault will be created that can be read by
0x3046 0x00 VCL.
External Supply Min 0-200 mA Sets the lower threshold of the combined current of the 5V and 12V external
External_Supply_Min 0-800 supplies. At or below this threshold a fault will be created that can be read by

0x3047 0x00

VCL.

DRIVERS: PWM FREQUENCY PARAMETER

PARAMETER ALLOWABLE RANGE DESCRIPTION
PWM Frequency 100 - 1000 Hz This single parameter defines the frequency of Drivers 1 through 4.
PWM_Frequency 100 - 1000
0x3938 0x00

MOTOR MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Typical Max Speed 500 — 8000 rpm Set this parameter to the typical maximum motor speed of the vehicle. This
Typical_Max_Speed 500 - 8000 value does not need to be set precisely; an estimate will do. All of the vehicle

0x304D 0x00

response rates are normalized to Typical Max Speed.
For example, suppose Typical_Max_Speed is fixed at 6000 rpm, and
Full_Accel_Rate_LS_SpdM = 3.0 seconds:

If Max_Speed_SpdM = 6000 rpm, it will take 3.0 seconds to accelerate from
zero to top speed (6000 rpm).

If Max_Speed_SpdM = 3000 rpm, it will take 1.5 seconds to accelerate from
zero to top speed (3000 rpm).

If Max_Speed_SpdM = 1000 rpm, it will take 0.5 seconds to accelerate to
accelerate from zero to top speed (1000 rpm)
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MOTOR: CONTROL ALGORITHMS MENU

PARAMETER

Motor Technology
Motor_Technology

0x3814 0x00

ALLOWABLE RANGE

0-1
0-1

DESCRIPTION
Set this parameter to the type of motor in your vehicle:

0 = ACIM (Induction Motor)

1 = SPM (Surface PM Motor).
NOTE: A Parameter Mismatch Fault will result unless the Feedback Type
(page 59) matches the Motor Technology setting:
If Motor Technology = 0 (ACIM), then Feedback Type must = 1 (quadrature encoder).
If Motor Technology = 1 (SPM), then Feedback Type must = 2 (Sin/Cos sensor).

MOTOR: 0 - ACIM: CHARACTERIZATION TESTS MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Test Enable 0-1 Enables ACIM (induction motor) characterization with quadrature encoder to
IM_AutoChar_Test_Enable 0-1 begin once Test Throttle is asserted.
0x3800 0x00 See Chapter 8A for the complete description of the ACIM motor
characterization procedure.
Test Throtte -1-1 Begins ACIM characterization if the Test Enable is asserted. This parameter is
IM_Test_Throttle —1-1 also used to change the direction of the motor to the forward direction during
0x3034 0x00 ACIM motor characterization.
Important: If the motor starts to turn in the positive-rpm vehicle speed
direction, set Test Throttle = 1. If it turns in the negative-rpm direction, set
Test Throttle = -1.
See Chapter 8A for the complete description of the ACIM motor
characterization procedure.
Motor Poles 2-8 This parameter is used to select the number of poles before beginning the
IM_MotorData6 1-4 ACIM motor characterization procedure.

0x3805 0x00

See Chapter 8A for the complete description of the ACIM motor
characterization procedure and how this parameter is used.

Max Test Speed 500 - 8000 rpm This parameter is used to set the maximum motor speed allowed during ACIM

IM_AutoChar_Max_Test_Speed 500 — 8000 motor characterization.

0x38A0 0x00 See Chapter 8A for the complete description of the ACIM motor
characterization procedure and how this parameter is used.

Max Test Current 10-100% This parameter is used to set the maximum motor current allowed during

IM_AutoChar_Max_Test_Current 3277 — 32767 ACIM motor characterization.

0x38A1 0x00 See Chapter 8A for the complete description of the ACIM motor
characterization procedure and how this parameter is used.

SlipGain 0.00 —200.00 This parameter is adjusted during ACIM motor characterization to tune the

IM_MotorData8 0 - 20000 motor to deliver the maximum torque per amp.

0x3819 0x00 See Chapter 8A for the complete description of the ACIM motor
characterization procedure and how this parameter is used.

Current Reg Tuning Test Enable 0-1 This parameter is typically applicable for previously auto-characterized

IM_CR_Tuning_Test_Enable 0-1 (Type 0) induction motors. It performs only the current regulation tuning

0x388B 0x00

portion of the motor characterization on existing Type 0 motors (e.g., prior

to 0s26/30). To begin, clear any existing faults, then set the Interlock = On
and this parameter = 1. Similar to the auto-characterization routine steps in
Chapter 8A, then set Test Enable = 1 followed by setting Test Throttle = 1. The
controller will run the tuning test and issue a Parameter Change Fault when
finished.

If a new (or existing Type 0) motor is auto-characterized following the steps
in Chapter 8A, do not use this parameter, as it is automatically included in the
full auto-characterization routine.

Consult your Curtis distributor or support engineer for further assistance
based on your motor and its application.

Quick Links:

Chapter 8A (ACIM motor characterization) p.85
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MOTOR: 0 - ACIM: FIELD WEAKENING CONTROL MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
FW Base Speed 200 — 12000 rpm Sets the speed at which modulation depth has reached 100% (all available
FW_Base_Speed 200 - 12000 voltage is used) and where field weakening begins. This parameter is scaled
0x3857 0x00 by an internal motor characterization parameter, so the setting of FW Base

Speed should always be done using the tuning test, which will take into
account the scaling factor. Entering a speed observed from a torque vs. speed
plot should not be done, as this number fails to take into account the internal
scaling factor.

This parameter needs to be set during initial setup (chapter 7) and reset
each time the Motor Type or the low speed current limit is changed. For
example, if the Drive_Current_Limit (page 43) or PL_Drive_Nominal (page 44)
parameters are lowered, reset this FW Base Speed parameter.

To determine the correct value, perform this “base speed” tuning test. The test
should be run with batteries that have a reasonable charge. In either Speed
Mode or Torque Mode, set their accel rates to be fast—so the motor will

be accelerating at full current during the test. Next, set this FW Base Speed
parameter to 6000 rpm (i.e., at a high-enough speed that its value will not
interfere with the test result). From a stop, apply full throttle and accelerate

to a high-speed beyond the expected base speed. After the motor settles at
this speed for a moment, release the throttle to stop the test. Note the value
displayed in Monitor » Controller » Motor Tuning » Base Speed Captured

(page 76), and enter this value for this FW Base Speed parameter setting.

For traction motors, the test restarts each time the vehicle comes to a stop
and the throttle is released, so be sure to note the Base Speed Captured value
before driving away.

For pump motors, follow the instructions in Chapter 8A, Part 2b.

Field Weakening Drive 0-100% Sets the amount of field weakening allowed while driving the motor. Field
Field_Weakening_Drive 0-1024 Weakening Drive will affect efficiency and torque only at speeds above the
0x3033 0x00 programmed FW Base Speed. Low settings will result in better efficiency

but less torque; higher settings will result in more torque and less efficiency.
A setting of zero will disable field weakening, thus resulting in the highest
efficiency and lowest torque above base speed.

To keep motor and controller heating to a minimum (high efficiency), Field
Weakening Drive should be set just high enough to meet the high speed
performance specifications. (Typical high speed performance specifications
are maximum drive speed with full load, or maximum lift speed with full load.)
The drive current limiting map (Fig. 12, page 44) can also be used to restrict
performance at all speeds.

The maximum setting of the Field Weakening Drive parameter depends on the
type of motor characterization that was used.

If the ACIM motor was dyno characterized (i.e., sent to the Curtis factory

for characterization on the motor dyno), Field Weakening Drive can be set
anywhere in the range of 0% (lowest torque, highest efficiency) to 100%
(highest torque, lowest efficiency).

If the ACIM motor was auto characterized (i.e., characterized using the ACIM
motor characterization procedure in Chapter 8A), the range is restricted by the
results of the Field Weakening Test. For these motors, Field Weakening Drive
can be set anywhere in the range of 0% (lowest torque, highest efficiency)

to Max Field Weakening Drive (highest torque, lowest efficiency) result. For
auto characterized motors, setting Field Weakening Drive greater than the
maximum setting found in the Field Weakening Test will result in poorer
efficiency and less torque as the motor will be operating “over the slip curve.”

NOTE: The Field Weakening Drive setting will have no effect at motor speeds
below FW Base Speed.
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MOTOR: 0 - ACIM: FIELD WEAKENING CONTROL MENU, cont’d

0x3821 0x00

PARAMETER ALLOWABLE RANGE DESCRIPTION
Weakening Rate Drive 0-100% Sets the control loop gains for field weakening. Setting the rate too low may
Field_Weakening_Rate_Drive 0-500 create surging in the vehicle as it accelerates at mid to high speeds. Setting
0x383C 0x00 the rate too high may create high frequency oscillations (usually audible)
when the vehicle accelerates at mid to high speeds.
Min Field Current 0-800A Sets the field current when no torque is requested from the motor. This
Min_Field_Current 0 - 8000 current pre-fluxes the motor and can improve initial take-off at the expense of

some battery consumption.

MOTOR: 0 - ACIM: SWAP TWO PHASES AND MOTOR TYPE PARAMETERS

0x3809 0x00

PARAMETER ALLOWABLE RANGE DESCRIPTION

Swap Two Phases PCF On/ Off If, after Swap Encoder Direction has been set correctly, the vehicle drives

Swap_Two_Phases_OptionBits3 [Bit 3] on/Off in the wrong direction (i.e., drives forward when in reverse, and vice

0x306C 0x00 versa), try changing the setting of the Swap Two Phases parameter. This
parameter has the same effect as physically swapping the cables on any
two of the three motor phase connections.
Positive motor speed must be in the forward direction in order for
the emergency reverse feature to operate properly.
NOTE: Do not change this parameter while the controller is powering the
motor. Any time this parameter is changed a Parameter Change Fault
(fault code 49) is set and must be cleared by cycling power; this protects
the controller and the operator.

A W AR N I N G Adjusting this parameter can be hazardous. For instructions, see
Chapter 7, Step 12 (page 84).

Motor Type PCF 0-324 This parameter references a predefined table of motor parameters for

IM_Motor_Type 0-324 many AC induction motors. Presently, 323 motors are defined for 0s31.

Motor Type 0 is reserved for using the auto-characterization procedure in
Chapter 8A.

NOTE: Changing this parameter requires the re-setting of the FW
Base Speed parameter (page 56). Other parameters may also need to
be reset or evaluated by following the Initial Setup and Tuning Guide
chapters instructions.

Consult your Curtis distributor or support engineer for information how to
set this parameter based on your application and motor.
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MOTOR: 0 - ACIM: LOS (Limited Operating Strategy) MENU

PARAMETER

LOS Upon Encoder Fault
|LOS_Upon_Encoder_Fault

ALLOWABLE
RANGE
On/ Off
On / Off

|LOS_Upon_Encoder_Fault_Bit0 [Bit 0]

0x308F 0x00

DESCRIPTION

Limited Operating Strategy (LOS) is typically used to drive the vehicle back to
a repair center at very low speeds in the event the motor encoder fails.
Following an encoder failure ((either Encoder Fault (fault code 36) or Stall
Detected (fault code 73)), and after the Interlock is cycled, the vehicle enters
LOS mode thus allowing drive without motor encoder feedback.

In LOS mode, the ability to achieve maximum torque—even for a very short
time—is considered more important than smoothness.

When LOS mode is entered, the Encoder LOS fault (fault code 93) becomes
active and the encoder fault ((either Encoder Fault (fault code 36) or Stall
Detected (fault code 73)) is cleared.

When this parameter is programmed On, LOS mode will be entered in the
event of an encoder fault followed by an Interlock cycle.

When programmed Off, in the event of an encoder fault the encoder fault
remains and drive is disabled.

LOS Max Speed 100 - 2000 rpm This parameter indirectly defines the maximum speed for LOS mode by

Enc_LOS_Max_Speed 100 - 2000 setting the maximum frequency that corresponds to LOS Max Speed. In LOS

0x3083 0x00 mode the throttle commands a frequency that is interpolated linearly between
zero (at Throttle Command = 0%) and the programmed LOS
Max Speed (at Throttle Command = 100%).

LOS Max Current 100 - 650 A In LOS mode, a partial or full throttle command will result in the maximum

Enc_LOS_Max_Current 1000 - 6500 current set by this parameter. This current setting is clamped by the

0x3085 0x00 controller’s rated current.

LOS Max Mod Depth 15-100% In LOS mode, the maximum modulation depth acts to limit the current at

Enc_LOS_Max_Mod_Depth 177 -1182 higher speeds. This parameter should be set such that the modulation depth

0x3084 0x00 limit is reached prior to the LOS Max Speed limit, so that the motor current
will fall off from LOS Max Current at higher speeds. This may allow the
vehicle to drive longer in LOS mode, as it lessens the chance of the motor or
controller overheating.

LOS Accel Rate 2.0-15.0s Defines the rate (in seconds) at which the frequency increases when full

Enc_LOS_Accel_Rate 2000 - 15000 throttle is applied, while operating in LOS mode. This parameter should be

0x3086 0x00 set to a slow rate (high parameter value) so the frequency command has a
very slow slew rate to ensure that the max torque point is hit for a reasonable
period of time; this decreases the probability of going over the slip curve, and
allows ramps or obstacles to be overcome.

LOS Decel Rate 2.0-15.0s Defines the rate (in seconds) at which the frequency decreases when throttle

Enc_LOS_Decel_Rate 2000 - 15000 is released, while operating in LOS mode.

0x3087 0x00
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MOTOR: 1 - SPM (SURFACE PM MOTOR) CHARACTERIZATION TESTS MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Test Enable 0-1 This parameter is used to start the SPM motor characterization procedure.
PMAC_AutoChar_Test_Enable* 0-1 See Chapter 8B for the complete description of the SPM motor
0x3862 0x00 characterization procedure.
Test Throtte -1-1 Begins characterization if a Test Enable is asserted. This parameter is used to
PMAC_Test_Throttle* —1-1 change the direction of the motor to the forward direction during SPM motor
0x30D1 0x00 characterization.

Important: If the motor starts to turn in the positive-rpm vehicle speed
direction, set Test Throttle = 1. If it turns in the negative-rpm direction, set
Test Throttle = -1.

See Chapter 8B for the complete description of the ACIM motor
characterization procedure and how this parameter is used.

Max Test Speed 1000 — 6000 rpm This parameter is used to set the maximum motor speed allowed during SPM
PMAC_AutoChar_Max_Test_Speed* 1000 - 6000 motor characterization.
0x38C1 0x00 See Chapter 8B for the complete description of the SPM motor
characterization procedure and how this parameter is used.
Max Test Current 10-30% This parameter is used to set the maximum motor speed allowed during SPM
PMAC_AutoChar_Max_Test_Current* 3277 — 9831 motor characterization.
0x38C2 0x00 See Chapter 8B for the complete description of the SPM motor
characterization procedure and how this parameter is used.
* Note: revised variable name for 0s31 (i.e., the "PMAC" part of the variable name was "SPM" in 0s30, Quick Links:
and was added for "Test_Throttle"). The terms Surface Permanent Magnet (SPM) and Permanent Magnet AC Chapter 8B p.91
(PMAC) motors used within this manual refer to the same motor technology. SPM Motor

Characterization

MOTOR FEEDBACK OPTIONS

PARAMETER ALLOWABLE RANGE DESCRIPTION
Feedback Type 1-2 Set this parameter to the type of position feedback device in your vehicle:
Feedback_Type 1-2

1 = quadrature encoder

0x382E 0x00 )
2 = Sin/Cos sensor.

NOTE: A Parameter Mismatch Fault will result unless the Feedback Type
matches the Motor Technology setting (see page 55):

If Motor Technology = 0 (ACIM), then Feedback Type must = 1 (quadrature encoder).
If Motor Technology = 1 (SPM), then Feedback Type must = 2 (Sin/Cos sensor).

Swap Feedback Direction PCF On/ Off Changes the motor encoder’s effective direction of rotation. The encoder
Swap_Feedback_Direction on/ Off provides data used to calculate motor position and speed. This parameter
OptionBits3 [Bit 0] must be set such that when the motor is turning forward, the controller
0x306C 0x00 reports back a positive motor speed.

Positive motor speed must be in the forward direction in order for the
emergency reverse feature to operate properly.

NOTE: Do not change this parameter while the controller is powering the
motor. Any time this parameter is changed a Parameter Change Fault (fault

code 49) is set and must be cleared by cycling power; this protects the
A WARN I N G controller and the operator.

Adjusting this parameter can be hazardous. For instructions, see
Chapter 7, Step 10 (page 83).

MOTOR FEEDBACK 1 - ENCODER MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Encoder Steps PCF 32-256 Sets the number of encoder pulses per revolution. This must be set to match
Encoder_Steps 32-256 the encoder; see motor nameplate or its technical data for this information.
0x304B 0x00 NOTE: Do not change this parameter while the controller is powering the

motor. Any time this parameter is changed a Parameter Change Fault (fault
code 49) is set and must be cleared by cycling power; this protects the
controller and the operator.

Adjusting this parameter can be hazardous; setting it improperly
A W AR N I N G may cause vehicle malfunction, including uncommanded drive. For
instructions, see Chapter 7, Step 8 (page 82-83).
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MOTOR FEEDBACK 1 - ENCODER: ENCODER FAULT SETUP MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Fault Detection Enable On / Off When programmed On, encoder fault checking is enabled. Three fault
|Encoder_Fault_Detection_Enable on/Off conditions are checked: Encoder Fault (fault code 36, Stall Detected
|Encoder_Fault_Detection_Enable_Bit0 [Bit 0] (fault code 73), and Encoder Pulse Error (fault code 88).
0x389C 0x00
Encoder Pulse Fault Detect Time 0.0-3.0s Defines the minimum time it takes for the controller, while the
Encoder_Pulse_Fault_Detect_Time 0-94 vehicle is in motion, to detect that the encoder and the Encoder
0x393F 0x00 Steps parameter do not match. When the Encoder Steps setup is
incorrect, the motor controller cannot properly calculate AC motor field
orientation. The loss of field orientation can cause the motor to spin up
toward full speed once any throttle is applied.
This parameter sets a timer that starts once the throttle has been
moved and then released, the drive current is significant, and the
motor is still accelerating. Note that the motor can spin at high rpm
for several seconds before conditions allow the controller to properly
detect a fault.
An Encoder Pulse Error (fault code 88) is declared when this fault
is detected.
Setting the parameter to zero will disable this fault detection.
Fault Stall Time 0-10s Sets a timer when no motor encoder movement is detected.
Enc_Fault_Stall_Time 0- 5000 In Speed Modes: If no motor encoder movement is detected for the

0x3089 0x00

programmed Fault Stall Time, a Stall Detected fault (fault code 73) is issued.
In Torque Mode: If no motor encoder movement is detected for the
programmed Fault Stall Time, with maximum throttle applied, a Stall
Detected fault (fault code 73) is issued.

MOTOR FEEDBACK 2 - SIN/COS MENU

PARAMETER

Sin Cos Fault Threshold
Sin_Cos_Fault_Threshold
0x3878 0x00

ALLOWABLE RANGE

5.0 -20.0%
51-205

DESCRIPTION

Defines the allowable percent change in the Sin or Cos feedback. A Sin/Cos
Sensor Fault (fault code 36) is declared if this threshold exceeded five times
sequentially. The default value is 12.0%.

Sin Cos Fault Threshold High

20.0-100.0%

Defines the % allowable change in the SIN or COS feedback (high value used

Sin_Cos_Fault_Threshold_High 205- 1024 for first 30 seconds after interlock). This will allow the controller to adjust for
0x38CD 0x00 slight variances if the sensor was changed.

This is a new parameter for 0s31.
Sin Cos Fault Time 10-1000 ms A Sin Cos Sensor fault (fault 36) will be generated if the sensor is outside the
Sin_Cos_Fault_Time 10 - 1000 tolerance for 10ms during this amount of time.
0x38CE 0x00 This is a new parameter for 0s31.
Sin Min* 0-100% Minimum output by the Sin/Cos sensor on the Sin channel. Input detected
Feedback_Sin_Min 0-1023 at Position Feedback A (pin 31). The value is set during the SPM motor
0x3863 0x00 characterization procedure. The default value is zero.
Sin Max* 0-100% Maximum output by the Sin/Cos sensor on the Sin channel. Input detected
Feedback_Sin_Max 0-1023 at Position Feedback A (pin 31). The value is set during the SPM motor
0x385C 0x00 characterization procedure. The default value is zero.
Cos Min* 0-100% Minimum output by the Sin/Cos sensor on the Cos channel. Input detected
Feedback_Cos_Min 0-1023 at Position Feedback B (pin 32). The value is set during the SPM motor
0x385F 0x00 characterization procedure. The default value is zero.
Cos Max* 0-100% Maximum output by the Sin/Cos sensor on the Cos channel. Input detected
Feedback_Cos_Max 0-1023 at Position Feedback B (pin 32). The value is set during the SPM motor

0x382F 0x00

characterization procedure. The default value is zero.

preformed.

*These are read-only parameters, useful when cloning controllers to verify these settings, and if the proper SPM (PMAC) auto-characterization was

The four Sin/Cos Min and Max parameters’ default value is zero. This prevents the running of SPM/PMAC motors without performing the auto-

characterization.

See Chapter 8B for the SPM/PMAC Auto Characterization procedure.
Contact your Curtis distributor or support engineer to resolve any Sin/Cos sensor errors or their parameter values.
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MOTOR: TEMPERATURE CONTROL MENU

0x304F 0x00

PARAMETER ALLOWABLE DESCRIPTION
RANGE

Sensor Enable On/ Off When programmed On, the motor temperature cutback and the motor
MotorTemp_Sensor_Enable on/Off temperature compensation features are enabled. This parameter can
OptionBits3 [Bit 1] be used only if a temperature sensor has been properly configured.

0x306C 0x00 The motor temperature cutback feature will linearly cut back

the current from 100% to 0% between the Temperature Hot
and Temperature Max temperatures. The motor temperature
compensation feature will adapt the motor control algorithms to
varying motor temperatures, for improved efficiency and more
consistant performance.

Sensor Type -5 Five sensor types are predefined in the software:.

MotorTemp_Sensor_Type 1-5 Type 1  KTY83-122

0x307B 0x00 Type2  2x Type 1, in series

Type 3 KTY84-130 or KTY84-150

Type 4 2x Type 3, in series

Type 5 PT1000.
Custom sensor types can be set up easily, if none of the five
predefined types is appropriate for your application. Please contact
your Curtis distributor or support engineer.
NOTE: The industry standard KTY temperature sensors are silicon

N OTI c E temperature sensors with a polarity band; the polarity band of a

KTY sensor must be the end connected to 1/0 Ground (pin 7).

Sensor Offset -20-20°C Often the sensor is placed in the motor at a location with a known

MotorTemp_Sensor_Offset —200 - 200 offset to the critical temperature; the offset can be corrected with this

0x305A 0x00 parameter. The parameter can also be used to correct a known offset

in the sensor itself.

Braking Thermal Cutback Enable On / Off When programmed On, drive current and regen braking current will
MotorBrakingThermalCutback_Enable on/Off be cut back based on motor temperature. All forms of regen braking
MotorBraking ThermalCutback_Enable_Bit0 [Bit0] current (Regen_Current_Limit, Brake_Current_Limit, EMR_Current_

0x386C 0x00 Limit, Interlock_Brake_Current_Limit) includes emergency reverse

braking, interlock braking, brake input braking, direction reversal
braking, neutral braking, and speed limit braking.

When programmed Off, only drive current (and not regen braking
current) will be cut back based on motor temperature.

If the vehicle has mechanical brakes, setting this parameter to On
may help reduce motor heating.

Temperature Hot 0-250°C Defines the temperature at which current cutback begins.

MotorTemp_Hot 0-2500

0x304E 0x00

Temperature Max 0-250°C Defines the temperature at which current is cut back to zero.

MotorTemp_Max 0- 2500

MotorTemp LOS Max Speed
MotorTemp_LOS_Max_Speed
0x308A 0x00

100 — 3000 rpm
100 - 3000

When a Motor Temp Sensor Fault (fault code 29) is set, a LOS
(Limited Operating Strategy) mode is engaged. The maximum speed
is reduced to the programmed Max Speed in the operating mode
(Max_Speed_SpdMx, Max_Speed_SpdM, Max_Speed_TrgM) or to
\the MotorTemp_LOS_Max_Speed, whichever is lower.
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BATTERY MENU
PARAMETER ALLOWABLE RANGE DESCRIPTION
Nominal Voltage 24-96V Must be set to the vehicle’s nominal battery pack voltage. This parameter
Nominal_Voltage 1536 — 6144 is used in determining the overvoltage and undervoltage protection

0x3048 0x00

thresholds for the electronic system. See page 25 for Over, Under, and
Brownout voltage definitions and constraints.

NOTE: In all cases the 0S default Nominal Voltage is the highest value

in the controller’s range (See Table D-1). Always check and adjust this
parameter whenever using a lower nominal voltage. Scaling is 64 counts
per volt.

For example, controller 1238E-65XX has a 4880 voltage range.
Therefore, when using a 48 volt battery, the Nominal_Voltage parameter
will be 3072 (64 x 48 = 3072) in your VCL program, or as the raw
(decimal) value in TACT.

Kp UV 0.0-100.0%/V When the battery voltage goes below the undervoltage threshold (page 25),
Batt Kp_UV 0-1024 a closed loop PI (Proportional/Integral) controller is enabled in an attempt
0x380E 0x00 to keep the battery voltage from drooping. It accomplishes this by cutting
. back the drive current, thereby reducing the load on the battery.
Ki UV 0-100% ) . . . L 0
Batt Ki UV 0— 16384 The Kp term is the propprtlonal gain and is get in units of % cutback per
0%380F 0x00 volt; for example, a setting of 25 would provide full current cutback with
4V of droop.
The Ki term is the integral gain. Integral gain will accumulate the voltage
droop and attempt to bring the battery droop back to 0 V. Higher gains will
react more strongly and quickly.
Typically, Kp UV and Ki UV are used together to provide the best response. If
the linear response of the previous AC controllers is preferred, set Ki UV = 0.
User Overvoltage 105 - 200% The value of this parameter is a percentage of the Nominal Voltage setting.
User_Overvoltage 269 - 512 The User Overvoltage parameter can be used to adjust the overvoltage
0x3049 0x00 threshold, which is the voltage at which the controller will cut back regen
braking to prevent damage to the electrical system.
Typically this parameter is changed only when the controller is being used
in an application at the low end of the controller’s range: such as
a 48-80V controller being used in a system with a 48 V battery pack. In
this case, the overvoltage threshold can be raised by setting the User
Overvoltage to a higher value. The overvoltage threshold can never be
raised above the controller’s power base maximum voltage rating.
User Undervoltage 0-95% The value of this parameter is a percentage of the Nominal Voltage setting.
User_Undervoltage 0-242 The User Undervoltage parameter can be used to adjust the undervoltage

0x304A 0x00

threshold, which is the voltage at which the controller will cut back drive
current to prevent damage to the electrical system.

Typically this parameter is changed only when the controller is being
used in an application at the high end of the controller’s range: such as
a 24-36 V controller being used in a system with a 36V battery pack. In
this case, the undervoltage threshold can be lowered by setting the User
Undervoltage to a lower value. The undervoltage threshold can never be
lowered below the controller’s power base minimum voltage rating.
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BATTERY MENU, cont’d

PARAMETER ALLOWABLE RANGE DESCRIPTION
Reset Volts Per Cell 0.900 - 3.000V The reset voltage level is checked only once, when the main contactor
BDI_Reset_Volts_Per_Cell 900 - 3000 first closes. Note that the BDI Reset Percent parameter also influences the
0x3170 0x00 algorithm that determines whether BDI Percentage is reset to 100%. Reset
Volts Per Cell should always be set higher than Full Volts Per Cell.
Reset Voltage Level = Reset Volts Per Cell x number of cells in the battery
pack.*
Full Volts Per Cell 0.900 - 3.000V The full voltage level sets the B+ (capacitor voltage) that is considered
BDI_Full_Volts_Per_Cell 900 - 3000 to be 100% state-of-charge; when a loaded battery drops below this
0x3171 0x00 voltage, it begins to lose charge. Capacitor Voltage is viewable in the
programmer’s Monitor » Battery menu.
Full Voltage Level = Full Volts Per Cell x number of cells in the battery
pack.*
Empty Volts Per Cell 0.900 - 3.000V The empty voltage level sets the Capacitor Voltage that is considered to be
BDI_Empty_Volts_Per_Cell 900—- 3000 0% state-of-charge.

0x3172 0x00

Empty Voltage Level = Empty Volts Per Cell x number of cells in the
battery pack.*

Discharge Time
BDI_Discharge_Time
0x3173 0x00

0 - 600 minutes
0- 600

Sets the minimum time for the BDI algorithm to count down the BDI
Percentage from 100% to 0%. The BDI algorithm integrates the time
the filtered capacitor voltage is below the state of charge voltage level.
When that cumulative time exceeds the Discharge Time / 100, the BDI
Percentage is decremented by one percentage point and a new state of
charge voltage level is calculated.

State of Charge Level = [(Full Voltage Level - Empty Voltage Level) x BDI
Percentage / 100] + Empty Voltage Level.

BDI Reset Percent
BDI_Reset_Percent

0x3174 0x00

0-100%
0-100

When a battery has a high BDI percentage, its float voltage at KSI On
can sometimes cause false resets. The BDI Reset Percent parameter
addresses this problem by allowing the user to define a BDI Percentage
value above which the BDI Percentage variable will not reset.

When KSl is first powered on, the BDI Percentage variable will reset

to 100% only if ((Keyswitch Voltage > Reset Voltage Level) and (BDI
Percentage < BDI Reset Percent)).

*To determine the number of cells in the battery pack, divide the Nominal Voltage setting (page 62) by the battery chemistry’s nominal volts-per-cell.

Lead-acid: 2.0 V/cell, nominal.

Note: For non lead-acid batteries, including Lithium-lon battery packs, use the pack’s or cell manufacturer’s approved Battery Management System

(BMS) for determining BDI.
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VEHICLE MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
Metric Units On/ Off When this parameter is programmed On, the distance variables (Vehicle
| Metric_Units on/ Off Odometer, Braking Distance Captured, Distance Since Stop, Distance Fine,
| OptionBits3 [Bit 5] and the Capture Distance variables) will accumulate and display in metric
0x306C 0x00 units (km, meters, or decimeters). When programmed Off, the distance

variables will accumulate and display in English units (miles, feet, or inches).
Distance variables are displayed in the Monitor » Vehicle menu.

Speed to RPM 10.0 — 3000.0 This parameter affects the vehicle speed displayed in the Monitor » Motor
Speed_to_RPM 100 — 30000 menu, and also modifies the VCL variable Vehicle_Speed; it does not affect
0x304C 0x00 actual vehicle performance. The value entered for Speed to RPM is a

conversion factor that scales motor speed to vehicle speed.
KPH to RPM: (G/d)*5305, where G = gear ratio, d = tire diameter [mm].
MPH to RPM: (G/d)*336.1, where G = gear ratio, d = tire diameter [in].

Capture Speed 1 0-8000 rpm The controller captures the time it takes the motor to go from 0 rpm to

Capture_Speed_1 0- 8000 the programmed Capture Speed. The result is stored as “Time to Speed

0x3079 0x00 1” in the Monitor » Vehicle menu. This timer starts every time the motor
accelerates from zero speed.

Capture Speed 2 0-38000 rpm This parameter allows a second capture speed to be defined, and works

Capture_Speed_2 0- 8000 identically to Capture Speed 1. The result is stored as “Time to Speed 2” in

0x3886 0x00 the Monitor » Vehicle menu.

Capture Distance 1 1-1320 The controller captures the time it takes the vehicle to travel from 0 rpm

Capture_Distance_1 1-1320 to the programmed Capture Distance. The result is stored as “Time to Dist

0x307A 0x00 1” in the Monitor » Vehicle menu. This timer starts every time the vehicle

accelerates from zero speed.

Note: For accurate distance measuring, the Speed to RPM parameter must
be set correctly.

With the Metric Units parameter programmed Off, distance is in units of
feet. With Metric Units programmed On, distance is in units of meters.

Capture Distance 2 1-1320 This parameter allows a second capture distance to be defined, and works
Capture_Distance 2 1-1320 identically to Capture Distance 1. The result is stored as “Time to Dist 2” in
0x3883 0x00 the Monitor » Vehicle menu.
Capture Distance 3 1-1320 This parameter allows a third capture distance to be defined, and works
Capture_Distance_3 1-1320 identically to Capture Distance 1. The result is stored as “Time to Dist 3”in
0x3884 0x00 the Monitor » Vehicle menu.

Quick Links:

Monitor » Vehicle Menu p.77
Vehicle Speed

Vehicle Odometer
Time to Speed 1
Time to Speed 2
Time to Distance 1
Time to Distance 2
Time to Distance 3
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EMERGENCY REVERSE MENU [sPeep MODE & SPEED MODE EXPRESS only]

0x303A 0x00

PARAMETER ALLOWABLE RANGE DESCRIPTION
EMR Enable On/ Off Determines whether the emergency reverse function is active.
|EMR_Enable On/ Off On = emergency reverse is enabled.
|OptionBits1 [Bit 1] Off = emergency reverse is disabled.
0x306A 0x00
EMR Type 0-3 Determines where the input comes from for emergency reverse.
EMR_Type 0-3 0 = emergency reverse activated by switch 1 (pin 24).
0x3036 0x00 1 = emergency reverse is activated by VCL functions \Enable_Emer_Rev()
and Disable_Emer_Rev().
2 = emergency reverse activated by switch 1 (pin 24), but only if the vehicle
is moving forward (forks trailing) when emergency reverse is activated.
3 = emergency reverse is activated by VCL functions Enable_Emer_Rev()
and Disable_Emer_Rev(), but only if the vehicle is moving forward
(forks trailing) when emergency reverse is activated.
EMR Dir Interlock On / Off Determines whether the interlock switch must be turned off after
|EMR_Dir_Interlock on/Off emergency reverse before the vehicle can be driven again.
|EMR_Dir_Interlock_BitO [Bit 0] On = interlock and throttle and direction must all be cleared.
0x389F 0x00 Off = only throttle and direction must be cleared.
EMR Time Limit 0.0-30.0s Defines how long emergency reverse is allowed to be active after the
EMR_Time_Limit 0—- 3750 vehicle is moving in the reverse direction. This timer will restart if the
0x303B 0x00 vehicle ever goes forward while emergency reverse is still active. The
allowable range is 0—30 seconds, where 30 seconds is a special case of no
time out.
When emergency reverse times out, the Emer Rev Timeout fault is set.
Cycling the emergency reverse input will clear the Emer Rev Timeout fault.
To stop the vehicle after an EMR event (not move in reverse direction), set
this parameter to 0.
EMR Speed 50 — 6000 rpm Defines the maximum reverse speed of the motor (in motor rpm), when
EMR_Speed 50 — 6000 emergency reverse is active. The motor speed in reverse during an
0x3038 0x00 emergency reverse event will be the lesser of EMR_Speed and either
Max_Speed_SpdMx (for Speed Mode Express) or Max_Speed_SpdM (for
Speed Mode).
Emergency Reverse is not valid for Torque Mode. See Fig.16, Control Mode
Processing, on page 108.
EMR Accel Rate 01-3.0s Sets the rate (in seconds) at which the vehicle accelerates in the opposite
EMR_Accel_Rate 100 - 3000 direction after it has been brought to a stop. If the vehicle is already
0x3039 0x00 traveling in the reverse direction below the EMR Speed, the EMR Accel Rate
will bring the vehicle to the EMR Speed.
EMR Decel Rate 0.1-3.0s Sets the rate (in seconds) at which the vehicle brakes to a stop when
EMR_Decel_Rate 100 - 3000 emergency reverse is activated and the vehicle is moving forward. If the

vehicle is already traveling in the reverse direction above the EMR Speed,
the EMR Decel Rate will bring the vehicle down to the EMR Speed.
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INTERLOCK BRAKING MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION

Enable On / Off Determines whether the interlock braking function is active.

|Interlock_Brake_Enable On/ Off On = The controller will attempt to bring the vehicle to a stop using regen

|OptionBits3 [Bit 7] braking when the interlock signal is removed.

0x306C 0x00 Off = The controller will disable the bridge after Sequencing Delay expires
and allow the vehicle to roll freely when the interlock signal is
removed. This option is typically used only when there is a user
controlled mechanical or hydraulic brake system.

Decel Rate HS 0.1-30.0s Sets the rate (in seconds) that is used to slow down the vehicle when the

Interlock_Brake_Decel_ Rate_HS 100 - 30000 interlock is released at high vehicle speeds (speeds > HS setting). Larger

0x309F 0x00 values represent slower response.

Decel Rate LS 0.1-30.0s Sets the rate (in seconds) that is used to slow down the vehicle when the

Interlock_Brake_Decel_ Rate_LS 100 - 30000 interlock is released at low vehicle speeds (speeds < LS setting). Larger

0x309E 0x00 values represent slower response.

Interlock Brake Timeout 0.0-80s Controls the maximum allowable duration of an interlock braking event. The

Interlock_Brake_Timeout 0- 1000 timer starts as soon as the interlock signal is removed. If the time expires

0x309C 0x00

before the vehicle has slowed below the Set_Speed_Threshold, the EM
brake will engage automatically.

This timeout allows parallel usage of regen braking and the EM brake to
reduce stopping distance. If Interlock Brake Timeout expires and the motor
is still moving, regen braking will continue to retard vehicle motion in
conjunction with the EM brake.

NOTE: This parameter is only applicable when EM_Brake_Type = 1 or 2
(page 49).

Quick Links:
Speed Mode — Fine Tuning Menu p.36

HS (High Speed)
LS (Low Speed)
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CAN INTERFACE MENU

PARAMETER ALLOWABLE RANGE DESCRIPTION
CANopen Interlock On/ Off When programmed On, CAN NMT State must = 5 (operational state)
|CANopen_Interlock_Enable On/ Off in order for the interlock to be set; see Monitor » CAN Status menu, page 78.
| OptionBits3 [Bit 2]
0x306C 0x00
CAN Node ID 1 1-127 The Node ID for the primary microprocessor is determined by the state of
CAN_Node_ID_1 1-127 switches 5 and 6 at KSI turn on:
0x3140 0x00 Node_ID_1 is selected when Sw 6 = Off and Sw 5 = Off
Node_ID_2 is selected when Sw 6 = Off and Sw 5 = On
Node_ID_3 is selected when Sw 6 = On and Sw 5 = Off
Node_ID_4 is selected when Sw 6 = On and Sw 5 = On.
If the selected parameter has a Node ID of zero, the Node_ID_1 parameter
is used. If the Node_ID_1 parameter is also zero, a default ID of 38 is used.
CAN Node ID 2 1-127 See description of Node ID 1.
CAN_Node_ID_2 1-127
0x3141 0x00
CAN Node ID 3 1-127 See description of Node ID 1.
CAN_Node_ID_3 1-127
0x3146 0x00
CAN Node ID 4 1-127 See description of Node ID 1.
CAN_Node_ID_4 1-127
0x3147 0x00
Supervisor Node ID 1-127 Sets the Node ID for the supervisor microprocessor. The Node ID is the first
Supervisor_Node_ID 1-127 7 bits of the 11-bit identifier (the COB ID).
0x3872 0x00
Baud Rate -3-4 Sets the CAN baud rate for the CANopen Slave system:
CAN_Baud_Rate -3-4 —3 =20 kbit/s, —2 =50 kbit/s, — 1 =100 kbit/s, 0 = 125 kbit/s,
0x3142 0x00 1 = 250 kbit/s, 2 =500 kbit/s, 3 = 800 kbit/s, 4 = 1000 Kbit/s.
Heartbeat Rate 16 -200 ms Sets the rate at which the CAN heartbeat messages are sent from the
CANopen_Heart_Beat_Rate 4-50 CANopen Slave system.
0x1017 0x00
PDO Timeout Period 0-200 ms Sets the PDO timeout period for the CANopen Slave system. After the slave
CAN_PDO_Timeout_Period 0-50 controller has sent a PDO-TX (MISO), it will declare a PDO Timeout Fault if
0x3149 0x00 the master controller has not sent a reply PDO-RX (MOSI) message within
the set time. Either PDO1 MOSI or PDO2 MOSI will reset the timer. Setting
the PDO Timeout Period = 0 will disable this fault check.
Emergency Message Rate 16 — 200 ms Sets the minimum rate between CAN emergency messages from the
CANopen_Emergency_Rate 4-50 CANopen Slave system. This prevents quickly changing fault states from
0x3148 0x00 generating so many emergency messages that they flood the CANbus.
Suppress CANopen Init 0-1 When Suppress CANopen Init is set = 1, at KSI On the initialization of the
Suppress_CANopen_Init 0-1 CANopen system is suppressed. Typically this is done so that the VCL
0x3143 0x00 program can make changes to the CANopen system before enabling it (by
setting the variable Suppress_CANopen_Init = 0 and running the Setup_
CAN() function).
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RESET CONTROLLER PARAMETER

PARAMETER ALLOWABLE RANGE DESCRIPTION
Reset Controller 0-1 Setting this parameter = 1 will reset the controller. This reset is similar
ResetController 0-1 to resetting by cycling the keyswitch. Reset Controller has the advantage

0x3B05 0x00

of resetting without causing the parameter block to be reloaded into the

1313/1314 programmer.

CLONING CONTROLLERS
(for copying parameter settings to multiple controllers)

Once a controller has been programmed to the desired settings, these settings can be transferred
as a group to other controllers, thus creating a family of “clone” controllers with identical settings.

Cloning only works between controllers with the same model number and software version. For
example, the 1313/1314 programmer can read all the information from a 1236E-5421 controller and
write it to other 1236E-5421 controllers; however, it cannot write that same information to 1236E-
5521 or 1236SE-5621 controllers.

To perform cloning, plug the programmer (1313 or 1314) into the controller that has the desired
settings. While the steps using the 1313 versus the 1314 are slightly different in terms of screen
images, the basic concept is the same: Save the parameters from the controller to clone, which is
the act of saving a “CPF” file (Curtis Program File) using the Save/Save As . . . operations. When
saving the CPF file, chose a file name with meaning as this CPF file is used to write (clone) its data
to subsequent controllers.

For example, using the 1314 PC Programming Station, with the controller to be updated connected,
select “open” in the File menu, then navigate to the above mentioned (saved) CPF file, which will
be loaded (indicated) below the menus bar. In the Communication menu, select the “Save file to
connected system (F6)” icon, and follow the prompts to copy the settings into the controller being
cloned (i.e., the “connected System” or controller). The 1313 is slightly different, working oft the SD
card where the CPF file was saved versus the PC’s hard drive, and then using the “Restore” feature
to download the settings into the controller being cloned.

For cloning Dual Drive controllers, the Master controller parameters will also be loaded into Slave
controller, then the parameters for the Slave-vs-Master must be adjusted using the 1313/1314, as
corresponds to the differences between the master and slave dual-drive controllers. See the separate
Dual Drive manual, p/n 53097-DD, for the specific steps to preform for cloning/setup of the Master
and Slave Dual-Drive controllers.

Note: Using either programmer (1313/1314), the prompts will offer “Advanced Cloning” . . . .
Advanced Cloning is advisable ONLY under the direction of your Curtis distributor or support
engineer, because it restores all parameters, including those at a higher (hidden level). Due to possible
conflicts, select “No” in the 1313 prompt, or do not “check” the box in the 1314).

Please contact your Curtis distributor or support engineer if there are any question on cloning controllers.
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5 — MONITOR MENU

Through its Monitor menu, the 1313 handheld and 1314 PC programmers provide access to real-time
data during vehicle operation. This information is helpful during diagnostics and troubleshooting,
and also while adjusting programmable parameters and the vehicle’s initial setup.

— PD Input

— DigOut6 Input
— DigOut7 Input
— Switch 16

Table 4 Monitor Menu: 1313/1314 Programmer

— VCL Error

— Motor Characterization Error

— Parameter Mismatch Error

— Supervision Error

— CUTBACKS........cccemmrrnerancnenene p.76

— Motor Temp Cutback
— Controller Temp Cutback
— Undervoltage Cutback
— Overvoltage Cutback
— MOTOR TUNING.......cccoeverereneee p. 76

— Motor RPM
— Base Speed Captured
— Test Field Current

VEHICLE MENU............coonmvnnnrnnccecn P 77

INPUTS MENU................... p. 70 OUTPUTS MENU......ccceverererernerereraernene p.72
— Throttle Command — Analog Out
— Throttle Multiplier — Digital Out 6
— Mapped Throttle — Digital Out 7
— Throttle Pot — Driver 1 PWM
— Brake Command — Driver 2 PWM
— Mapped Brake — Driver 3 PWM
— Pot2 Raw — Driver 4 PWM
— PD Throttle — PD PWM
— Steer Pot — PD Current
— Steer Angle (deg) — 5 \Volts
— Interlock — 12 Volts
— Emer Rev — Ext Supply Current
— Analog 1 — Pot Low
— Analog 2
—_ Switch 1 BATTERY MENU.........cccccoevvmreriercrrceee. p.73
— Switch 2 — BDI
— Switch 3 — Capacitor Voltage
— Switch 4 — Keyswitch Voltage
— Switeh 5 MOTORMENU. ..o 0.73
— Switch 6
_ Switch 7 — Motor RPM
. — Max Speed Controller Limit
— Switch 8
— Driver 1 Input — Temperature
. P — MotorSpeed A
— Driver 2 Input
. — MotorSpeed B
— Driver 3 Input .
Driver 4 Input — Sin Input A
P — Cos Input B

— Rotor Postion

— Vehicle Speed

— Vehicle Odometer

— Vehicle Acceleration
— Time to Speed 1

— Time to Speed 2

— Time Between Speeds
— Time to Dist 1

— Time to Dist 2

— Time to Dist 3

— Braking Distance Captured
— Distance Since Stop
— Distance Fine

CONTROLLER MENU.........ccrevuurenrennes p. 74

CAN STATUS MENU...........coeevesrrrnnnee. p.78

5 — MONITOR MENU

— Current (RMS)
— Modulation Depth
— Frequency

— Temperature

— Main State

— EMBrake State
— Regen

— Master Timer

— VCL Error Module

— CAN Node ID

— CAN NMT State

— PDO1 MOSI Byte Map
— PDO1 MISO Byte Map
— PD02 MOSI Byte Map
— PD02 MISO Byte Map
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Monitor Menu: INPUTS

VARIABLE

Throttle Command
Throttle_Command

0x3216 0x00

DISPLAY RANGE

-100.0 - 100.0%
-32767 - 32767

DESCRIPTION
Throttle request to slew rate block.

Throttle Multiplier
Throttle_Multiplier
0x3213 0x00

-200.0 —200.0%
—-256 — 256

Multiplies or divides the throttle signal; useful in VCL throttle processing
(see Throttle Processing on page 104 and Figure 15 on page 105).

Mapped Throttle
Mapped_Throttle

0x3211 0x00

-100.0 - 100.0%
32767 - 32767

Mapped throttle request.
(see Throttle Processing on page 104 and Figure 15 on page 105).

Throttle Pot 0.00-5.50V Voltage at throttle pot wiper (pin 16).
Throttle_Pot_Raw 0 - 36044
0x3215 0x00
Brake Command 0.0 -100.0% Brake request to slew rate block.
Brake_Command 0- 32767 (see Brake Processing on page 106 and Figure 15 on page 105)
0x321A 0x00
Mapped Brake 0.0 - 100.0% Mapped brake request.
Mapped_Brake 0- 32767 (see Brake Processing on page 106 and Figure 15 on page 105)
0x3212 0x00
Pot2 Raw 0.00-5.50V Voltage at pot2 wiper (pin 17).
Pot2_Raw 0 - 36044
0x3217 0x00
PD Throttle 0.00-100.00 % Proportional driver current request.
PD_Throttle 0- 32766 (see Interfacing the Proportional Current Driver and Figure 17 on page 109)
0x3210 0x00
Steer Pot 0.00-6.25V Voltage at steer pot wiper (pin 17) on Dual Drive traction slave.
Steer_Pot_Raw 0- 32767 (reference the Dual Drive supplement manual: 53097_E&SEDD_os31)
0x38BB 0x00
Steer Angle -90-90 Steer angle degrees calculated in Dual Drive traction master.
Steer_Angle —90-90
0x38BA 0x00
Interlock On/ Off Interlock input on or off. The source of the interlock input is determined by
|Interlock_State on/ Off the Interlock Type parameter.

|System_Flags1 [Bit 0] from Switch 3 (pin 9) if Interlock Type = 0
0x322B 0x00 from VCL function if Interlock Type = 1

from KSI (pin 1) if Interlock Type = 2.

Emer Rev On/ Off Emergency reverse input on or off. The source of the emergency reverse
|EMR_State on/Off input is determined by the EMR Type parameter:
|System_Flags1 [Bit 1] from Switch 1 (pin 24) if EMR Type = 0, or 2.
0x322B 0x00 from VCL function if EMR Type = 1.
Analog 1 0.00-10.00V Voltage at analog 1 (pin 24).
Analog1_Input 0-1023
0x3204 0x00
Analog 2 0.00-10.00V Voltage at analog 2 (pin 8).
Analog2_Input 0-1023
0x3205 0x00
Switch 1 On / Off Switch 1 on or off (pin 24).

Sw_1 On/ Off

Switches [Bit 0]
0x3226 0x00
Switch 2 On / Off Switch 2 on or off (pin 8).

|sw2 On/ Off

|Switches [Bit 1]

0x3226 0x00
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Monitor Menu: INPUTS, cont’d

VARIABLE DISPLAY RANGE DESCRIPTION

Switch 3 On/ Off Switch 3 on or off (pin 9).
Sw_3 On/ Off
Switches [Bit 2]

0x3226 0x00

Switch 4 On / Off Switch 4 on or off (pin 10).
Sw_4 On/ Off
Switches [Bit 3]

0x3226 0x00

Switch 5 On / Off Switch 5 on or off (pin 11).
Sw_5 On/ Off
Switches [Bit 4]

0x3226 0x00

Switch 6 On/ Off Switch 6 on or off (pin 12).
Sw_6 On/ Off
Switches [Bit 5]

0x3226 0x00

Switch 7 On/ Off Switch 7 on or off (pin 22).
sw_7 On/ Off
Switches [Bit 6]

0x3226 0x00

Switch 8 On / Off Switch 8 on or off (pin 33).
Sw_8 On/ Off
Switches [Bit 7]

0x3226 0x00

Driver 1 Input On/ Off Driver 1 input on or off (pin 6).
sw_9 On/ Off
Switches [Bit 8]

0x3226 0x00

Driver 2 Input On/ Off Driver 2 input on or off (pin 5).
Sw_10 On/ Off
Switches [Bit 9]

0x3226 0x00

Driver 3 Input On / Off Driver 3 input on or off (pin 4).
Sw_11 On / Off
Switches [Bit 10]

0x3226 0x00

Driver 4 Input On/ Off Driver 4 input on or off (pin 3).
Sw_12 On/ Off
Switches [Bit 11]

0x3226 0x00

PD Input On / Off Proportional driver on or off (pin 2).
Sw_13 On / Off
Switches [Bit 12]

0x3226 0x00

DigOut6 Input On/ Off Digital Out 6 input on or off (pin 19).
Sw_14 On / Off
Switches [Bit 13]

0x3226 0x00

DigOut7 Input On / Off Digital Out 7 input on or off (pin 20).
Sw_15 On/ Off
Switches [Bit 14]

0x3226 0x00

Switch 16 On / Off Switch 16 on or off (pin 14).
Sw_16 On / Off
Switches [Bit 15]

0x3226 0x00
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Monitor Menu: OUTPUTS

VARIABLE DISPLAY RANGE DESCRIPTION

Analog Out 0.00-10.00V Voltage at Analog output (pin 30).
Analog_Output 0- 32767 Note: 1232E and 1232SE controllers do not include this Analog output.
0x321D 0x00
Digital Qut 6 On / Off Digital Out 6 output on or off (pin 19).

Dig6_Output On/ Off

System_Flags1 [Bit 3]
0x322B 0x00
Digital Out 7 On/ Off Digital Out 7 output on or off (pin 20).
|Dig7_Output on/ Off

|System_Flags1 [Bit 4]
0x322B 0x00
Driver 1 PWM 0-100% Driver 1 PWM output (pin 6).
PWM1_Output 0- 32767
0x321F 0x00
Driver 2 PWM 0-100% Driver 2 PWM output (pin 5).
PWM2_Output 0- 32767
0x3220 0x00
Driver 3 PWM 0-100% Driver 3 PWM output (pin 4).
PWM3_Output 0- 32767
0x3221 0x00
Driver 4 PWM 0-100% Driver 4 PWM output (pin 3).
PWM4_Output 0- 32767
0x3222 0x00
PD PWM 0-100% Proportional driver PWM output (pin 2).
PD_Output 0-32767
0x321E 0x00
PD Current 0.00-2.00A Current at proportional driver (pin 2).
PD_Current 0-607
0x321C 0x00
5 Volts 0.00-6.25V Voltage at +5V output (pin 26).
Five_Volts_Output 0-1023
0x3202 0x00
12 Volts 0.00-12.00V Voltage at +12V output (pin 25).
Twelve_Volts_Output 0-768
0x3522 0x00
Ext Supply Current 0-200 mA Combined current of the external +12V and +5V voltage supplies (pins 25
Ext_Supply_Current 0-800 and 26).
0x3229 0x00
Pot Low 0.00-6.25V Voltage at pot low (pin 18).
Pot_Low_Output 0-1023
0x3203 0x00
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Monitor Menu: BATTERY

VARIABLE DISPLAY RANGE DESCRIPTION

BDI 0-100% Lead-acid battery discharge indicator (BDI). Effectively the battery’s

BDI_Percentage 0-100 remaining state-of-charge.

0x3308 0x00 NOTE: For non lead-acid batteries, including Lithium-lon battery packs, use
the pack’s or cell manufacturer’s approved Battery Management System
(BMS) for determining the BDI

Capacitor Voltage 0.0-200.0V Voltage of controller’s internal capacitor bank at B+ terminal.

Capacitor_Voltage 0 - 12800

0x324C 0x00

Keyswitch Voltage 0.0-105.0V Voltage at KSI (pin 1).

Keyswitch_\Voltage 0- 10500

0x324D 0x00

Monitor Menu: MOTOR

VARIABLE

Motor RPM
Motor_RPM_Display

DISPLAY RANGE

—12000 — 12000 rpm
—12000- 12000

DESCRIPTION

Motor speed in revolutions per minute.

Filtered for display on the 1313/1314. No CAN Index is assigned to this
monitor variable. Possible usage for a tachometer, due to the filtered
(smoothing) nature of this VCL variable over the Motor_RPM variable (see
Motor RPM in monitor Controller » Motor Tuning » Motor_RPM, page 76).

Max Speed Controller Limit 0-12000 rpm Displays the maximum allowed speed, which clamps the upper limit of the
Max_Speed_Controller_Limit 0- 12000 Max Speed parameters. It is the least of the three motor-speed constraints
0x3559 0x00 described on page 24.

Temperature —100 - 300°C Temperature sensor readout.

Motor_Temperature —1000 - 3000

0x320B 0x00

MotorSpeed A
MotorspeedA
0x35D1 0x00

—12000 — 12000 rpm
—12000 - 12000

Motor encoder phase A speed in revolutions per minute. This can be used to
verify that phase A of the encoder is operating correctly. MotorSpeed A
should equal MotorSpeed B in a properly operating motor encoder.
MotorSpeed A does not indicate direction.

MotorSpeed B
MotorspeedB
0x35D2 0x00

—12000 — 12000 rpm
—12000 - 12000

Motor encoder phase A speed in revolutions per minute. This can be used to
verify that phase B of the encoder is operating correctly. MotorSpeed B
should equal MotorSpeed A in a properly operating motor encoder.
MotorSpeed B does not indicate direction.

Sin Input A 0-1023 Input at Position Feedback A (pin 31).
encoder_sin_input_compensated 0-1023

0x38C5 0x00

Cos Input B 0-1023 Input at Position Feedback B (pin 32).
encoder_cos_input_compensated 0-1023

0x38C6 0x00

Rotor Position
rotor_position_raw
0x38C7 0x00

-32768 — 32767
-32768 - 32767

The displayed value will never exceed 4095. 0 — 4095 maps to mechanical
0°-360°.
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Monitor Menu: CONTROLLER

VARIABLE DISPLAY RANGE DESCRIPTION
Current (RMS) 0.0-1000.0A RMS current of the controller, taking all three phases into account.
Current_RMS 0—- 10000
0x3209 0x00
Modulation Depth 0.0 -100.0% Percentage of available voltage being used.
Modulation_Depth 0-1182
0x3208 0x00
Frequency —500 - 500 Hz Controller electrical frequency.
Frequency -3000 - 3000
0x3206 0x00
Temperature —100 - 300°C Controller internal temperature.
Controller_Temperature —1000 - 3000
0x322A 0x00
Main State 0-10 Main contactor state:
Main_State 0-10 0 =open
2 = weld check
3 = closing delay
4 = missing check
5 = closed (when Main Enable = On)
6 = delay
7 = arc check
8 = open delay
9 = fault
10 = closed (when Main Enable = Off).
EMBrake State 0-4 EM brake state:
EMBrakeState 0-4 0= engaged
0x3892 0x00 1 = releasing
2 = released
3 = engaging
4 = engaged and vehicle stopped.
Regen On / Off On when regen braking is taking place; Off when it is not.
Regen_State on/Off

System_Flags1 [Bit 2]
0x322B 0x00

Master Timer
Master_Timer
0x3160 0x00

0-429496729.5 s
0-4294967295

The master timer is a timer of the total hours the controller is powered on
(keyswitch hours). The master timer is controlled by the 0S software and
cannot be reset.

VCL Error Module
Last_VCL_Error_Module
0x3473 0x00

VCL Error

Last _VCL_Error
0x3472 0x00

0-65535
0-65535

0-65535
0-65535

AVCL Runtime Error (fault code 68) will store additional information about
the cause of a VCL runtime error in the VCL Error Module and VCL Error
variables. The resulting non-zero values can be compared to the runtime
VCL module ID and error code definitions listed in the controller’s 0S
Syslnfo file, which should help pinpoint the VCL error that caused the
runtime error.
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Monitor Menu: CONTROLLER, cont’d

0x3897 0x00

VARIABLE DISPLAY RANGE DESCRIPTION
Motor Characterization Error 0-23* A Motor Characterization Fault (fault code 87) will store additional
Motor Characterization Error 0-23 information in the Motor Characterization Error variable:*
B h 0 = sequencing error. Normally caused by turning off Motor Characterization

0x3899 0x00 Test Enable before running the test.

1 = encoder signal seen but step size not auto-detected; set up Encoder

Steps manually

2 = motor temp sensor fault

3 = motor temp hot cutback fault

4 = controller overtemp cutback fault

5 = controller undertemp cutback fault

6 = undervoltage cutback fault

7 = severe overvoltage fault

8 = encoder signal not seen, or one or both channels missing

9 = motor parameters out of characterization range.

20 = Sin/Cos sensor not found

21 = phasing not detected

22 = Sin/Cos sensor characterization failure

23 = started characterization procedure while motor rotating.
Parameter Mismatch Error -2 A Parameter Mismatch Fault Fault (fault code 99) will store additional
Parameter Mismatch Error _2 information in the Parameter Mismatch Error variable:

0 =none
0x388F 0x00 1 = Dual Motor Enable = On, and Control Mode Select is not set to either

0-Speed Mode Express or 1-Speed Mode

2 = Feedback Type is incompatible with Motor Technology setting.
Supervision Error -4 A Supervision Fault (fault code 77) will store additional information in the
Supervision_Error _4 Supervision Error variable:

0 =none

1 = watchdog timeout comms
2 = power supply fault detected
3 = queue fault detected

4 = ALU fault detected.

The Supervisor Fault (flash code 77) has several causes. The most common
cause is when one of the digital inputs is stuck in the range between the
guaranteed high threshold and the guaranteed low threshold for more than
100 milliseconds. See Digital Input specifications, page 14.

*NOTES:
Errors 1 and 9 apply to ACIM motors only.
Errors 20-23 apply to SPM motors only.

Errors indicate the motor characterization data is invalid, except in the case of Error 1.
This monitor variable will read “0” during normal operation (i.e., no characterization fault code 87).
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Monitor Menu: CUTBACKS

VARIABLE DISPLAY RANGE DESCRIPTION
Motor Temp Cutbhack 0-100% Displays the current available as a result of \the motor temperature cutback
MotorTempCutback 0- 4096 IUnELion: - ,
A value of 100% indicates no cutback in current.
0x3581 0x00
Controller Temp Cutbhack 0-100% Displays the current available as a result of the controller temperature
ControllerTempCutback 0-409 cutback f“nCt'O"‘. ) )
A value of 100% indicates no cutback in current.
0x35F3 0x00
Undervoltage Cutback 0-100% Displays the current available as a result of the undervoltage cutback
UndervoltageCutback 0- 4096 function. o ,
A value of 100% indicates no cutback in current.
0x3605 0x00
Overvoltage Cutback 0-100% Displays the current available as a result of the overvoltage cutback
OvervoltageCutback 0-4096 function.

0x3604 0x00

A value of 100% indicates no cutback in current.

Monitor Menu:

MOTOR TUNING

VARIABLE
Motor RPM
Motor_RPM
0x3207 0x00

DISPLAY RANGE
—32768 — 32767 rpm
-32768 — 32767

DESCRIPTION

Motor speed in revolutions per minute.

This is the raw value (compare to the filtered value under the Motor menu,
page 73). Use Motor_RPM for VCL and CAN applications.

Base Speed Captured 0-65535 rpm Displays the value of the motor base speed captured in the most recent

_ acceleration. This value is used to set the FW Base Speed parameter, using
Base_Speed_Captured 0-65535 the FW Base Speed set procedure described on page 56 or using the ACIM
0x35BE 0x00 motor characterization procedure (Chapter 8A).
Test Field Current 0-800A Field test current reading to be used during the ACIM motor characterization
Test_Field_Current 0-3800 procedure (Chapter 8A).

0x3873 0x00
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Monitor Menu: VEHICLE

VARIABLE

Vehicle Speed
Vehicle_Speed
0x320A 0x00

DISPLAY RANGE

-3276.8 - 3276.7
-32768 - 32767

DESCRIPTION

Vehicle speed, in units of MPH or KPH, depending on the setting of the Metric
Units parameter (see Program » Vehicle menu).

For accurate speed estimates, the Speed to RPM parameter must be set correctly.

Vehicle Odometer
Vehicle_Odometer
0x3200 0x00

0.0 -10000000.0
0 - 100000000

Vehicle distance traveled, in units of miles or km, depending on the setting of
the Metric Units parameter in the Vehicle parameters menu.

For accurate distance measurements, the Speed to RPM parameter must be
set correctly.

Vehicle Acceleration

0.000-10.000 g

Vehicle acceleration. This is a calculated value. The Speed to RPM parameter

Vehicle_Acceleration 0- 10000 must be set correctly for an accurate measurement.

0x35C1 0x00

Time to Speed 1 0.00-128.00s Time taken for the vehicle to go from zero rpm to the programmed Capture

Time_to_Capture_Speed_1 0 - 32000 Speed 1 (see Program » Vehicle menu) during its most recent such

0x35BF 0x00 acceleration.

Time to Speed 2 0.00-128.00s Time taken for the vehicle to go from zero rpm to the programmed Capture

Time_to_Capture_Speed_2 0 - 32000 Speed 2 (see Program » Vehicle menu) during its most recent such

0x35BB 0x00 acceleration.

Time Between Speeds 0.00-128.00s Time taken for the vehicle to go from programmed Capture Speed 1 to

Time_Between_Capture_ Speeds 0 - 32000 programmed Capture Speed 2 (see Program » Vehicle menu) during its most

0x35C4 0x00 recent such acceleration.

Time to Dist 1 0.00-128.00s Time taken for the vehicle to travel from zero rpm to the programmed Capture

Time_to_Capture_Distance_1 0 - 32000 Distance 1 (see Program » Vehicle menu) during its most recent such trip.

0x3612 0x00 For accurate distance measurements, the Speed to RPM parameter must be
set correctly.

Time to Dist 2 0.00-128.00 s Time taken for the vehicle to travel from zero rpm to the programmed Capture

Time_to_Capture_Distance_2 0 - 32000 Distance 2 (see Program » Vehicle menu) during its most recent such trip.

0x3613 0x00 For accurate distance measurements, the Speed to RPM parameter must be
set correctly.

Time to Dist 3 0.00-128.00s Time taken for the vehicle to travel from zero rpm to the programmed Capture

Time_to_Capture_Distance_3 0 - 32000 Distance 3 (see Program » Vehicle menu) during its most recent such trip.

0x3614 0x00

For accurate distance measurements, the Speed to RPM parameter must be
set correctly.

Braking Distance Captured
Braking_Distance_Captured

0x3201 0x00

0.0 -1000000.0
0-40000000

Distance traveled by the vehicle starting with vehicle braking (initiated by
throttle reversal, brake pot, VCL_Brake, or interlock braking) and ending when
Motor_RPM = 0. Units are meters or feet, depending on the setting of the
Metric Units parameter.

For accurate distance measurements, the Speed to RPM parameter must be
set correctly.

Distance Since Stop
Distance_Since_Stop
0x324E 0x00

0.0 -1000000.0
0 - 40000000

Distance traveled by the vehicle starting from a stop. In effect, the vehicle

is used as a tape measure. (In other words, if you travel 300 feet forward
and then 300 feet in reverse, the distance would be 600.) The distance is
continuously updated and will stop (and restart) when Motor_RPM = 0.

For accurate distance measurements, the Speed to RPM parameter must be
set correctly. Units are meters or feet, depending on the setting of the Metric
Units parameter.

Distance Fine
Distance_Fine_Long
0x3616 0x00

—214748364.8 — 214748364.7
—2147483648 — 2147483647

Position measurement. Net distance in both the forward and reverse
directions. (In other words, if you travel 20 inches forward and then 20 inches
in reverse, the distance would be zero.) The distance is continuously updated
and will roll over when the variable goes over the limits. Resets to zero on key
cycle. Units are decimeters or inches, depending on the setting of the Metric
Units parameter.

For accurate distance measurements, the Speed to RPM parameter must be
set correctly.

NOTE: All vehicle calculations assume no tire slippage.

Quick Links:

Vehicle Menu parameters p.64
Metric Units
Speed to RPM
Capture Speed 1, 2
Capture Distance 1, 2, 3
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Monitor Menu: CAN STATUS

VARIABLE DISPLAY RANGE DESCRIPTION
CAN Node ID 0-127 Displays the controller’s Node ID.
CAN_Node_ID 0-127
0x3145 0x00
CAN NMT State 0-127 Controller CAN NMT state:
CAN_NMT_State 0-127 O=initialization, 4=stopped, 5=operational, 127=pre-operational.
0x3328 0x00
PDO1 MOSI Byte Map* 0-2% Mapping objects for PDO1 MOSI’s eight bytes.
PDO1 MISO Byte Map* 0-2% Mapping objects for PDO1 MISO’s eight bytes.
PD02 MOSI Byte Map* 0-2% Mapping objects for PDO2 MOSI’s eight bytes.
PD02 MISO Byte Map* 0-2% Mapping objects for PD02 MISO’s eight bytes.

* Each of these byte maps is a submenu containing 8 variables, one for each byte. Each variable is 32 bits.

PDO1 MOSI Byte Map

CAN_PDO_MOSI_1_MAP_1
CAN_PDO_MOSI_1_MAP_2
CAN_PDO_MOSI_1_MAP_3
CAN_PDO_MOSI_1_MAP_4
CAN_PDO_MOSI_1_MAP_5
CAN_PDO_MOSI_1_MAP_6
CAN_PDO_MOSI_1_MAP_7
CAN_PDO_MOSI_1_MAP_8

PDO1 MISO Byte Map

CAN_PDO_MISO_1_MAP_1
CAN_PDO_MISO_1_MAP_2
CAN_PDO_MISO_1_MAP_3
CAN_PDO_MISO_1_MAP_4
CAN_PDO_MISO_1_MAP_5
CAN_PDO_MISO_1_MAP_6
CAN_PDO_MISO_1_MAP_7
CAN_PDO_MISO_1_MAP_8

0x1600
0x1600
0x1600
0x1600
0x1600
0x1600
0x1600
0x1600

0x1A00
0x1A00
0x1A00
0x1A00
0x1A00
0x1A00
0x1A00
0x1A00

0x01
0x02
0x03
0x04
0x05
0x06
0x07
0x08

0x01
0x02
0x03
0x04
0x05
0x06
0x07
0x08

PD02 MOSI Byte Map

CAN_PDO_MOSI_2_MAP_1
CAN_PDO_MOSI_2_MAP_2
CAN_PDO_MOSI_2_MAP_3
CAN_PDO_MOSI_2_MAP_4
CAN_PDO_MOSI_2_MAP_5
CAN_PDO_MOSI_2_MAP_6
CAN_PDO_MOSI_2_MAP_7
CAN_PDO_MOSI_2_MAP_8

PDO1 MISO Byte Map

CAN_PDO_MISO_2_MAP_1
CAN_PDO_MISO_2_MAP_2
CAN_PDO_MISO_2_MAP_3
CAN_PDO_MISO_2_MAP_4
CAN_PDO_MISO_2_MAP_5
CAN_PDO_MISO_2_MAP_6
CAN_PDO_MISO_2_MAP_7
CAN_PDO_MISO_2_MAP_8

NOTE: MOSI (Master Out Slave In) = RX (Server to Client) in CANopen nomenclature
MISO (Master In Slave Out) = TX (Client to Server) in CANopen nomenclature
PDO mapping variables in 0s31, as listed above, use the MOSI and MISO nomenclature as shown.

0x1601 0x01
0x1601 0x02
0x1601 0x03
0x1601 0x04
0x1601 0x05
0x1601 0x06
0x1601 0x07
0x1601 0x08

0x1A01 0x01
0x1A01 0x02
0x1A01 0x03
0x1A01 0x04
0x1A01 0x05
0x1A01 0x06
0x1A01 0x07
0x1A01 0x08
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6 — CONTROLLER INFORMATION MENU

This menu provides ID and version numbers for your controller hardware and software.

CONTROLLER INFORMATION MENU

VARIABLE DISPLAY RANGE DESCRIPTION
Serial Number 0-4294967295 Serial number. For example, if the serial number printed on your controller is
Serial_Number 0 - 4294967295 15045L.11493, the Serial Number variable will have the value of 11493.
0x1018 0x04
Model Number 0-4294967295 Model number. For example, if you have a 1236E controller with the model number
Model Number 0 - 4294967295 1236E-4521, the Model Number variable will have a value of 12364521.
0x3464 0x00
Mfg Date Code 0-32767 Controller date of manufacture, with the first two digits indicating the year and
Manuf_Date 0—- 32767 the last three indicating the day. For example, if the serial number printed on your
0x3466 0x00 controller is 15045L.11493, the Mfg Date Code variable will have the value of 15045

(45th day of 2015).

Hardware Version 0-32.767 The hardware version number uniquely describes the combination of power base
Hardware_Ver 0—- 32767 assembly and the logic, cap, and IMS board assemblies used in the controller.
0x3467 0x00
0S Version 0-65535 Version number of the operating system software that is loaded into the controller This
0S_Ver 0 - 65535 variable specifies the major version number of the controller’s operating system.
0x346A 0x00
Build Number 0-65535 Build number of the operating system software that is loaded into the controller. This
TBuild_Number 0 - 65535 variable specifies the minor version number of the controller’s operating system.
0x346B 0x00
SM Version 0-327.67 Version number of the Start Manager software that is loaded into the controller.
SM_Ver 0- 32767
0x332B 0x00
Param BIk Version 0-327.67 Version number of the parameter block that is loaded into the controller.
Param_BIk_Ver 0—- 32767
0x3468 0x00
VCL App Version 0-327.67 Version number of the VCL application software that is loaded into the controller. This
VCL_App_Ver 0—- 32767 value is set in the VCL program by assigning a value to the VCL_App_Ver variable.
0x3463 0x00
Vehicle Serial Number 0 - 4294967295 Provided for OEM use and definition.
Vehicle_Serial_Number 0 - 4294967295

0x393D 0x00
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7 — INITIAL SETUP

The 1232E/SE, 1234E/SE, 1236E/SE, and 1238E/SE controllers can be used in a variety of vehicles,
which differ widely in characteristics. Before driving the vehicle, it is imperative that these initial
setup procedures be carefully followed to ensure that the controller is set up to be compatible with
your application.

BEFORE YOU START

Correct values for the motor parameters (Motor Type, FW Base Speed, and Field Weakening) must be
determined individually for each motor.

For ACIM motors, use one of these three options to obtain ACIM motor data:

e Contact your Curtis distributor or support engineer with the manufacturer’s part number for
your motor. Curtis has a database of many motors for which the motor data has already been
determined. Motors in the Curtis database are assigned a number, which is the number used
for the ACIM Motor Type parameter.

e Send your ACIM motor to Curtis for testing on the factory motor dyno. Your motor’s data will be
entered into the Curtis database and we will send you software with the appropriate parameter
values set to match your motor. Contact your Curtis distributor or support engineer before
shipping your motor.

e Use the ACIM Motor Characterization Procedure (Chapter 8A), which has the controller “learn”
the motor parameter data. The procedure should take about half an hour and can be done
on the vehicle. Go ahead and complete setup steps 1 through 11 of the Initial Setup before
conducting the ACIM characterization procedure.

For SPM motors, use the SPM Motor Characterization Procedure (Chapter 8B), which has the controller
“learn” the motor parameter data. The procedure should take about half an hour and can be done

on the vehicle. Go ahead and complete steps 1 through 9 of the Initial Setup before conducting the
SPM characterization procedure. Using the SPM Motor Characterization Procedure is the only option
for obtaining motor data for SPM motors. Note, for SPM motors, there is no motor poles or feedback
sensor direction parameters, as obtaining this data is part of the SPM auto-characterization routine.

ACIM:

If Curtis has given you the values for Motor Type, FW Base Speed, and Field Weakening and you
have set them on the controller (see ACIM Field Weakening Control menu, pages 56-57), complete
the these initial setup procedures prior to fine-tuning the motor. If you will be using the automated
Motor Characterization Procedure, that will come later—after you have completed steps 1 through
10. Following the motor characterization, complete the initial steps prior to completing the fine-
tuning in Chapter 9.

SPM:

For SPM motor applications, start these initial setup procedures now. The SPM motor characterization
will be preformed after you have completed steps 1 through 9. Then complete steps 12—14 prior to
completing the fine-tuning in Chapter 9.
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A WARNING

Quick Links:
Monitor/Inputs Menu p.70
Monitor/Motor Menu p.73

Quick Links:

Monitor/Inputs Menu p.70

Drivers/Main Contactor menu
Main Interlock Type p.51
Interlock Type p.52

Before beginning the setup procedures, jack the vehicle drive wheels up off the ground so that
they spin freely and the vehicle is stable. Double-check all wiring to ensure it is consistent with
the wiring guidelines presented in Chapter 2. Make sure all electrical and mechanical connections
are tight.

Turn on the controller and plug in the 1313 handheld or 1314 PC programmer.

Step 1: Motor Temperature Sensor (see page 61)

Set the Sensor Type parameter to the predefined type (1-5) that corresponds to your motor
temperature sensor. Typically, the motor temperature sensor will be a thermistor that is connected
from Analog 2 (pin 8) to I/O Ground (pin 7) as shown in figure 3.

To check whether the Sensor Type and Sensor Offset parameter settings and the motor-thermistor
connections yield the correct motor temperature, ensure the motor’s Sensor Enable parameter is
set to On, then read the Temperature value displayed in the programmer’s Monitor » Motor menu

(page 73).

If the 1313/1314 programmer does not display the correct motor temperature, double-check the
motor temperature control parameters Sensor Enable, Sensor Type, and Sensor Offset. Ensure that
the thermistor’s wiring orientation is as shown in Figure 3.

To setup a custom sensor type, VCL and an OS parameter-block change for a Sensor Type “Type 0”
is required by your Curtis distributor or support engineer.

To proceed if the correct motor temperature is not displayed, if there is no motor temperature sensor,
or while awaiting a custom sensor os/VCL, the initial setup procedure can continue only if the Sensor
Enable parameter is set to Off.

If the 1313/1314 displays the correct motor temperature, complete this step by setting the remaining
motor temperature control parameters: Sensor Offset (if not already completed, above), Braking
Thermal Cutback Enable, Temperature Hot, Temperature Max, and MotorTemp LOS Max Speed.

Step 2: Current Limits (see page 43)

The Drive, Regen, Brake, EMR, and Interlock Current Limit parameters are a percentage of the
controller’s full rated current. The controller’s full rated current is printed on the label of the
controller. Set the five current limit parameters to your desired values.

Step 3: Battery (see page 62-63)

Set the Nominal Voltage parameter to match the nominal battery pack voltage of your system.

Step 4: Main Contactor (see pages 51-52)

Set up the parameters in the Drivers » Main Contactor Menu.

Step 5: EM Brake (see pages 49-50)
Set up the parameters in the EM Brake Control Menu.

Step 6: Throttle (see pages 20-23 and 46-47)

Before the throttle can be setup, the interlock must be verified as Off. Read the Interlock value
displayed in the Monitor » Inputs menu. If the 1313/1314 programmer indicates the interlock is
On, review how you set the Interlock Type parameter (Drivers » Main Contactor Menu) and turn
the interlock off. Verify that the programmer displays that the interlock is now Off.

Contact your Curtis distributor or support engineer to resolve any issues about the interlock before
continuing with these initial setup procedures.

7 — INITIAL SETUP

pg. 81



Curtis 1232E/34E/36E/38E & 1232SE/34SE/36SE/38SE Manual, os 31 — May 2017 Return to TOC

%UiCKI Links: Once the interlock has been verified Off, proceed to the throttle input setup. First set the Throttle
miﬁﬁz%}i"fm p46-47 Type parameter to match the type of throttle (1-5) and wiring used as described in Chapter 3,
Wiring p.20-23 Throttle section. Then adjust the Forward Deadband, Forward Max, Reverse Deadband and Reverse
M“;‘Iimrt tIl”I;‘t; p-70 Max parameters to match the range of the throttle. The Throttle Pot value displayed on the Monitor »
rotlle ro
Mapped Throttle Inputs menu is useful when setting up these parameters.
For the forward and reverse directions, read the displayed Throttle Pot voltage at the point when
the throttle moves out of neutral and at the point just before full throttle and enter these values for
the deadband and max settings for that direction. Set up the remaining parameters in the Throttle
Menu as required by the application.
Verify that the throttle settings are correct by checking the Mapped Throttle value displayed in the
Monitor » Inputs menu over the entire range of throttle pot movement. The value displayed for
Mapped Throttle should be = 0% through the range of throttle motion that is considered neutral.
The displayed Mapped Throttle should be = 100% through the range of motion that is considered
maximum forward throttle and it is = -100% through the range considered maximum reverse throttle.
Contact your Curtis distributor or support engineer to resolve any issues about the throttle setup
before continuing with the initial setup procedures.
Step 7: Brake (see page 48)
If the brake function is not used by your application, set the Brake Pedal Enable parameter = Off
and Brake Type = 5.
Before the brake can be set up the interlock must be verified as Off. Read the Interlock value displayed
in the Monitor » Inputs menu. If the 1313/1314 programmer indicates the interlock is On, review how
you set the Interlock Type parameter (Drivers » Main Contactor Menu) and turn the interlock off.
Quick Links: The Brake Type parameter must be set to match the type of brake throttle (1, 2, 3, 5) and wiring.
g:zzi (T;’f; 1:5:‘::;“;’25;4283 Next, adjust the Brake Deadband and Brake Max parameters to match the range of the brake pot. The
Monitor/Inputs p.’70' Brake Pot value (Pot2 Raw) displayed in the Monitor » Inputs menu is useful when setting up these
Pot2 Raw parameters. Read the displayed brake pot voltage at the point when the brake moves out of neutral

Mapped Brake and at the point just before full brake. Enter in these values for the deadband and max parameter

settings. Then set up the other parameters in the Brake Menu as required by the applications.

Verify that that the brake settings are correct by checking the Mapped Brake value displayed in the
Monitor » Inputs menu over the entire range of brake pot movement. The value displayed for Mapped
Brake should be = 0% through the range of brake pot motion that is considered neutral. The displayed
Mapped Brake should be = 100% through the range of motion that is considered maximum brake.

Contact your Curtis distributor or support engineer to resolve any issues about the brake setup before
continuing with the setup procedure.

Step 8: Motor Technology & Feedback Type (see pages 55 and 59)
Set the Motor Technology parameter to match the motor used in your application
(0 =ACIM, 1 = SPM).
Set the Motor Feedback Type parameter based on the Motor Technology setting:
Feedback Type = 1 (quadrature position encoder) for ACIM,
Feedback Type = 2 (Sin/Cos sensor) for SPM.
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A WARNING

Quick Links:
Monitor/Inputs Menu p.70
Monitor/Motor Menu p.73

Make sure that the Feedback Type matches the feedback device used on the motor, and that you are
using the right type of device for your motor. If there is not a match, stop the setup procedure until
a compatible motor and feedback device are obtained and installed.

If your application uses an ACIM motor (which must use a quadrature encoder), program the
Encoder Steps parameter to the correct setting. This information is typically available from the motor
manufacturer. If the ACIM Characterization Procedure is used (Chapter 8A), it can determine the
encoder steps, but only for encoders with 32, 48, 64, or 80 pulses per revolution (ppr).

Setting the Encoder Steps parameter improperly may cause vehicle malfunction, including
uncommanded drive.

If your application uses an SPM motor (which must use a Sin/Cos sensor), the Sin/Cos min and max
voltages will be learned during the SPM Characterization Procedure (Chapter 8B).

Step 9: Faults (see Chapter 11)

Cycle KSI (to clear any parameter change faults) and use the programmer to check for faults in the
controller. All faults and errors (including those in the History file) must be cleared before continuing
with the initial setup. Use Chapter 10 for help in troubleshooting. Contact your Curtis customer
support engineer to resolve any fault issues before continuing with the setup procedure.

Step 10: Setting Feedback Direction (see page 59)

ACIM:

With the vehicle drive wheels still jacked up, no faults present in the controller, the interlock Off (as
verified in the Monitor » Inputs menu), and both the throttle and brake in neutral (Mapped Throttle =
0% and Mapped Brake = 0% in the Monitor » Inputs menu), the encoder direction can be checked.
Use the Monitor » Motor menu to view the Motor RPM display. Turn the motor by hand and observe
the sign of Motor RPM. Positive is forward and negative is reverse. If you get a positive Motor RPM
when you rotate the motor in the forward direction, and a negative Motor RPM when you rotate
the motor in the reverse direction, the Swap Feedback Direction parameter is correct and should
not be changed. If you are getting negative Motor RPM when rotating the motor forward, the Swap
Feedback Direction parameter must be changed. Cycle KSI power and repeat the procedure until
you are satisfied that the Swap Feedback Direction setting is correctly set. If the vehicle will use the
emergency reverse feature, the reverse direction (negative Motor RPM) must be correctly selected
so that when the Emergency reverse input is active the motor will rotate in the reverse direction.
Contact your Curtis distributor or support engineer to resolve any issues about encoder direction
or emergency reverse before continuing with the setup procedure.

SPM:

Step 10 is not applicable to SPM motors. Go to the next step for SPM motor in-vehicle auto-
characterization.

Step 11: Motor Characterization

If your motor is an ACIM motor, you must either:

(a) Already have software with the motor data programmed to match your motor. The pre-set motor
data software is usually the result of contacting your Curtis distributor or support engineer and
getting a match between your motor and the Curtis ACIM motor database, or by shipping a motor
to Curtis for dyno characterization.

or (b) Use the in-vehicle ACIM Motor Characterization Procedure (Chapter 8A). This procedure
will set the direction, may set the Encoder Steps, learn ACIM motor data, and set the FW Base Speed
and Field Weakening Drive.

7 — INITIAL SETUP
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Quick Links:
ACIM characterization p.85-90
SPM characterization p.91-92

A WARNING

If your motor is an SPM motor, you must use the in-vehicle SPM Motor Characterization Procedure
(Chapter 8B). This procedure will determine the number of motor poles, set the direction and the
Sin/Cos sensor parameters, and learn the SPM motor data parameters.

After ensuring that the controller has the motor data values that match your system, complete Steps
12 through 14 of the initial setup.

NOTE: Do not take the vehicle down off the blocks if you will be re-running the Motor
Characterization procedure.

Step 12: Checking Direction of Rotation
Do not take the vehicle down off the blocks until the motor is responding properly.

Only after the motor is responding properly is it safe to lower the vehicle and place the drive wheels
on the ground.

Once the encoder direction set correctly, this step tests to see whether the motor rotation is correct.
Begin by cycling KSI off and on (to clear any parameter change faults), then use the 1313/1314
programmer to check for faults in the controller. All faults must be cleared before continuing with the
setup procedure. Apply the interlock input and verify that Interlock = On (as verified in the Monitor
» Inputs menu). Then, while keeping the brake in neutral*, select a direction and apply throttle. The
motor should begin to turn.

For an ACIM motor, observe the motor rotation and if the motor appears to be “fighting itself”
(struggling at full current while jerkily turning at very low speed), change the setting of the Swap
Two Phases parameter.

For an SPM motor, observe the motor rotation and if it is turning in the wrong direction repeat the
SPM auto-characterization procedure, where the direction is set in its step 11.

Contact your Curtis distributor or support engineer if the proper motor direction cannot be resolved.

Step 13: Emergency reverse (see page 65)

Set up the parameters in the Emergency Reverse Menu. Note: Emergency Reverse is active only if
you are using Speed Mode Express or Speed Mode as your motor tuning mode.

Step 14: Interlock Braking (see page 66)

Set up the parameters in the Interlock Braking Menu.

*Note: The Throttle Command is zeroed if the Brake Command is > 0 for Control Modes 0 and 1. See Figure 16, page 108.

pg. 84

7 — INITIAL SETUP



Return to TOC

Curtis 1232E/34E/36E/38E & 1232SE/34SE/36SE/38SE Manual, os 31 — May 2017

8A — AUTOMATED ACIM MOTOR
CHARACTERIZATION PROCEDURE

A WARN'NG Motor will rotate during this procedure. Do not take the vehicle down off the blocks.

Quick Links:
Motor Parameters
Control Algorithms p.55
Characterization Tests p.55
Feedback Options p.59
Power Limiting Map p.43
Monitor
Inputs/Interlock p.70

This procedure is only for applications using an ACIM motor and quadrature encoder.

The procedure is performed in two parts. Both parts must be completed for proper controller setup.
The first part applies to all systems, and the second part is different for traction systems and hydraulic
systems. It is assumed that Initial Setup steps 1 through 10 have been completed.

The procedure assumes the motor is approximately room temperature (20-25°C); do not characterize
a hot motor without a temperature sensor.

If characterizing a traction system, the vehicle should have its drive wheels clearly off ground,
and the vehicle should be safely blocked from accidental movement. The drive wheels should be
freely spinning—any dragging brake or excessive friction may invalidate this test, or cause it to fail.

If characterizing a hydraulic system, the motor must be unbolted from the hydraulic pump and
allowed to spin freely. The test will not work properly if the motor is left connected to the pump.
Note: The motor may spin to high speed in either direction.

Hint: The procedure is easier to conduct if you add the various motor Parameter (Program) and
Monitor variables to your 1313’s Favorites folder. The 1314 programmer can also be used, although
it does not offer the convenience of the Favorites folder.

PART 1: TRACTION AND HYDRAULIC SYSTEMS

1. Verify that Motor Technology = 0-ACIM and Feedback Type = 1-encoder. This configuration,
and these settings, are required to run this procedure.
Motor » Control Algorithms » 0-ACIM
Motor » Feedback Options » Feedback Type » 1-Encoder

2. Enter the number of motor poles in the Motor Poles parameter. The vast majority of induction
motors will have 4 poles.
Motor » Control Algorithms » 0-ACIM » Characterization Tests » Motor Poles

3. Enter the desired Max Test Speed for the characterization test. Note this speed might not be
achieved, depending on system characteristics; this is normal. A typical setting is approximately
1/3 of the maximum motor speed in the application.
Motor » Control Algorithms » 0-ACIM » Characterization Tests » Max Test Speed

4. Enter the desired Max Test Current for the characterization test. A typical setting is 70% (70%
of the maximum motor or controller rating, whichever is higher). Generally this is only reduced
if motor heating during the test is a problem, or resonance in the motor occurs at high currents.

Motor » Control Algorithms » 0-ACIM » Characterization Tests » Max Test Current.

5. Using the 1313/1314, clear the Fault History (Faults » Clear Fault History).
6. Ensure that Interlock is enabled (Monitor » Inputs » Interlock).

7. Set Test Enable = 1.
Motor » Control Algorithms » 0-ACIM » Characterization Tests » Test Enable

8. If any faults are present, stop and resolve the issue before continuing.

9. Note that no cutbacks should be in effect (thermal, voltage, etc.) when these tests are run.
Also, the power limiting maps should not cut back current over the characterization speed
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range. Check and verify that the power limiting map parameters are set to 100% over the
characterization speed range.

Current Limits » Power Limiting Map

A WARNING Motor will start to rotate after next step.

10. Set Test Throttle = +1.
Motor » Control Algorithms » 0-ACIM » Characterization Tests » Test Throttle

Quick Links:
Power Limiting Map p-43 11. After approximately 30 or more seconds the motor will begin to rotate. It is critical to verify the
Characterization Tests p.55 ' . ) . ) ) T ’
Test Throttle motor is turning in the FORWARD vehicle direction. If it is not, set Test Throttle = 0, wait for
M"tgr Characterization the motor to come to a stop, then set Test Throttle = —1.
rror p.75

Notes: (1) This step runs faster if TACT is not running. (2) If the motor starts to accelerate then
slows down again, you may need to increase Max Test Current (IM_AutoChar_Max_Test_
Current). See step 4 above.

12. The automated test may take several minutes. When it is complete, the controller will have a Parameter
Change Fault. This is normal. Check whether other faults are present. If you have a Characterization
Error fault, read the number at Monitor » Controller » Motor Characterization Error and reference the
following table. All errors except “1” indicate the motor characterization data is invalid. For error “1,
the data is valid but Encoder Steps must be set manually. Contact your Curtis distributor or support
engineer if the Motor Characterization Errors indicated cannot be resolved.

Motor Characterization Errors

0 Sequencing error. Normally caused by turning off Motor Characterization Test.
Enable before running test.

1 Encoder signal seen but step size could not be auto-detected; set up Encoder Steps
manually. (Only encoder steps of 32, 48, 64, and 80 will be identified automatically.)
Program » Motor » Encoder Steps (page 59).

2 Motor temperature sensor fault.

3 Motor temperature > MotorTemp_Hot (150°C is the typical default). This is active only
when the motor temp sensor is present and enabled.

4 Controller overtemperature.

5 Controller undertemperature.

6 Battery undervoltage.

7 Battery severe overvoltage.

8 Encoder signal not seen, or one or both channels missing.

9 Motor parameter out of characterization range; check to be sure motor has no load.

13. Cycle KSI power. The motor control should now be operational, though likely poorly optimized.
The Slip Gain test is very important for most, but not all, motors; you won't know which until you
perform the test and get the result. The following steps will complete the optimization process.

PART 2A: TRACTION SYSTEMS ONLY

Quick Links: 14. Run the SlipGain test.
SlipGain p.55

Adjust the SlipGain parameter to provide maximum torque at stall (0 rpm motor speed). Note:
The present SlipGain value was determined by the auto-characterization procedure, and is not
the default value.

Motor » Control Algorithms » 0-ACIM » Characterization Tests » SlipGain

To determine the SlipGain setting, use either of the following two methods, with (a) being the
most accurate:
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Quick Links:
SlipGain p.55
Fault Detection Enable p.60
Express Mode p.31
Accel Rate
Speed Mode p.35
Full Accel HS
Full Accel LS
Low Accel Rate
Torque Mode p.40
Accel Rate

Capture Speed 1 p.64
Time to Speed 1 p.77

Quick Links:
Drive_Current_Limit p.43
PL_Drive_Nominal p.44
FW Base Speed p.56

Base Speed Captured p.76

15.

(a) Configure the vehicle to measure stall torque, by using a load cell / draw bar test. Note: You will want
to perform this test quickly to avoid excessive motor heating and provide the most accurate results.

Turn off encoder fault detection (Motor » Encoder Fault Setup » Fault Detection Enable).
While applying and holding full throttle, adjust SlipGain until you measure peak torque.
If you want to have encoder fault detection active (recommended), turn it back on.

(b) Alternately, the vehicle can be used as the “draw bar test” by accelerating the motor to a
predetermined speed (rpm)—with the quickest time corresponding to the optimum SlipGain.
This method uses the controller’s time-to-speed function. The test-acceleration will be at full
controller current.

Begin by setting the corresponding Accel Rates to very fast values, based upon the application’s
Control Mode.

Speed Mode Express: Accel Rate.
Speed Mode: Full Accel LS, Full Accel HS, Low Accel.
Torque Mode: Accel Rate.

On the 1313 programmer, add these two items to the Favorites shortcut, to easily toggle between them:

Monitor » Vehicle » Capture Speed 1
Monitor » Vehicle » Time to Speed 1
Parameters (Program) » Motor Control Tuning » 0-ACIM » Characterization Tests » SlipGain.

Next, set the Gapture Speed 1 parameter to an rpm enveloping the motor’s desired maximum torque
range. The monitor item, Time to Speed 1, will record the time taken for the vehicle (motor) to go
from zero rpm to the programed Capture Speed 1 during its most recent acceleration.

To perform the test, from a stop, accelerate the vehicle through the predetermined speed. The
timer starts counting when full throttle is applied, and stops counting when the speed is reached.
A built-in trigger will allow the test to begin again once the vehicle comes to a stop and the
throttle is re-engaged, so be sure to note the value of the test first before accelerating-away in
subsequent runs. Each time, adjust the SlipGain value until the Time to Speed 1 is minimized.

This test should be run repeatedly over the same stretch of flat or uphill ground. Loading the vehicle
will improve results, the idea being to have the motor produce maximum torque as in the draw-
bar method. Work quickly, to avoid excessive motor heating, to obtain the most accurate results.

Run the FW Base Speed test.

Set the FW Base Speed to 6000 rpm. The test should be run with batteries that have a
reasonable charge.

Motor » Control Algorithms » 0-ACIM » Field Weakening Control » FW Base Speed

Set the Accel Rates to be very fast, so that you'll be accelerating at full current during the test.
From a stop, quickly apply full throttle to accelerate to a high speed. After the motor settles at
a speed for a moment, release the throttle to stop the test run. Note the value of the Base Speed
Captured (Monitor » Controller » Motor Tuning » Base Speed Captured), and enter this value
for the FW Base Speed setting.

Note:
— The base speed capture test restarts each time the vehicle comes to a stop and the throttle is
released, so be sure to note the value before driving (accelerating) away.
- This FW Base Speed parameter not only needs to be set during initial setup, yet reset each
time the Motor Type or the low speed current limit is changed. For example, if you lower
Drive_Current_Limit or PL_Drive_Nominal, retest and reset this parameter.
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Quick Links:
Max Speed
Express Mode p.31
Speed Mode p.32
Torque Mode p.39
Capture Speed 1,2 p.64
Field Weakening Drive p.56

Time Between Speeds p.77

16. Run the Field Weakening test.

This test will enable you to decide between a more efficient (less torque) or more torque (less
efficient) operation above the base speed, by adjusting the Field Weakening Drive parameter.

Note: the present Field Weakening Drive value (0%) was determined by the above auto-
characterization routine, and is not the default value (100%) in the native OS intended for the Curtis
dynamometer characterized motors when a motor type (number) is utilized. The differences are:

Auto Characterized: Field Weakening Drive is adjusted UP from 0% to the max Field
Weakening Drive determined in this text.
Dyno Characterized: Field Weakening Drive is adjusted DOWN from 100%
(can be set from 0-100%)

Increasing this parameter toward 100% will progressively allow more torque (along with more
current) at high motor speeds, but increasing it too much will actually reduce torque while still
driving a great deal of current. The auto-characterization value of 0% will give the most efficient
motor operation, but will not give the highest torque at high speeds.

If more torque is required at high speeds, run this Field Weakening Drive test.

On the 1313 programmer, add these two items to the Favorites shortcut, along with Field
Weakening Drive parameter, so you can easily toggle between them:
Parameters (Program) » Motor » Control Algorithms » 0-ACIM » Field Weakening Control » Field Weakening Drive
Parameters (Program) » Vehicle » Capture Speed 1, 2
Monitor » Vehicle » Time Between Speeds

Set Capture Speed 1 and 2 to values that are close to the Max Speed setting. The Capture Speed
1 and 2 values MUST be set higher than the measured FW Base Speed in step 15 (because Field
Weakening only affects performance at speeds above the “base speed”). Ideally the Capture
Speed 1, 2 values should be above the second corner point of the motor torque - speed curve.
For example, if the Max Speed is set to 4000 rpm, set Capture Speed 1 = 3500 rpm and Capture
Speed 2 = 3800 rpm:

Parameters (Program) » Speed Mode Express » Max Speed

Parameters (Program) » Speed Mode » Speed Controller » Max Speed

Parameters (Program) » Torque Mode » Speed Limiter » Max Speed

From a stop, apply full throttle to accelerate to a speed greater than Capture Speed 2. Note the
value displayed in Monitor » Vehicle » Time Between Speeds.

Now increase the Field Weakening Drive setting and repeat the acceleration in the same
direction, with the same load, and with the same full throttle and again note the Time Between
Speeds value.

Keep adjusting the Field Weakening Drive value and repeating the test until you find the Field
Weakening Drive value that results in the smallest Time Between Speeds. This Field Weakening
Drive value should be used for applications that require the most torque at high speeds.

Some Field Weakening Drive settings may result in a test acceleration run where Capture Speed 2 cannot
be obtained. These Field Weakening Drive settings cannot provide enough torque to get the vehicle past
Capture Speed 2, and thus can be ignored.

Use the Field Weakening Drive setting that best matches the application. It will be somewhere between
0% (most efficient, least motor heating) and the setting found in this test (highest torque at high speeds).

NOTE: The Field Weakening Drive setting will have no effect at motor speeds below FW Base Speed.

17. Return to Chapter 6 and complete Initial Setup Steps 12 through 14.
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Quick Links:
SlipGain p.55

Max Speed
Express Mode p.31
Speed Mode p.32

Current (RMS) p.74

Quick Links:
FW Base Speed p.56
Express Mode p.31
Accel Rate
Speed Mode p.35
Full Accel HS
Full Accel LS
Low Accel Rate
Test Field Current p.76
Min Field Current p.57
Base Speed Captured p.76

A CAUTION

A WARNING

PART 2B: HYDRAULIC SYSTEMS ONLY

14.

15.

Run the SlipGain test.

Adjust the SlipGain parameter to provide maximum torque at low speeds. Note: The present
SlipGain value was determined by the auto-characterization procedure, and is not the default value.

On the 1313 programmer, add the motor current to the items in the Favorites shortcut, to easily
toggle between them:

Monitor » Controller » Current (RMS)
Parameters (Program) » Motor Control Tuning » 0-ACIM » Characterization Tests » SlipGain.

Set Max Speed to a fairly low speed (but high enough to be able to lift a heavy load on the
forks), typically 800 rpm. The Max Speed setting must be below the motor base speed, which is
measured in the next step.

Put a very heavy load on the forks, preferable a max load.

Apply full throttle, and adjust the SlipGain parameter until the motor current is minimized. If
the vehicle has a multistage mast, work in the first stage only so that the load is consistent.

This will be the SlipGain parameter value, unless following step 15, the base speed used here
(e.g., 800 rpm) was too high.

Run the FW Base Speed test.

Note: For this test, because the hydraulic motor (disconnected from the pump) can quickly
accelerate past the “Base Speed”, it will be necessary to pre-flux the motor current prior to
running this test to get an accurate measure of base speed. Since the controller will be running
current with no throttle, ensure this test’s 1313 Favorites items are loaded so the test continues
without delay to prevent motor and controller heating. Then, be sure to to re-set the controller to
cancel the pre-flux following the test. This test is for hydraulic (pump) motor working in Speed
Mode only. Run this test with batteries that have a reasonable charge.

Set in the 1313 Favorites
Parameters (program) » Motor » Control Algorithms » 0-ACIM » Field Weakening Control » FW Base Speed
Parameters (Program) » Motor » Control Algorithms » 0-ACIM » Field Weakening Control » Min Field Current
Monitor » Controller » Motor Tuning » Test Field Current
Monitor » Controller » Motor Tuning » Base Speed Captured

Set the Max Speed to 6000 rpm (i.e., beyond the maximum desired pump speed).

Set the Accel rates to be very fast, so the motor will be accelerating at full current during the test.
Use only Speed Speed Modes for hydraulic systems.

Record the value of the Test Field Current (Monitor) and enter this value for the Min Field
Current parameter.

The controller is now running current with no throttle, so continue this test without delay
to prevent motor and controller heating.

From a stop, quickly apply full throttle to accelerate to a high speed. After the motor settles
at a speed for a moment, release the throttle to stop the test. Note the value of the Base Speed
Captured and enter this value for the FW Base Speed parameter setting.

When this test is finished, you must re-set the parameter Min Field Current = 0 Amps to
cancel the pre-flux current. Verify that the pre-flux current is canceled before continuing.

8A — AUTOMATED ACIM MOTORCHARACTERIZATION PROCEDURE
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Quick Links:
Motor RPM p.76
Field Weakening Drive p.56
Max Speed
Express Mode p.31
Speed Mode p.32

16. Run the Field Weakening test.

This test will enable you to decide between a more efficient (less torque) or more torque (less
efficient) operation at high speeds, by adjusting the hydraulic motor’s Field Weakening Drive
parameter. While the most efficient operation will occur with field weakening at the 0% auto-
characterization value, more torque at high speeds may be required, necessitating adjusting the
field weakening. Field Weakening Drive should be set just high enough to meet the high speed
performance specifications, typically maximum lift speed with full load.

Note: the present Field Weakening Drive value (0%) was determined by the above auto-
characterization routine, and is not the default value (100%) in the native OS intended for
the Curtis dynamometer characterized motors when a motor type (number) is utilized. The
differences are:

Auto Characterized: Field Weakening Drive is adjusted UP from 0% to the max Field Weakening Drive determined in this test.
Dyno Characterized: Field Weakening Drive is adjusted DOWN from 100% (can be set from 0—100%)

Increasing the Field Weakening Drive parameter toward 100% will progressively allow more
torque (along with more current) at high motor speeds, but increasing it too much will actually
reduce performance while still driving a great deal of current.

On the 1313 programmer, add these two items to the Favorites shortcut so you can easily toggle
between them:

Monitor » Controller » Motor Tuning » Motor RPM

Parameter (Program) » Motor » Control Algorithms » 0-ACIM » Field Weakening Control » Field Weakening Drive.

Run this test with no load on the forks. Work with only the first stage of a multistage mast. Work
quickly to avoid overheating the controller or motor.

Using the application’s Speed (control) Mode, set the Max Speed parameter to a high speed that
likely cannot be achieved by the hydraulic system.

Set Field Weakening Drive = 100% (note: this test work works DOWN from 100% to find the
actual maximum value).

Apply full throttle, running the motor towards the maximum speed. Record the maximum
(achieved) Motor RPM.

Repeat the acceleration runs while continuing to lower the Field Weakening Drive value before
on each run until you notice the achievable maximum motor speed fall off significantly (20-30
rpm). This number represents the maximum Field Weakening Drive value (%) to achieve the
maximum torque/speed envelope of the hydraulic motor (do not use a higher percentage). You
can always reduce the Field Weakening Drive percentage to reduce energy consumption and
improve efficiency (but reducing torque output) at high speeds.

NOTE: The Field Weakening Drive setting will have no effect at motor speeds below FW
Base Speed.

17. Return to Chapter 6 and complete Initial Setup steps 12 through 14.
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8B — AUTOMATED SPM MOTOR
CHARACTERIZATION PROCEDURE

A WARN'NG Motor will rotate during this procedure. Do not take the vehicle down off the blocks.

Quick Links:
Motor Technology p.55
Feedback Type p.59
Sin/Cos p.60
Characterization Tests p.59
Test Enable
Test Throttle
Max Test Speed
Max Test Current

Interlock (monitor) p.70

This procedure is only for applications using an SPM motor and Sin/Cos sensor.

This procedure is performed in one stage and takes approximately 5-10 minutes. It can only be used
on a sinusoidal wound SPM motor with a Sin/Cos absolute position sensor (e.g, RLS RM22, SKF
BX-BMB-7050, etc.) set up with one sensor revolution per mechanical revolution.

It is assumed that Initial Setup steps 1 through 9 have been completed and that the motor is approximately
room temperature (20-25°C); do not characterize a hot motor without a temperature sensor.

If characterizing a traction system, the vehicle should have its drive wheels clearly off ground, and
the vehicle should be safely blocked from accidental move-ment. The drive wheels should be freely
spinning—any dragging brake or excessive friction may invalidate this test, or cause it to fail.

If characterizing a hydraulic system, the motor must be unbolted from the hydraulic pump and
allowed to spin freely. The test will not work properly if the motor is left connected to the pump.
Note: The motor will spin to Max Test Speed in both directions.

1. Verify that Motor Technology = 1-SPM and Feedback Type = 2-Sin/Cos sensor.
This configuration, and these settings, are required to run this procedure.
Motor » Control Algorithms » 1-SPM
Motor » Feedback Options » Feedback Type » 2-Sin/Cos

2. Enter the maximum speed the motor is intended to turn as the Max Test Speed for the
characterization test. Note this speed might not be achieved, depending on system characteristics;
this is normal. A typical setting is 5000 rpm, but clearly the Max Test Speed should not be set to
a higher speed than safe for the mechanical configuration.

Motor » Control Algorithms » 1-SPM » Characterization Tests » Max Test Speed

3. Enter the desired Max Test Current for the characterization test. A typical setting is 20%
(note this is 20% of the maximum controller rating). Generally this is only reduced if motor
heating during the test is a problem. Generally this is only increased if the motor fails to
rotate during commissioning.

Motor » Control Algorithms » 1-SPM » Characterization Tests » Max Test Current
4. Using the 1313/1314, clear Fault History (Faults » Clear Fault History).

5. Enable the SPM (PMAC) Auto Characterization by setting Test Enable = 1.
Motor » Control Algorithms » 1-SPM » Characterization Tests » Test Enable

6. Turn on (enable) Interlock (Monitor » Inputs » Interlock).
7. If any faults are present, stop and resolve the issue before continuing.

8. Set Test Throttle = +1.
Motor » Control Algorithms » 1-SPM » Characterization Tests » Test Throttle
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A WARN'NG Motor will start to rotate in step 9 and faster in step 10.

9. 'The controller will start to inject test pulses. After a few minutes (when pulsing stops), the motor
will begin to rotate very slowly. It is critical to verify the motor is turning in the FORWARD
vehicle direction. If it is not, set Test Throttle = 0, wait for the motor to come to a stop, then set
Test Throttle = —1. The motor will start again in the same direction. The controller will properly
set the direction at the end of characterization process. (Note: This is a different operation than
that in the ACIM characterization procedure, which does turn the motor in the other direction
when Test Throttle is set negative.)

10. After about a minute, the motor will spin up to a moderate speed, then to high speed (limited
by Max Test Speed) in each direction.

11. When the automated test is complete, the controller will have a Parameter Change Fault. This
is normal. Check whether other faults are present. If you have a Characterization Error fault,
read the number at Monitor » Controller » Motor Characterization Error and reference the
following table. An error during the SPM test indicates the motor characterization data is invalid;
contact your Curtis distributor or support engineer for assistance if the indicated error cannot
be resolved.

Quick Links: Motor Characterization Errors
Motor Characterization

Errors p.75 0 Sequencing error. Normally caused by turning off Motor Characterization Test.
Enable before running test.

2 Motor temperature sensor fault.

3 Motor overtemperature >150°C (active only when temp sensor is present).
4 Controller overtemperature.

5 Controller undertemperature.
6

7

9

Battery undervoltage.

Battery severe overvoltage.

Motor parameter out of characterization range; check to be sure motor has no load.
20 | Sin/Cos sensor not found.

21 Phasing not detected (check to be sure the motor has no load).

22 | Sin/Cos sensor characterization failure.

23 | Started motor characterization while motor rotating.

12. Cycle KSI power.
13. Return to Chapter 6 and complete Initial Setup Steps 12 through 14.
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Quick Links:
Control Mode select p.31
Speed Mode Express menu p.31
Max Speed
Kp
Ki
Accel Rate
Decel Rate
Brake Rate
Typical Max Speed p.54

9 — TUNING GUIDE

Many aspects of vehicle performance can be optimized, using the wide variety of adjustable
parameters available to these E and SE controllers. Once a vehicle/motor/controller combination
has been tuned, the parameter values can be made standard for the system or vehicle model. Any
changes in the motor, the vehicle drive system, or the controller will require that the system be tuned
again to provide optimum performance.

Selecting the Control Mode (see page 31)

Before starting to tune your vehicle’s performance, you must select which control mode you use. Set
the Control Mode Select parameter = 0 (Speed Mode Express for either traction or pump motors),
=1 (Speed Mode, for either traction or pump motors) or = 2 (Torque Mode, for traction motors).
Cycle KSI input Off and then On (to clear any parameter change faults) and use the 1313 handheld
or 1314 PC programmer to check for faults in the controller. Then proceed to the tuning steps for
the control mode you have selected.

Conduct the steps in the sequence given, because successive steps build upon the ones before. It
is important that the effect of these programmable parameters be understood in order to take full
advantage of the controller’s powerful features. Please refer to the descriptions of the applicable
parameters in Chapter 4 if there is any question about what any of them do.

0 — Speed Mode Express Tuning (see page 31)

Speed Mode Express is the same as Speed Mode with the exception that it has fewer parameters and is
therefore simpler to use. Most vehicle applications will find success with Speed Mode Express; however,
for some applications vehicle performance cannot be satisfactorily fine-tuned in Speed Mode Express.
In this case, change your control mode to Speed Mode (i.e., set Control Mode Select =1).

a. For traction applications, set Pump Enable to Off. For AC pump applications, set this parameter On.

b. Adjust Max Speed to the maximum speed the motor should turn in the vehicle application; this
speed setting corresponds to an input of full throttle.

c.  Adjust Typical Max Speed to the approximate maximum speed that the motor will spin. This is
usually the same value as the setting for Max Speed, but some applications have a Max_Speed_
SpdMx that changes (in the VCL software). If the Max_Speed_SpdMx changes, set Typical Max
Speed to the highest speed the motor is expected to reach. This value does not need to be set
precisely since it will not change motor performance. Typical Max Speed sets a reference point for
the “rate” parameters (accel, decel, brake rates), so that applications that have a changing Max_
Speed_SpdMx will not experience changes in the rates (because the rates are referenced to the
unchanging Typical Max Speed value). Once you set the Typical Max Speed parameter you should
not readjust it without adjusting all the rate parameters as well.

d. Kpand Ki typically do not need to be changed as the default values will work well in most applications.
If you want to adjust Kp (for looser or tighter following of the speed trajectory set by the accel, decel, and
brake rates), follow the procedure in step “d” in the Speed Mode tuning section.

e. Adjust the Accel Rate and Decel Rate as necessary while moving the throttle to different positions
(i.e., neutral to full throttle, half throttle to full throttle, full throttle to half throttle, full throttle
to neutral, neutral to low throttle, etc.). For AC pump applications, typically the Accel Rate and
Decel Rate are set very fast for quick response to hydraulic inputs.

9 — TUNING GUIDE
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f.  Adjust the Brake Rate as necessary while reversing the throttle input (i.e., full throttle forward
to low throttle reverse, full throttle forward to full throttle reverse, full throttle reverse to low
throttle forward, etc.). If a brake input is present in the application (Brake Pedal Enable = On)
continue adjusting Brake Rate by applying different amounts of brake throttle (i.e., full throttle
forward, then apply full brake or full throttle forward, then apply low brake, etc.). For AC pump
applications the Brake Rate has no effect on performance since the AC pump will not run in
reverse nor with a brake input.

« »

AC pump motor applications, which in step “a” had the Pump Enable parameter set to On, may
also be controlling hydraulic valves (load hold valve, proportional valve). The Proportional Driver

A WARNING parameters (page 53) and some VCL will typically be used to set up the control of these valve
driver outputs. Consult with your Curtis distributor or support engineer regarding hydraulic
valve control.

1 — Speed Mode Tuning (see pages 32-39)

a. For traction applications, set Pump Enable to Off. For AC pump applications set this parameter On.

b. Adjust Max Speed to the maximum speed the motor should turn in the vehicle application; this
speed setting corresponds to an input of full throttle.

c. Adjust the Typical Max Speed to the approximate maximum speed that the motor will spin. This
is usually the same value as the setting for Max Speed, but some applications have a Max_Speed_
Quick Links: SpdM that changes (in the VCL software). If the Max_Speed_SpdM changes, set the Typical Max
ConzolMode select p.31 Speed to the highest speed the motor is expected to reach. This value does not need to be set
R4 e\;gﬁé"gggﬁ)’;ﬁ r};ﬁm 032 precisely since it will not change motor performance. Typical Max Speed sets a reference point
Max Speed for the “rate” parameters (accel, decel, brake rates), so that applications that have a changing
?’ LSS Max_Speed_SpdM will not experience changes in the rates (because the rates are referenced to
1
Response ment p.35 the unchanging Typical Max Speed value). Once you set the Typical Max Speed parameter you
Accel Rate should not readjust it without adjusting all the rate parameters as well.
Decel Rate
Brake Rate d. Kp and Ki (LS & HS) typically do not need to be changed as the default values work well in
Resstg;;'gtgeg;e e3'37 most applications. These parameters control how tightly the actual motor speed will track the
Position Hold requested speed trajectory (speed trajectory is set by the Accel, Decel, and Brake rates).
menu p.38
EM Brake Control menu p.49
Typical Max Speed p.54 If you want to adjust the Kp (for looser or tighter following of the speed trajectory), follow these guidelines.

« Set the following parameters. Before setting them, make a note of their present (default)
settings so you can return them to these original values at the end of this procedure.

- In the Speed Mode » Speed Controller menu, set the Max Speed to low value
(=1000 rpm), as high speed operation is not needed to observe system response.

- In the Speed Mode » Response menu, set all the Accel and Decel rates to their
fastest values (0.1 seconds); this allows better observation of the system response.

- In the Speed Mode » Restraint menu, set the Soft Stop Speed parameter = 0 rpm
to disable the soft stop speed function.

- In Speed Mode » Restraint » Position Hold Menu, set Position Hold Enable = Off
such that the position hold function will not interfere with the speed control gain
setup procedure.

- Ifyour vehicle has an EM Brake, in the EM Brake menu, set the EM Brake Type = 1.
This setting will release the EM Brake as soon as interlock is asserted.
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o Cycle KSI to clear any faults. Then, assert (close) the Interlock.

« Using very quick, pulsing throttle movements, increase the throttle and then
release it to 0%. The intent is to give the speed controller torque impulses.

 Increase Kp and repeat the throttle tests. Increase Kp until you start to notice
marginal stability (normally motor bouncing, or continuous oscillation
in the gears, is heard). Note: It is possible that very heavy vehicles will not
experience marginal stability even at the highest setting of Kp.

» Once the Kp setting for marginal stability is found, reduce the Kp value
by about one third (i.e., final Kp = marginal stability Kp * 2/3).

o Ifyou will be using Speed Mode Express, enter this Kp value for
the Kp parameter in the Speed Mode Express menu.

« Set the Max Speed, Accel/Decel, Soft Stop Speed, Position Hold,
and Brake Type parameters back to their original values.

Quick Links: e. In the Speed Mode » Response menu, adjust the five Accel and Decel Rate
Speed Mode menu p.32 . R K . K
Speed Controller menu p.32 parameters as necessary while moving the throttle to different positions (i.e.,
Max Speed neutral to full throttle, half throttle to full throttle, full throttle to half throttle, full
g’ (LS/HS) throttle to neutral, neutral to low throttle, etc.). For AC pump applications, these
Response menu p.35 parameters are typically set very fast for quick response to hydraulic inputs.
Accel R . .
i thtee f. Inthe Speed Mode » Response menu, adjust the remaining three brake rate parameters as
Brake Rate necessary while reversing the throttle input (i.e., full throttle forward to low throttle reverse,
Resstrj‘c;’;tt’”eg“ 5-37 full throttle forward to full throttle reverse, full throttle reverse to low throttle forward, etc.).
oft Stop Spee
Position Hold If a brake input is present in the application (Brake Pedal Enable = On) continue adjusting
menu p.38

these three brake rates by applying different amounts of brake throttle (i.e., full throttle
forward, then apply full brake or full throttle forward, then apply low brake, etc.).

For AC pump applications these parameters have no effect on performance
since the AC pump will not run in reverse nor with a brake input.

g. The parameters in the Speed Mode » Response » Fine Tuning menu typically do
not need to be changed as the default values work well in most applications.

« »

A W ARN I N G AC pump motor applications, which in step “a” had the Pump Enable parameter set to On, may
also be controlling hydraulic valves (load hold valve, proportional valve). The Proportional Driver
parameters (page 53) and some VCL will typically be used to set up the control of these valve
driver outputs. Consult with your Curtis distributor or support engineer regarding hydraulic
valve control.
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Quick Links:
Torque Mode/Speed
Limiter p.39

Kp

Ki

Kd

Response menu p.40

Fine Tuning p.41

Figure 9 p.42
Current Limits menu p.43
Typical Max Speed p.54

2 -

Torque Mode Tuning (see pages 39-42)

a.

b.

Set Max Speed to the maximum speed you want to limit the motor to.

Kp, Ki, and Kd typically do not need to be changed as the default values will
work well in most applications. These parameters control how tightly the
controller limits the speed of the motor to the programmed Max Speed.

Set Typical Max Speed to the expected maximum speed of the motor.
Adjust the parameters shown in Figure 9 to set up the throttle mapping:
o Drive Current Limit (Current Limits menu)

« Regen Current Limit (Current Limits menu)

o Forward/Back Full Restraint Speed (Torque Mode » Response menu)
 Brake Taper Speed (Torque Mode » Response » Fine Tuning menu)

« Neutral Braking (Torque Mode » Response menu)

 Neutral Taper Speed (Torque Mode » Response menu)

+ Creep Torque (Torque Mode » Response » Fine Tuning menu).

In the Torque Mode » Response menu, adjust the four accel, decel, and
release rate parameters as necessary while moving the throttle to different
positions (i.e., neutral to full throttle, half throttle to full throttle, full throttle
to half throttle, full throttle to neutral, neutral to low throttle, etc.).

The other parameters in the Torque Mode » Response » Fine Tuning menu typically may need
to be changed for some applications. Read the parameter descriptions and adjust as necessary.

pg. 96

9 — TUNING GUIDE



Return to TOC

Curtis 1232E/34E/36E/38E & 1232SE/34SE/36SE/38SE Manual, os 31 — May 2017

10 — VEHICLE CONTROL LANGUAGE (VCL)

Curtis 1232E/34E/36E/38E and 1232SE/34SE/36SE/38SE controllers have a built-in programmable
logic controller with application-specific functions. VCL (Vehicle Control Language) software
provides a way to implement unique and complex vehicle control functions.

VCL is a simple programming language that will feel very familiar to anyone who has worked with
BASIC, Pascal, or C. Working with VCL requires the installation of the WinVCL program onto a PC.
WinVCL will compile VCL programs and flash download the software into the controller through
the computer’s serial port. The install process for WinVCL will also install three important manuals
on your PC: the WinVCL User’s Guide, VCL Programmer’s Guide, and VCL Common Functions
Manual. These manuals, which are in PDF format, include more detailed information about VCL
than is included here.

This chapter of the manual summarizes VCL and also describes aspects and functions of VCL that
are specific to these E and SE controllers. For a more complete understanding of the functions and
capabilities of VCL, see the WinVCL User’s Guide, VCL Programmer’s Guide, and VCL Common
Functions Manual.

Summary of VCL Basics

o VCL is not case-sensitive:
put_pwm(), Put_ PWM(), and PUT_PWM() are identical.

« Spaces in variable names are not allowed in VCL; use underscores in place of spaces.
Example: Forward_Offset is the VCL name for the 1313/1314 parameter
Forward Offset.

« Functions are followed by parentheses; for example:
Reset_Controller() is a function
Reset_Voltage is a variable.

+ Logical statements must be inside parentheses; examples:
IF (setpoint >50)
ELSE IF ((setpoint <20) & (temperature >100)).

« Comments are preceded by semicolons.
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The VCL functions described in the VCL Common Functions Manual are available to all 1232E/
SE, 1234E/SE, 1236E/SE, and 1238E/SE controllers. These controllers have these additional specific
functions, listed below. All VCL functions, common and specific, are also available in the controller’s
0s31 SysInfo file.

ENABLE_PRECHARGE() p. 117
DISABLE_PRECHARGE( p. 118
SET_DIGOUT( p. 119
CLEAR_DIGOUT() p. 119
ENABLE_EMER_REV() p. 120
DISABLE_EMER_REV() p. 120
SET_INTERLOCK() p. 121
CLEAR_INTERLOCK() p. 121
SETUP_POT() p. 122

GET_POT() p. 122
SETUP_POT_FAULTS() p. 123
START_PUMP() p. 124
STOP_PUMP() p. 124
AUTOMATE_FREQUENCY_OUTPUT( p. 125
OVERRIDE_EM_BRAKE_PWM() p. 126
RESTORE_EM_BRAKE_PWM() p. 126
MAP_TWO_POINTS() p. 127
BATTERY_COMPENSATE() p. 128

VARIABLE TYPES

VCL provides dedicated space in which to store custom variables. There are four types of variables,
based on their type of storage: volatile storage (RAM) and three types of non-volatile storage
(EEPROM) are available.

RAM variables are stored only while power is on; they are lost at power-down. They must be
initialized on power-up by explicit VCL assignments (i.e., Userl = 12).

NVUser1-15 EEPROM variables are 15 variables automatically saved at power-down and restored
at power-on. During power-down or a power-failure (brownout), these variables are saved to NVMI.
During operation, these variables are also periodically saved (every 6 minutes) to NVM2, thus two
locations are used to preserve the data. At power-up, the data in NVMI is read first, yet if it is
corrupted, the data from NVM2 is restored. See the section on non-volatile memory access in the
VCL Common Functions manual for more information, including caution to changing the NVM2
save rate, and rational of the save/restore strategy.

Block EEPROM are 38 blocks of 15 variables (total of 570 variables), which are stored and recalled
using the functions NVM_Block_Read and NVM_Block_ Write. The 38 blocks are called NVM3-
NVM40. The read and write functions must point to the RAM variables that the EEPROM blocks
should be written from or read to. For example, NVM_Block_Read(NVM10,0,15,User20) will
read the 15 variables stored in EEPROM block NVMI10 and restore those variables to the 15
variables starting with RAM variable User20 (so the 15 EEPROM variables would be restored
to User20-34). See the section on non-volatile memory access in the VCL Common Functions
manual for more information.
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Parameters EEPROM variables are a special type of EEPROM variable that is intended to be used
to create OEM defined 1313/1314 programmer parameters. These parameters can be defined as 16-
bit by using the P_User variables or they can be defined as bit (On/Off ) by using the P_User_Bit
variables. These variables are typically written to EEPROM through the 1313 handheld or 1314 PC
programmer interface (i.e., when a user changes a parameter setting using the 1313). They can be
used in the VCL code, but changing a P_User (or P_User_Bit) value with VCL will only change the
variable value in RAM and will not change the value in EEPROM. Thus, these variables are intended
for creating and defining 1313/1314 programmable parameters only.

VCL can modify the control mode parameters in RAM by using the VCL variable name for the
programmable parameter. For example,

Brake Rate SpdMx = 3000 ;Change Brake Rate to 3.0sec

will change the RAM value of the Speed Mode Express’s Brake Rate; the new value will be used
in determining the braking rate. However, the value of the parameter’s stored EE value remains
unchanged; when the controller is turned off, the RAM value will be lost. The next time the
controller is powered back on, the “old” value of Brake Rate will be restored from EE memory. To
save this RAM value in VCL, you must use the NVM_Write_Parameter function ((i.e., NVM_Write_
Parameter(Brake_Rate_SpdMXx)).

Parameter values that are changed by using the 1313 handheld or 1314 PC programmer are saved
directly to EE memory. The 1313/1314 changes will be retained and restored the next time the
controller is powered back on.

The table below summaries the available VCL variables.

Type Quantity Range
User1 — User120

RAM 420 variables AutoUser1 — AutoUser300
NVUser EEPROM 15 variables NVUser1 — NVUser15
Block EEPROM 38 blocks (15 variable each) NVM3 — NVM40
Parameters EEPROM 150 variables and P_User1 — P_User150

10 variables of 8 bits each (80 bits) P_User_Bit1 — P_User_Bit10
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VCL RUNTIME RATES

VCL is an interpreted language. Each line of VCL code is converted (compiled) into a set of codes
and then flash loaded into the controller. The controller interprets these codes one line at a time while
the system is powered up. Here are the processing rates of the various functions:

ltem Function/ltem Description Quantity | Service Rate
ABS Absolute Value 2 4ms
ADC Analog to Digital Converter Input (Analog1 and Analog2) 2 1ms
CAN CAN Communications 24 4ms
CPY Copy 8 4 ms
DLY Delay 32 1ms
FLT Filter 4 1ms
LIM Limit 4 4 ms
MAP Map 8 4 ms
MTD Multiply then Divide 4 4 ms
NVM Non-Volatile Memory block (NVM3-40) 38 2ms
PID Proportional Integral Derivative 2 4ms
POT Potentiometer Input 2 8 ms
PWM Pulse Width Modulated output 6 4 ms
RMP Ramp 4 1ms
SCL Scaling 8 4 ms
SEL Selector, 2-position switch 8 4 ms
SEL_4P Selector, 4-position switch 8 32ms
SW Switch Input 1* 4 ms
TMR Timers (hourmeters) 3 1ms

*There is only one Switch variable; it has 16 associated bit-variables.
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I/0 CONTROL WITH VCL

Digital Inputs

The controllers each have 16 digital inputs. Nine are switch inputs (Sw_1 through Sw_8, and Sw_16.
These switch inputs are shown on the standard wiring diagram (Figure 3, page 12). The remaining
seven digital inputs are less obvious: one on each driver and digital output (Sw_9 through Sw_15).
These can be used as digital inputs or to sense the state of the output or its wiring (e.g., open
coil check).

To address a digital input in a VCL program, use the desired input label (Sw_1 through Sw_16). You
must use On or Off in the code when determining a switch state; using true/false or 1/0 will give
erroneous results.

if (Sw_ 1 = ON)

{

;put code here to run when switch 1 is On

}

if (Sw_16 = OFF)

{

;put code here to run when switch 16 is Off

}

All switch inputs are automatically debounced by the VCL operating system. This prevents noisy
contacts or contact bounce from causing erroneous events in your VCL code. The debounce time
can be varied from 0 to 32 ms in 4 ms steps, using this function:

Setup Switches(5); 20 milliseconds

If this line is not in the VCL code, the debounce time is set at 16 ms.

Driver and Digital Outputs

There are five driver outputs (PWM1 through PWMS5) and two digital outputs (DigOut6 and
DigOut7). These outputs have variations in current and frequency range. For their specifications,
see “digital and PWM outputs” on page 15.

Driver outputs have high current FET output stages and can be pulse width modulated (PWM)
to vary the average output to inductive loads such as contactors and relays. This is useful when the
battery voltage needs to be brought down for lower voltage coils. The two digital outputs are 1 A
drivers that are only On or Off.

Drivers use a special VCL function to set their PWM level. This PWM level can be set up in a signal
chain to update automatically or can be set directly in the main loop. PWM can be set from 0-100%
using the digital range of 0 to 32767.

Put_PWM (PWM2,16384)
will output a 50% waveform on Driver 2.
Automate PWM (PWM2,@userl)

will continually update the Driver 2 output with the present value of variable User1. This automate
statement needs only to be run once, usually in the initialization section of the VCL program. VCL

can monitor the present value of a PWM driver: the variable PWMx_Output (where “x” is the PWM
channel number) is automatically filled with the present value of the driver output.
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Quick Links:
Throttle Type
Selection p.20-23
Three-Wire p.21
Two-Wire p.20,23
One-Wire p.21
Figure 15 p.105
Figure 17 p.109
Throttle menu p.46
Brake menu p.48
Setup_Pot () p.122

The proportional driver (Driver 5, Pin 2) is different from Drivers 1-4. It can be controlled in two
ways: with the proportional driver processing function (see Figure 17) or with the VCL Put_PWM()
function. The VCL statement Put_ PWM(PWMS5, 16383) will result in a 50% PWM output on pin 2
only if the parameter PD Enable is set to Off. For more information about the proportional driver,
see the section entitled “INTERFACING THE PROPORTIONAL CURRENT DRIVER” on page 109.

Control of the two digital outputs (Digital Outputs 6 and 7) is done using the VCL functions Set_
Digout() and Clear_Digout().

Set DigOut (DigOuté6)

will set Digital Output 6 On (active). VCL can monitor the present value of a digital output driver:

the bit variable Digx_Output (where “x” is the digital output channel number) is automatically filled
with the present value of the driver output (On or Off).

It is important to note that all outputs are active Low. With 100% PWM or an output of “On,” the
FET or transistor will be pulling hard to ground. A DVM on the output will measure near 0 volts.

Potentiometer Inputs

These controllers have two potentiometer inputs, which are typically used for throttle and brake.
Many features (mapping, acceleration rates, etc.) are built in as 1313/1314 programmer parameters.
Still, there are times that these potentiometer inputs may be needed for other functions such as
steering angle or height sensing, or simply as data inputs. The standard way to input pot information
is to set the parameter Throttle Type (or Brake Type) to an appropriate value of 1-4 as described in
the Throttle Type pages, and the Throttle and Brake parameter menus. When set to a value of 1-4,
the resulting signal chain can operate without the use of any VCL.

However, if an OEM wishes to control the throttle (or brake) signal chain in VCL or use the throttle
(or brake) inputs for signals that are not throttle (or brake) signals, then the parameter Throttle Type
(or Brake Type) should be set to a value of 5. Setting the parameter Throttle Type (or Brake Type) to
a value of 5 changes the routing of the appropriate signal chain (either throttle or brake) and allows
the VCL programmer access to the Throttle Pot (or Brake Pot) output variables; see Figure 15.

Using the Setup_Pot() function, executed at the beginning of a VCL program, will define the
potentiometer input connection(s) as THREE_WIRE (uses Pot High and Pot Low connections),
TWO_ WIRE (variable resistor, or rheostat, uses Pot Low but no connection to Pot High), or ONE_
WIRE (a voltage input, no connection to either Pot High or Pot Low).

THREE_WIRE potentiometer connections are the same as the 3-wire potentiometer connections
shown in Figure 5 for Throttle Type 2.

TWO_WIRE potentiometer connections are the same as the 2-wire potentiometer connections
shown in Figure 4 for Throttle Type 1.

ONE_WIRE potentiometer connections are the same as the Voltage Source or Current Source
connections shown in Figure 5 for Throttle Type 2.

Note that the Setup_Pot() function will only work (and is only needed) if the corresponding Type is
set to 5 (Throttle Type = 5 or Brake Type = 5).

Setup_Pot (THROTTLE_POT, THREE_WIRE)
will set up the throttle pot input for wiring using all three connections (pins 15, 16, 18).

To set up the brake pot input for use in VCL, use the Brake_Pot constant in place of the Thottle_Pot
constant in the Setup_Pot function.

Setup_ Pot (BRAKE POT,TWO WIRE)

will set up the brake pot input for wiring using two connections (pins 17, 18).
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The 0-100% position of the potentiometer is represented by a value from 0-32767 in VCL, and is
set up through the VCL Setup_Pot() function. It is important to use the correct setup (ONE_WIRE,
TWO_WIRE, or THREE_WIRE) since the input is automatically re-scaled for 0-100% based on the
wiring used; for example, the voltage at the Pot Low pin is automatically subtracted and re-scaled
on a THREE_WIRE pot.

Another effect of setting the Throttle Type = 5 is that the signal chain for the throttle now gets its
input from a different source. The input to the throttle chain is now a VCL variable called VCL_
Throttle instead of the throttle pot. Similarly, Brake Type = 5 means the brake signal chain will get
its input from a VCL variable called VCL_Brake rather than from the brake pot. The VCL_Throttle
and VCL_Brake variables will need to be controlled in the VCL program.

One of the unique features of the potentiometer inputs (as opposed to the analog inputs) is that
they have automatic pot fault detection functions running in the motor controller OS. The VCL
programmer has access to the pot detection functions with the Setup_Pot_Faults() function. With
this function, VCL can re-set the high and low thresholds at which a fault occurs. This function
also forces the pot value to a definable level if a fault occurs. Note that the Setup_Pot_Faults()
function will work for all throttle Types (1-5). See page 123 for more detail on this function, and
Interfacing the Throttle and Brake Commands (below) for further information on both the
Throttle and Brake processing..

Analog Inputs

These controllers have two generic analog inputs (pins 24 and 8). These are shared as switch inputs
1 and 2 (Sw_1, Sw_2). The values of the analog inputs are automatically placed in VCL variables
Analogl_Input and Analog2_Input every 1 millisecond. Scaling is 0-10V = 0-1023.

User2 = Analog2 Input
will fill the User2 RAM variable with the value of the voltage at pin 8.

The filtered values of the analog inputs are also available and are automatically placed in VCL
variables Analogl_Filtered and Analog2_Filtered. Scaling is 0-10V = 0-1023. The default filter value
is 328 (10 Hz) and can be changed in VCL by changing the Analogl_Filter and Analog2_Filter values.
Scaling is 0-999 Hz = 0-32767.

Analog Output

The 1234E/36E/38E and 1234SE/36SE/38SE controllers have one analog output (pin 30); the 1232E/
SE has no analog output. This output is a special driver output. The switching stage is filtered to
provide a smooth average voltage, instead of the actual PWM waveform seen on Drivers 1-5.
However, AnalogOut uses the same VCL functions Put_ PWM() and Automate_ PWM() used by
these other drivers. The scaling is 0-10 V = 0-32767.

Put PWM (PWM6,6553)

will generate 2.0 volts at the analog output. VCL can monitor this output using the variable Analog
Output.

INTERFACING THE THROTTLE AND BRAKE COMMANDS

VCL can interface and modify the throttle and brake signals at several points, from the potentiometer
to the final motor controller command. VCL can be used to create a completely unique command,
adjust parameters to provide MultiMode, or modify the throttle command based on steering angle,
height, etc.
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Quick Links:
Figure 15 p.105
Throttle_Type parameter p.46
Throttle menu p.46
Pump parameter menu
Speed Mode =0 p.31
Speed Mode =1 p.32-39
Monitor Inputs p.70

Monitor menu
Inputs » Interlock State p.70
Controller » Main State p.74
Troubleshooting
Chart p.132-139

The throttle and brake signal chains within the controller are sophisticated and flexible. Before applying
VCL to modify these chains, it is important to fully understand the ramifications of implementing
changes. The motor and brake command signal chains are illustrated in Figure 15 and discussed below.

Throttle Processing

The top section of Figure 15 shows the throttle processing. The throttle signal chain flows left to right
starting with the throttle pot (wiper). The voltage on the throttle wiper input (pin 16) is processed by
the controller and has the VCL variable name Throttle_Pot_Raw. This variable is displayed as Throttle
Pot (voltage) in the Monitor » Inputs menu of the 1313/1314 programmer. This throttle signal is then
modified by the Throttle Type Processing and Throttle Mapping blocks.

The Throttle Type Processing block combines the Throttle_Type parameter and the throttle
potentiometer input (Throttle_Pot_Raw) to create a 16-bit variable containing the magnitude of the raw
command. This raw command passes to the Throttle Mapping block, which re-shapes the throttle signal
magnitude and direction based on the various Throttle Menu parameters and the direction inputs.

Following the Throttle Mapping block are two switches whose purpose is to give the throttle signal a
small value (1 for the forward switch, and -1 for the reverse switch) to indicate that a direction switch
is On—but only if the throttle signal output from the Throttle Mapping block = 0.

The signal then passes through a selector switch. If the Throttle_Type parameter is set to 5 the
Throttle Mapping block output signal is ignored and the command comes from the VCL variable
VCL_Throttle. The VCL program manipulates the VCL_Throttle variable to get a throttle command.
When the Throttle Type is set to 1-4, the variable VCL_Throttle does nothing, and the Throttle
Mapping block output signal passes through.

After the “Throttle Type = 5” switch, the throttle signal is modified by the multiplying and summing
nodes. These nodes can be adjusted by VCL through the variables Throttle_Multiplier and Throttle_
Offset. This is the basic input point for creating functions like MultiMode, dual drive algorithms, and
height vs. speed control. Note that the throttle multiplier has a built-in “divide by 128 This allows
the VCL to either multiply (Throttle_Multiplier > 128) or divide (Throttle_Multiplier <128) the
nominal throttle value. Typically the default multiplier is set to 128, thus having no net effect. Both
Throttle_Multiplier and Throttle_Offset can be positive or negative.

The throttle signal next passes through a limiter that is active only if a pump motor is being operated (Pump
Enable = On, and optionally if Regen Lower Enable = On, the pump motor can operate in reverse). This
limiter acts to constrain the pump’s throttle signal to 100% (positive for forward motion, or negative when
Regen_Lower_Enable is On), which is appropriate for controlling a hydraulic pump motor in speed mode.

The output of the multiplying, summing and (pump) limiter nodes is the VCL variable called Mapped_
Throttle, which is displayed as Mapped Throttle (percent) in the Monitor » Inputs menu of the 1313
handheld or 1314 PC programmers. A VCL program can control this throttle signal by changing the three
variables VCL_Throttle (only if Throttle Type = 5), Throttle_Multiplier, and Throttle_Offset. The effect
of these variables can be observed as in the 1313/1314’s Mapped Throttle or the VCL Mapped_Throttle
variables. Checking the value of Mapped Throttle (Mapped_Throttle) is a good way to see if your Throttle
Menu parameters are set correctly.

Prior to passing to the final selector switch, the throttle signal passes through a selector which
validates for forward pump operation in speed modes. It will set the pump throttle signal = 0% when,
in either speed mode, Pump Enable = On and the Mapped_Throttle is < 0 (negative). This will prevent
a pump operating in reverse when Regen Lower Enable = Off, or if the controller is in Torque Mode.

The throttle signal continues to a selector switch that will set the throttle signal = 0% if any of the
following conditions are present: Interlock_State = Off, a fault has set throttle request = 0% (Fault
action = ShutdownThrottle), or if Main_State # 5 or 10, or an invalid throttle. An invalid throttle is
when both the Forward and Reverse switches are On, for example.
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Quick Links:
Brake Menu

Brake Pedal Enable p.48
Current Limits Menu

Brake Current Limit p.43
Brake Taper Speed p.41
Monitor

Inputs » Pot2 Raw p.70
Figure 15 p.105
Figure 16 p.108

After this final selector switch the throttle signal is the VCL variable called Throttle_Command, which
is displayed as Throttle Command in the 1313/1314 Monitor » Inputs menu. Throttle_Command is the
final value of the throttle signal chain that is input to the Control Mode Processing block; see Figure 16.
Checking the value of Throttle Command using the 1313/1314 is a good way to see the final throttle signal.

If ABS (Throttle_Command) > 1 count, the motor controller will output signals to the motor to
make it spin.

For investigating why a motor is not spinning, it is useful to use the 1313/1314 programmer to check
the state of the throttle signal from beginning to end: using Throttle_Pot_Raw, Mapped_Throttle,
and Throttle_Command. Once these values are known, the Motor Command Diagram (Figure 15)
can be used to find how that signal progressed from input to final value.

The following throttle processing variables are accessible by VCL:

VCL Variable o
CAN Object Index LI Decription
Throttle Pot_Raw Read Only | Voltage measurement at pin 16, scaled for the proper wiring.
0x3215 0x00
0S Throttle Throttle pot value after mapping, to be used in VCL when VCL
0x3518 0%00 Read Only | Throttle Enable = On and Throttle Type =1 - 4.
xesie o Scale: 0—100%, 0 32,767
Mapped_Throttls Read Only | Throttle pot value after mapping.
0x3211 0x00
VCL_Throttle Read/Write | VCL-accessible throttle command.
0x3218 0x00
Throttie_Multipler Read/Write | Multiplies or divides the throttle signal.
0x3213 0x00
Throttle_Offset Read/Write | Provides a + offset to the throttle signal.
0x3214 0x00
Throttie_Command Read Only | Command resulting from throttle processing.
0x3216 0x00

Brake Processing

Brake processing is optional as it can be turned Off by setting Brake_Pedal_Enable = Oft. If turned On,
brake processing can be done with or without VCL. When the controller is in Speed Mode, any non-
zero brake command will then override the throttle signal and the motor controller will brake to a stop
as determined by the Brake Current Limit and Brake Taper Speed parameters. When the controller is
in Torque Mode, the brake command is multiplied by 2 and subtracted from the throttle command
to produce the final command; thus a 50% brake command will cancel a 100% throttle command.

The lower part of Figure 15 shows the brake signal processing section. The brake signal chain flows
from left to right starting with the physical brake pot. The voltage on the brake wiper input (pin 17)
is processed by the controller and has the VCL variable name Pot2_Raw which is displayed as Pot2
Raw in the programmer’s Monitor » Inputs menu. This brake signal is then modified by the Brake
Type Processing and Brake Mapping blocks.

The Brake Type Processing block uses the Brake_Type parameter and the brake potentiometer input
(Pot2_Raw) to create a signed 16-bit variable. This brake signal then passes to the Brake Mapping
block, which re-shapes the brake signal according to the various Brake Menu parameters.

The brake signal next passes through a selector switch. If the Brake_Type parameter is set to 5 (Brake
Type = VCL input), the Brake Mapping block output signal is ignored and the command comes from
the VCL variable VCL_Brake. The VCL program manipulates the VCL_Brake variable to get a brake
command. Custom braking functions can be set up in this fashion; e.g., braking based on a switch
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Quick Links:
Brake Menu

Brake Pedal Enable p.48
Monitor Inputs

Brake Command p.70
Figure 15 p.105
Figure 16 p.108

Quick Links (for Control

Mode and Motor Control

Processing):

Figure 15 p.105

Figure 16 p.108

Motor Technology p.55

Motor Type p.57

Automated Characterization
AC Induction motors p.85
SPM w/Sin/Cos sensor p.91

position or an internal fault. The brake potentiometer can still be used, but must be set up using the
Setup_Pot() function. When the Brake Type is set to 1-4, the variable VCL_Brake does nothing and
the Brake Mapping block output signal passes through.

After the “Brake Type = 5” switch, the brake signal passes through a limiter which limits the brake
signal to a range of 0-100% (0-32767). After the limiter the brake signal is a VCL variable called
Mapped_Brake, which is displayed as Mapped Brake in the Monitor » Inputs menu. Checking the
value of Mapped_Brake is a good way to see if your Brake Menu parameters are set correctly. A VCL
program can control the brake by changing the variable VCL_Brake (only if Brake Type = 5).

The brake signal then goes through a selector which will change it to 100% if the fault-action
FullBrake is active. (see Troubleshooting Chart).

The brake signal then goes through a third selector switch that will set the brake signal = 0% if the
Brake Pedal Enable parameter is set Off. If set On, then the brake signal will pass through to the
Control Mode Processing block. The brake signal after this third selector switch is the VCL variable
called Brake_Command and Brake Command in the Monitor » Inputs menu.

Brake_Command is the final value of the brake signal chain that is input to the Control Mode
Processing block; see Figure 16. Checking the value of Brake_Command using the 1313 is a good
way to see the final brake signal. Note: If Brake_Command is non-zero in Speed Mode Express or
Speed Mode, the Throttle_Command will be set to 0% (see Fig. 16).

The following brake processing variables are accessible by VCL:

VCL Variable i
CAN Object Index Access Decription

Pot2_Raw .
0x3217 0x00 Read Only | Voltage measurement at pin 17.
0S_Brake Read Onl Brake pot value after mapping, to be used in VCL when VCL
0x3519 0x00 Y| Brake Enable = On and Brake Type = 1-3.
VCL_Brake . i .
0%3219 000 Read/Write | VCL-accessible brake command.
Mapped_Brake .
0%3212  0%00 Read Only | Brake pot value after mapping.
Brake_Command Read Onl Command resulting from brake processin
0x321A 0x00 y g p g.

Control Mode and Motor Control Processing

Figure 16 begins with the Throttle Command and Brake_Command inputs and routes the signals according
to the selected control mode. For the speed modes, a switch will zero the Throttle_Command if the Brake_
Command is any value but 0%. The signal chains are then directed to Speed Mode Express, Speed Mode,
or Torque Mode based on Control Mode Select. Note that in Torque Mode there is no emergency reverse.

The control mode function uses algorithms to convert the incoming throttle and brake signals, the
motor rpm, and associated parameter settings into a Controller Torque Command.

Based upon the control mode selected, the desired Controller Torque Command is calculated, which
is passed to the Motor Control block (see Figure 15). The Motor Control block uses its mathematical
model of the specific motor & technology to generate the high efficiency three-phase outputs that
drive the AC motor via the cables connected to the U, V, and W terminals. For AC Induction
motors, 323 motor characterizations are available using the Motor Type parameter, or a motor can
be characterized (Motor Type 0) following the procedures in Chapter 8a. For application using an
SPM motor and a Sin/Cos sensor, follow the automated characterization procedure in Chapter 8b.
Always select the matching motor technology for the motor utilized.
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Quick Links (for PD text):

Figure 17 p.109
Figure 3, PD Wiring p.12
Proportional Driver
parameters p.53
Monitor
PD Input p.71
PD PWM p.72
PD Current p.72

INTERFACING THE PROPORTIONAL CURRENT DRIVER

VCL code can directly interface the proportional current driver (PD), as shown in Figure 17. VCL
can change the working parameters of the PD and can provide the command.

Depending on how the PD system is to be used, certain parameters need to be set; they can be set
via the 1313/1314 programmer or via VCL.

1. PD_Enable must be set On for current control, otherwise the PD_Output will be
controlled by the VCL function Put_ PWM(PWMS5,xxxx), which is voltage control.

2. Hyd_Lower_Enable must be set On to use the throttle input
to control lowering in a hydraulic lift/lower system.

3. Hyd_Lower_Enable must be set Off to allow using a VCL
variable (VCL_PD_Throttle) as the PD command.

Once the PD parameters are set, the PD_Throttle variable will be mapped between PD_Min_Current
and PD_Max_Current and sent to the dither function. Note that Mapped_Throttle is inverted;
lowering its value (making it more negative) increases the PD_Throttle value.

The Dither function adds and subtracts from the current command to the PD based on PD_Dither_ Percent,
at a rate set by PD_Dither_Period.

The dithered current command is compared to the present PD_Current and the error is fed into a PI
controller. The feedback gains are set by the parameters PD Kp (proportional gain) and PD Ki (integral
gain). The final output is the VCL variable PD_Output, which is displayed in the 1313/1314 programmer’s
Monitor » Outputs menu as PD PWM.

The following PD processing variables are accessible by VCL:

VCL_PD_Throttle
VCL_PD_Throttle

CXI\(I: Ibl‘:/?erci? Ibnlgex Access Decription
I(\)Iligp;etljfhr%tieo 0 Read Only | Command from throttle section.
\é(i'g 5 gEThrootEl{eO 0 Read/Write | VCL-accessible PD command.

P Tote oo | ReadOnly | Resuitant command to the PD.
E?CEC; grgnt 0%00 Read Only | Average current flowing in the PD.
l;?{gozu%lt 0%00 Read Only | Resultant PWM at PD output.

PO hin Gurent ] PD Dither Prcon Y l PPN 12)
Hyd !

ShutdownPD

b @ o Q'( PD_Output
PD Enable

Lower
Enable = On

%c PD_Throttle
o

+ %Dither

PD Throttle

|
|
|
|
Mapped_Throttle D %O_T I
I\
0% 0 32767

ShutdownThrottle
or
Throttlelnvalid
or
(CANopen Interlock = On

an
CAN NMT State = Pre-operational)

s i Sl Sk Y
% T
0A
- %Dither f
— /]

Dither Period

PD PWM

Current Mapping Dither

PI Control
PD_Current

Bold = Parameters Italics = Other R/W Variables

Bold Italics = Monitor Variables

Figure 17

Proportional driver processing.
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USING THE FAULT HANDLER IN VCL

The controller’s operating system detects various faults and takes appropri-ate fault actions to
protect the controller. These faults have fault codes that are flashed on the controller status LEDs.
The fault text is displayed in the System Faults and Fault History menus of the 1313 handheld and
1314 PC programmers. These operating system faults are covered in more detail in Chapter 10’s
Troubleshooting Chart.

Additionally, the operating system makes the status of the operating system faults available for use in
VCL programs in the form of nine variables called Statusl, Status2, Status3, Status4, Status5, Status6,
Status7, Status8, and Status9. Each of these 16-bit variables contains the status of 8 faults in the lower
byte (the upper byte is always set to 0). These Status1-9 variables are read only (RO) and can be used
in a VCL program to trigger additional fault actions such as sending fault text messages to a display
or blinking a dashboard LED.

Listed below are the the bit locations of each of the operating system faults in the Status 1-9 variables,
applicable to the default 1232E/SE - 1238E/SE controllers:

Statusl

Bit0 = Main Contactor Welded (Code 38)

Bitl = Main Contactor Did Not Close (Code 39)
Bit2 = Pot Low OverCurrent (Code 45)

Bit3 = Throttle Wiper Low (Code 42)

Bit4 = Throttle Wiper High (Code 41)

Bit5 = Pot2 Wiper Low (Code 44)

Bit6 = Pot2 Wiper High (Code 43)

Bit7 = EEPROM Failure (Code 46)

Status2

Bit0 = HPD/Sequencing Fault (Code 47)

Bitl = Severe B+ Undervoltage (Code 17)

Bit2 = Severe B+ Overvoltage (Code 18)

Bit3 = B+ Undervoltage Cutback (Code 23)
Bit4 = B+ Overvoltage Cutback (Code 24)

Bit5 = Sin/Cos Sensor Fault (Code 36)

Bit6 = Controller Overtemp Cutback (Code 22)
Bit7 = Controller Severe Undertemp (Code 15)

Status3

Bit0 = Controller Severe Overtemp (Code 16)
Bitl = Coill Driver Open/Short (Code 31
Bit2 = Coil2 Driver Open/Short (Code 32
Bit3 = Coil3 Driver Open/Short (Code 33
Bit4 = Coil4 Driver Open/Short (Code 34
Bit5 = PD Open/Short (Code 35)

Bit6 = Main Open/Short (Code 31)

Bit7 = EMBrake Open/Short (Code 32)

Status4

Bit0 = Precharge Failed (Code 14)

Bitl = Digital Out 6 Open/Short (Code 26)
Bit2 = Digital Out 7 Open/Short (Code 27)
Bit3 = Controller Overcurrent (Code 12)
Bit4 = Current Sensor Fault (Code 13)
Bit5 = Motor Temp Hot Cutback (Code 28)
Bit6 = Parameter Change Fault (Code 49)
Bit7 = Motor Open (Code 37)
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Statusb

Bit0 = External Supply Out of Range (Code 69)
Bitl = Motor Temp Sensor Fault (Code 29)

Bit2 = VCL Run Time Error (Code 68)

Bit3 = +5V Supply Failure (Code 25)

Bit4 = OS General (Code 71)

Bit5 = PDO Timeout (Code 72)

Bit6 = Encoder Fault (Code 36)

Bit7 = Stall Detected (Code 73)

Statusé

Bit0 = Bad Calibrations (Code 82)

Bitl = [Not Used]
Bit2 = Emer Rev HPD (Code 47)
Bit3 = [Not Used]

Bit4 = Motor Type Fault (Code 89)
Bit5 = Supervisor Fault (Code 77)
Bit6é = Motor Characterization Fault (Code 87)

Bit7 = [Not Used]
Status?7
Bit0 = [Not Used]

Bitl = VCL/OS Mismatch (Code 91)

Bit2 = EM Brake Failed to Set (Code 92)

Bit3 = Encoder LOS (Limited Operating Strategy) (Code 93)
Bit4 = [Not Used]

Bit5 = Dual Severe Fault (Code 75)

Bit6é = Fault On Other Traction Controller (Code 74)

Bit7 = Illegal Model Number (Code 98)

Status8
Bit0 = [Not Used]
Bitl = [Not Used]
Bit2 = [Not Used]
Bit3 = Parameter Mismatch (Code 99)

Bit4 = Severe KSI Undervoltage (Code 17)
Bit5 = Severe KSI Overvoltage (Code 18)
Bit6é = Insulation Resistance Low (Code 76)
Bit7 = Encoder Pulse Count Fault (Code 88)

Status9

Bit0 = Supervisor Incompatible (Code 78)
Bitl = [Not Used]

Bit2 = [Not Used]

Bit3 = [Not Used]

Bit4 = [Not Used]

Bit5 = [Not Used]

Bit6é = Driver Supply (Code 83)

Bit7 = [Not Used]
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CANbus Emergency Messages

The Status1-9 faults form CAN emergency message using little-endian byte ordering, where: Bytel1&2
is the Error Category, Byte3 is the error register which is “set” (01) if there is an active fault, and Bytes
4-8 map into the Status 1-9 faults as per the error category.

Error category = 0x1000 (for Statusl - Statuss)
Byte4 = Statusl
Byte5 = Status2
Byte6 = Status3
Byte7 = Status4
Byte8 = Statusb5

Error category = 0x1001 (for Statusé - Status 10)
Byte4 = Statusé6
Byte5 = Status?7
Byte6 = Status8
Byte7 = Status9
Byte8 = Status .. n/a (Status 10 is not utilized)

Example

CANbus error 00 10 01 00 00 00 08 00 equates to Status4, Bit3, Controller
Overcurrent (Code 12)

The OEM-defined user faults, described next, are also accessible in a CANbus emergency message.
Error category = 0x6200 (for UserFaultl and UserFault2, OEM Defined, implemented
in VCL)

Byte4 = UserFaultl

Byte5 = UserFault2

Byte6 = Not applicable

Byte7 = Not applicable

Byte8 = Not applicable

Example

CANbus error 00 62 01 02 00 00 00 equates to VCLfaultl, Bit 1 (Code 52)
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OEM-defined User Faults

The operating system provides the capability to create OEM-defined custom faults using VCL. Just
as with system faults, the VCL fault codes are flashed on the controller Status LEDs and fault text is
displayed on the System Faults and Fault History menus of the 1313/1314 programmer. Optionally,
the VCL can assign fault actions to occur automatically when the associated fault is set. Sixteen VCL
faults are available, stored in the VCL variables UserFault]l and UserFault2. The UserFault1,2 variables
are Read/Write (R/W) and the 16 faults are mapped & stored in the lower byte of each variable as
shown below:

UserFaultl
Bit0 = VCLfaultl (Code 51)
Bitl = VCLfault2 (Code 52)
Bit2 = VCLfault3 (Code 53)
Bit3 = VCLfault4 (Code 54)
Bit4 = VCLfault5 (Code 55)
Bit5 = VCLfaulté (Code 56)
Bit6 = VCLfault7 (Code 57)
Bit7 = VCLfault8 (Code 58)

UserFault2
Bit0 = VCLfault9 (Code 59)
Bitl = VCLfaultlO0 (Code 61)
Bit2 = VCLfaultll (Code 62)
Bit3 = VCLfaultl2 (Code 63)
Bit4 = VCLfaultl3 (Code 64)
Bit5 = VCLfaultl4 (Code 65)
Bit6 = VCLfaultl5 (Code 66)
Bit7 = VCLfaultlé (Code 67)

The “Code” numbers result in the flashing of the controller status LEDs that help identify the fault
without use of a 1313/1314 programmer. Setting the fault in VCL is done by setting the associated
fault bit in the UserFaultl and 2 variables. Clearing the fault must also be handled by VCL and is
done by clearing the associated fault bit. For example:

if (BDI-Percentage < 10)

{

UserFaultl.2 = ON ; Set VCL Fault bit
else

{

UserFaultl.2 = OFF ; Clear VCL Fault bit

}

This VCL will check to see if the Battery Discharge Indicator is less than 10%. If it is, UserFault1 Bit1
(Code 52) is set. If the BDI is not less than 10%, the fault is cleared. Using just the VCL above in a
program will only result in the flashing of a code 52 on controller status LEDs and no fault actions
will result nor will the 1313/1314 programmer display any text about the fault.
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To add automatic fault actions to the VCL faults, the VCL programmer must define the desired fault
actions by using the sixteen VCL variables: User_Fault_Action_01 through User_Fault_Action_16.
Each of the UserFault bits has a corre-sponding User_Fault_Action_xx variable (where “xx” is the
number of the VCL fault bit). When a VCL fault bit is set, the actions defined in the corresponding
User_Fault_Action_xx variable will be automatically executed by the operating system. For any
user fault, single or multiple actions can be specified. The available fault actions in the User_Fault_
Actions_xx variables are listed below:

Variable

Fault Action

Bit0 = ShutdownMotor

Disable the motor.

Bit1 = ShutdownMainContactor

Shut down the main contactor (only if Main Enable = On)

Bit2 = ShutdownEMBrake

Shut down the EM brake (only if EM Brake Disable Upon Fault = On).

Bit3 = ShutdownThrottle

Set the Throttle_Command = 0%.

Bit4 = Shutdownlinterlock

Set the Interlock_State = Off.

Bit5 = ShutdownDriverl

Shut down Driver1.

Bit6 = ShutdownDriver2

Shut down Driver2.

Bit7 = ShutdownDriver3

Shut down Driver3.

Bit8 = ShutdownDriver4

Shut down Driver4.

Bit9 = ShutdownPD

Shut down Proportional Driver

Bit10 = FullBrake

Set the Brake_Command = 100%.

Bit11 = [reserved]

N/A

Bit12 = TrimDisable

Disable Dual Drive trim calculation.

Bit13 = SevereDual

For Dual Drive system, one controller has a severe fault but the main contactor
must stay closed so the other controller can continue to operate.

Bit14 = ShutdownSteer

Steer angle = 0°.

Bit15 = LOSDual

For Dual Drive system, set the max speed to Dual_LOS_Max_Speed
parameter for operation in Limited Operating Strategy.

The User_Fault_Action_xx variables should be set up at the beginning of a VCL program (before the
main loop) as these fault actions should be defined only once in a program. Here is another example:

User Fault Action 02 = 24 ;Set fault action to ShutdownInterlock

;and ShutdownThrottle

MainLoop:

if (BDI_Percentage < 10)

{

UserFaultl.2 ON

Put Spy Text (“BDI Low”)

}

else

{

UserFaultl.2

}

goto MainLoop

OFF

; Set User Fault bit

Send message to Model 840 display

; Clear User Fault bit
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This time when UserFaultl.2 is set, the operating system will ShutdownInterlock and
ShutdownThrottle (which will result in a Throttle_Command = 0%) in ad-dition to flashing the
code 52 on the controller status LEDs. An additional VCL line was added (Put_Spy_Text (“BDI
Low”)) to show how additional actions beyond those provided in the User_Fault_Action_xx can be
programmed using VCL. In this example the Put_Spy_Text(“BDI Low”) will result in the message
“BDI Low” appearing on the model 840 display (presumably as a message to the vehicle operator).
This example will still not result in any display on the 1313/1314 programmer System Faults and
Fault History menus.

To add the fault text on the System Faults and Fault History menus it is necessary to create a Fault
Definition. Creating 1313/1314 fault definitions is a subject that is covered in detail in the VCL
Programmer’s Guide (Section 5, Support for the 1313/1314 Handheld Programmer). Here is an example
of a fault definition:

User Fault Action 02 = 24 ; Set fault action to ShutdownInterlock
;jand ShutdownThrottle

MainLoop:

if (BDI_Percentage < 10)

{

UserFaultl.2 = ON ;Set User fault bit

Put Spy Text (“BDI Low”) ;Send message to Model 840 display
}

else

{

UserFaultl.2 = OFF ;Clear User fault bit

}

goto MainLoop

; PARAMETER ENTRY “BDI Low Fault”
; TYPE FAULTS

; WIDTH 8BIT

; ALT ADDRESS Hist UserFaultl
; ADDRESS UserFaultl

; BITSELECT 1

; BITACTIVELOW NO

; END
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This example will result in the exact same actions as the last example, except now the fault will be
displayed in the programmer’s System Faults menu (only while the fault is set) and this fault will
be logged into the Fault History menu after being set. The text displayed in either of these menus
will be the text defined in the fault definition (in this example “BDI Low Fault” will be displayed).
The variable Hist_UserFaultl is listed as an ALT _ADDRESS. This line controls whether the fault
gets logged into fault history (and thus appears in the programmer’s Fault History menu). The two
variables that can be used in the fault definitions for ALT ADDRESS are Hist_UserFaultl and
Hist_UserFault2; these should be used in the fault definitions with the corresponding UserFault1
and UserFault2 variables. If you wish to use VCL to clear fault history, use the VCL function Clear_
Diaghist(). Also note that this example fault definition was for bit 1 of UserFaultl. The VCL example
set and cleared this bit by using the UserFault1.2 notation (“2” being the mask that defines bit 1).

CAN Indexes for the User Fault Variables
The CAN indexes for the various OEM-defined VCL user fault variables are shown below.

0x3238
0x389A
0x3231
0x3239
0x389B
0x3232
0x323B
0x323C
0x323D
0x323E
0x323F
0x3240
0x3241
0x3242
0x3243
0x3244
0x3245
0x3246
0x3247
0x3248
0x3249
0x324A

0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00
0x00

UserFaultl
UserFaultl History
Hist UserFaultl
UserFault2
UserFault2_ History
Hist UserFault2

User Fault Action 01
User Fault Action 02
User Fault Action 03
User Fault Action 04
User Fault Action 05
User Fault Action 06
User Fault Action 07
User Fault Action 08
User Fault Action 09
User Fault Action 10
User_Fault_ Action_ 11
User Fault Action 12
User Fault Action 13
User_Fault_ Action_ 14
User Fault Action 15

User Fault Action 16
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VCL FUNCTIONS SPECIFIC TO 1232E/SE, 1234E/SE, 1236E/SE,
AND 1238E/SE CONTROLLERS

Function descriptions are provided here for the functions that are unique to these controllers.
They are presented in the same format that is used in the VCL Common Functions Manual for the
common functions.

ENABLE_PRECHARGE()

This function is designed to precharge the capacitor bank before engaging a main contactor thereby
preventing current surges and to protect controller internal components and main contactor tips.
This function turns on the request for precharge of the capacitor bank from KSI.

When the precharge function is enabled, power will be supplied to the capacitor bank until the
voltage is within the factory-set range of KSI, or the precharge time limit has expired, or the precharge
resistor energy range has been exceeded. The current state of precharge is shown by the precharge
variable (Precharge_State), which has the following values:

0 — Precharge has not yet been done.

1 — Precharge is in progress.

2 — Precharge has passed.

3 — Precharge has been aborted by the Disable_Precharge() function.
4 — Precharge has exceeded the precharge resistor energy limit.

5 — Precharge has exceeded the one-second time limit.

Syntax: Enable Precharge ()
Parameters: None.
Returns:
0 — Precharge not enabled.
1 — Precharge successfully enabled.
Error Codes: None.
Example: Enable Precharge ()
This will attempt to precharge the capacitor bank.
Note: Use this function only when the precharge is under VCL control.
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DISABLE_PRECHARGE()

This function is designed to abort the precharge function and clear any precharge fault. This function
aborts the request for precharge of the capacitor bank from KSI. The resultant state of the precharge
variable (Precharge_State) will be set to = 3 (for precharge aborted). The precharge states are:

0 — Precharge has not yet been done.

1 - Precharge is in progress.

2 — Precharge has passed.

3 — Precharge has been aborted by the Disable_Precharge() function.

4 — Precharge has exceeded the precharge resistor energy limit.

5 — Precharge has exceeded the one-second time limit.

Syntax: Disable Precharge()
Parameters: None.
Returns:
0 — Precharge not enabled.
1 — Precharge successfully enabled.
Error Codes: None.
Example: Disable Precharge ()

This will attempt to abort the precharge of the capacitor bank
and will clear any precharge fault.
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SET_DIGOUT()

This function turns on the selected digital output. The digital outputs are active low (On = driver on and
pulled to ground, Off = open circuit at the pin).

Syntax:

Parameters:

Returns:

Error Codes:

Example:

CLEAR_DIGOUT()

Set_Digout (DigOut_1ID)

DigOut_ID is the digital output identification.
DigOut6 = Digital Output 6 (pin 19).
DigOut7 = Digital Output 7 (pin 20).

0 — Selected digital output not set.
1 — Selected digital output successfully set.

Bad_ID is returned when DigOut_ID is not in the range of
DigOut6 to DigOut7.

Set Digout (DigOuté)

This example will set Digital Output 6 (pin 19) On (active low,
pulled to ground).

This function turns off the selected digital output. The digital outputs are active low (On = driver on and
pulled to ground, Off = open circuit at the pin).

Syntax:
Parameters:

Returns:

Error Codes:

Example:

Clear Digout (DigOut_ ID)

DigOut_ID is the digital output identification.
DigOut6 = Digital Output 6 (pin 19).
DigOut7 = Digital Output 7 (pin 20).

0 - Selected digital output not cleared.
1 — Selected digital output successfully cleared.

Bad_ID is returned when DigOut_ID is not in the range of
DigOut6 to DigOut7.

Clear Digout (DigOuté6)

This example will set Digital Output 6 (pin 19) Off (open circuit).
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ENABLE_EMER_REV()

This function is used to engage emergency reverse using VCL. The EMR Type parameter must be set
to = 1 in order for the Enable_Emer_Rev() function to operate. If the system emergency reverse state
is enabled (EMR_State bit variable = On), the emergency reverse function will operate according
to the Emergency Reverse parameter settings; see page 65. To view the current emergency reverse
state, see Monitor » Inputs: Emer Rev on the 1313/1314 programmer.

When the EMR_Type is set to = 1 and neither the Enable_Emer_Rev() nor the Disable_Emer_Rev()
function has been called, the state for emergency reverse is Oft (EMR_State bit variable = Off).

Syntax: Enable Emer Rev ()
Parameters: None.
Returns:
0 — Emergency reverse not enabled.
1 — Emergency reverse successfully enabled.
Error Codes: None.
Example: Enable Emer Rev ()
This will enable the emergency reverse function.

DISABLE_EMER_REV()

This function is used to disengage emergency reverse using VCL. The EMR Type parameter must be
set to = 1 in order for the Disable_Emer_Rev() function to operate. If the system emergency reverse
state is disabled (EMR_State bit variable = Off), the emergency reverse function will stop operating
and normal motor control function will resume (including an HPD/SRO check if the HPD/SRO
Enable parameter is set to On). To view the current emergency reverse state, see Monitor » Inputs:
Emer Rev on the 1313/1314 programmer.

When the EMR_Type is set to = 1 and neither the Enable_Emer_Rev() nor the Disable_Emer_Rev()
function has been called, the state for emergency reverse is Off (EMR_State bit variable = Off).

Syntax: Disable Emer Rev()
Parameters: None.
Returns:
0 — Emergency reverse not disabled.
1 — Emergency reverse successfully disabled.
Error Codes: None.
Example: Disable Emer Rev ()
This will disable the emergency reverse function.
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SET_INTERLOCK()

This function is used to engage the system interlock using VCL. The Interlock Type parameter (page 52) must
be set to = 1 in order for the Set_Interlock() function to operate. If the system interlock is set (Interlock_
State bit variable = On), the throttle input signal is allowed to pass along the throttle chain; see Figure 15.
Additionally, if the main contactor is used (Main Enable parameter = On), setting the interlock will request
the main closed state from the main contactor state machine. To view the current interlock state, see the
Monitor » Inputs: Interlock. To view the current main contactor state, see Monitor » Controller: Main State.

When the Interlock_Type is set to = 1 and neither the Set_Interlock() nor the Clear_Interlock() function has
been called, the state for the interlock is Off (Interlock_State bit variable = Off).

Syntax: Set Interlock()
Parameters: None.
Returns:
0 - Interlock not set.
1 — Interlock successfully set.
Error Codes: None.
Example: set Interlock ()

This will engage the system interlock.

CLEAR_INTERLOCK()

This function is used to disengage the system interlock using VCL. The Interlock Type parameter must be set
to = 1 in order for the Set_Interlock() function to operate. If the system interlock is cleared (Interlock_State
bit variable = Off), the throttle input signal is not allowed to pass along the throttle chain; see Figure 15.
Additionally, if the main contactor is used (Main Enable parameter = On), clearing the interlock will request
the main open state from the main contactor state machine. To view the current interlock state, see Monitor
» Inputs: Interlock. To view the current main contactor state, see Monitor » Controller: Main State.

When the Interlock_Type is set to = 1 and neither the Set_Interlock() nor Clear_Interlock() function has been
called, the default state for the interlock is Off (Interlock_State bit variable = Off).

Syntax: Clear Interlock()
Parameters: None.
Returns:
0 - Interlock not cleared.
1 — Interlock successfully cleared.
Error Codes: None.
Example: Clear Interlock()
This will disengage the system interlock.
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SETUP_POT()

This function determines the type of electrical connection of the Throttle Wiper (J1-16) and Pot2
High (J1-27) potentiometers (pot inputs).

One wire potsarea 0 - 5 V input.

Two wire pots are rheostats.

Three wire pots use the pot-high and pot-low as their high and low references.

Syntax:
Parameters:
POT _ID

Type
Returns:

0
1

Errors
BAD_ID
BAD P TYPE

GET_POT()

Setup Pot (Pot ID, Type)

Pot (ID) Selector (THROTTLE_POT,or BRAKE_POT)
Pot type (ONE_WIRE, TWO_WIRE, or THREE_WIRE)

Setup not successful

Setup successful

POT_ID out of Range
Pot Type out of Range

This function returns the value of the selected pot; 0 - 32767 equating to 0 — 100% over the

0 - 5.00 V input range.

Syntax:
Parameters:
POT _ID

Returns:
0

n

Errors
BAD_ID

Get Pot (POT_ID)

Pot Selector (THROTTLE_POT,or BRAKE_POT)

Pot = 0 or error.

Pot value.

POT_ID out of Range
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SETUP_POT_FAULTS()

This function re-sets the upper and lower wiper fault voltages for the specified pot-input that will be
used to activate a pot-wiper voltage fault. The valid range for the function parameters are 0 - 6.25
V (0 - 400 counts). If this function is not run, the default thresholds depend on the Throttle Type
(or Brake Type) parameter setting; see table below. If the Throttle Type = 5 (or Brake Type = 5), the
VCL function Setup_Pot will determine what fault thresholds are used.

Throttle Type Low Fault Threshold High Fault Threshold
1 01V 55V
2 NONE 55V
3 01V 55V
4 01V 55V
5 (ONE_WIRE) NONE 55V
5 (TWO_WIRE) 01V 55V
5 (THREE_WIRE) 01V 55V
Syntax: Setup Pot Faults(Pot ID, Low Fault, High Fault,
Fault Value)
Parameters: pot_ 1D identifies the throttle whose fault limits are being set:
Throttle Pot
Brake Pot
Low Fault: Specifies the lower threshold voltage limit.
Scaling: 1V = 64 counts.
High Fault: Specifies the upper threshold voltage limit.
Scaling: 1 V = 64 counts.
Fault Value: The value that is used for the pot input when
there is a fault (0-32767).
Scaling: + 32767 = + 100%.
Returns:

Error Codes:

Example:

0 — Setup did not execute.
1 — Setup successful.

Bad_ID is returned when an incorrect pot ID is used.
Param_Range is returned when the voltage value is not within
range.

Setup Pot Faults (THROTTLE POT,19,320,4000)

For the throttle pot, this will set the lower pot voltage to 0.3 V
(19/64) and the upper pot voltage to 5.0 V (320/64). When there
is a pot fault, the value of 4000 will be used. That is 4000/32767
of the full output, or roughly 12%.
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START_PUMP()

This function is used to turn on the pump lift contactor (pin 4). If the parameter Drivers » Driver3
» Contactor Enable = On (VCL HydraulicContactorEnable bit variable = On), the VCL function
Start_Pump() will turn on the pump lift contactor (Driver 3).

When HydraulicContactorEnable = On and neither Start Pump() nor Stop_ Pump() has been called,
the pump lift contactor is Off.

Syntax: Start Pump ()
Parameters: None.
Returns:
0 — Pump start function not enabled.
1 — Pump start function successfully enabled.
Error Codes: None.
Example: start Pump ()

This will turn on the pump lift contactor.

STOP_PUMP()

This function is used to turn off the pump lift contactor (pin 4). If the parameter Drivers » Driver3
» Contactor Enable = On (VCL HydraulicContactorEnable bit variable = On), the VCL function
Start_Pump() will turn off the pump lift contactor (Driver 3).

When HydraulicContactorEnable = On and neither Start Pump() nor Stop_ Pump() has been called,
the pump lift contactor is Off.

Syntax: Stop_ Pump ()
Parameters: None.
Returns:
0 — Pump stop function not enabled.
1 — Pump stop function successfully enabled.
Error Codes: None.
Example: Stop_ Pump ()

This will turn off the pump lift contactor.
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AUTOMATE_FREQUENCY_OUTPUT()

This function sets up the PD Driver (pin 2) PWM output to yield a frequency proportional to
the input variable at an execution rate of 16 ms. This output can be used to drive an electronic
speedometer or tachometer.

An additional VCL variable called Frequency_Output_Duty_Cycle works in conjunction with the
Automate_Frequency_Output() function to modify the duty cycle of the output. The default value
of Frequency_Output_Duty_Cycle is 50% (or

Syntax:
Parameters:
@Source
MinInput
MaxInput
MinOutput

MaxOutput

Returns:

Error Codes:

Example:

Automate Frequency Output ()

Index of source value to be the input.

Holds the minimum value for the input.

Holds the maximum value for the input.

Holds the minimum value for the output in Hz.
Holds the maximum value for the output in Hz.

NOTE: The frequency range is 0-4000 Hz, with 4 Hz being the
minimum active frequency, and 0-3 Hz = Off.

0 - PWM not automated.
1 - PWM automated.

Param_Range is returned when a parameter is out of range.
PT_Range is returned when the Parameter Table Index is out

of range.

To set up the PD Driver to output 500 Hz to 1500 Hz (at duty
cycle = 25%) for motor speed in the range 100 rpm to 4000 rpm:

Frequency Output Duty Cycle = 8192 ;set duty cycle = 25%
Automate Frequency Output (@ABS Motor Speed, 100,4000,500,1500)
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OVERRIDE_EM_BRAKE_PWM()

This function is designed to override EM Brake. When this function is enabled, it resets the hill hold
memory value.

Syntax: Override EM Brake PWM(Kill Hill Hold)
Parameters: Kill_Hill_Hold
0 — Retain hill hold memory.
1 — Reset hill hold memory.
Returns:
0 — Failed to override EM brake.
1 — Succeeded in overriding EM brake.

Error Codes: None.

RESTORE_EM_BRAKE_PWM()
This function returns control of the EM brake PWM to the EM brake state machine.

Syntax: Restore EM Brake PWM()
Parameters: None
Returns:
0 — Failed
1 - Success.

Error Codes: None.
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MAP_TWO_POINTS()

This function interpolates values between two points, Y1 and Y2; based upon an X input parameter.

Interpolating based on X1 and X2.

Typical Usage:

1. Calculate a value framed between two X-axis points projected across two Y
points, where the functions” output is the value of the Y-axis intersection.

2. Extend the 7 pair limitation of the Setup_Map function by the use of
multiple If, If Else statements on segments of an XY array.

Map Two Points (X,X1,X2,Y1,Y2)

Syntax:
Parameters:
X Input.
X1 Input point X1.
X2 Input point X2.
vl Output point Y1.
v2  Output point Y2.
Returns:
n Mapped value.

Error Codes:
Example:

None.

Convert a controller value, such as Steer_Angle, to a voltage.
The input (X) is the Steer_Angle variable, where X1-X2 is an
angle between 0 and 90 Degrees. The output is the interpolated
value across Y-axis points in Volts.

Enable the expansion of the Setup_Map(16) function beyond the
seven (7) point-pair by the use of multiple If, If Else statements
on segments of a two point XY array. For Example:

If(X < 1)

{
Y = Map_Z_Points(X, X1, X2, Y1, Y2)
Else If(0<= X <= 1)
Y = Map two Points (X, X1, X2, Y1, Y2)
}
Else If(1l< X <= 2)
{
Y = Map Two_ Points (X, X1, X2, Y1, Y2)
}
Else If(2< X <= 3)
{
Y = Map Two_ Points (X, X1, X2, Y1, Y2)
Etc.
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BATTERY_COMPENSATE()

This function is used to compensate a variable with battery voltage using the nominal battery setting.

Syntax: Battery Compensate (Input)
Parameters:

Input  Variable to be compensated.

Returns:

n Output.

Error Codes: None.
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11 — DIAGNOSTICS AND TROUBLESHOOTING

These controllers detect a wide variety of faults or error conditions. Faults can be detected by the
operating system or by the VCL code. This chapter describes the faults detected by the operating system

Faults detected by VCL code (faults 51-67 in Table 6) cannot be defined here as they will vary from
application to application. Refer to the appropriate OEM documentation for information on these faults.

DIAGNOSTICS

Diagnostics information can be obtained in either of two ways: (1) by reading the display on a 1313
handheld or 1314 PC programmer or (2) by observing the fault codes issued by the Status LEDs. See
Table 5 for a summary of LED display formats.

The 1313 /1314 programmer will display all faults that are currently set as well as a history of the
faults that have been set since the history log was last cleared. The 1313/1314 displays the faults by
name.

The pair of LEDs built into the controller (one red, one yellow) produce flash codes displaying all the
currently set faults in a repeating cycle. Each code consists of two digits. The red LED flashes once
to indicate that the first digit of the code will follow; the yellow LED then flashes the appropriate
number of times for the first digit. The red LED flashes twice to indicate that the second digit of the
code will follow; the yellow LED flashes the appropriate number of times for the second digit.

Example:
B+ Undervoltage Cutback (code 23).

In the Fault menu of the 1313/1314 programmer, the words B+ Undervoltage Cutback will be
displayed; the real-time battery voltage is displayed in the Monitor menu (“Capacitor Voltage”).

The controller’s two LEDs will display this repeating pattern:

Red Yellow Red Yellow
* % * % % % 3k
(first digit) 2) (second digit) 3)

The numerical codes used by the yellow LED are listed in the troubleshooting chart (Table 6), which
also lists possible fault causes and describes the conditions that set and clear each fault.
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Summary of LED Display Formats

The two LEDs have four different display modes, indicating the type of information they are providing.
Table 5 Types of LED Display

Display Status
Neither LED illuminated | Controller is not powered on; or vehicle has dead battery; or severe damage.
Yellow LED flashing Controller is operating normally.
Zﬁ":g}'i da nd red LEDs both Controller is in Flash program mode.

Red LED on solid Internal hardware fault detected by the Supervisor or Primary microprocessor.
Missing or corrupt software. Interrupting a software download may cause
corruption of the software. Cycle KSI to clear. Reload software or replace
controller if necessary.

Red LED and yellow LED | Controller has detected a fault. 2-digit code flashed by yellow LED identifies the

flashing alternately specific fault; one or two flashes by red LED indicate whether first or second code
digit will follow.
TROUBLESHOOTING

The troubleshooting chart, Table 6, provides the following information on all the controller faults:

o fault code

o fault name as displayed on the programmer’s LCD
o the effect of the fault

« possible causes of the fault

o fault set conditions

o fault clear conditions.

Whenever a fault is encountered and no wiring or vehicle fault can be found, shut off KSI and turn it
back on to see if the fault clears. If it does not, shut oft KSI and remove the 35-pin connector. Check
the connector for corrosion or damage, clean it if necessary, and re-insert it.
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The fault actions (effect of fault) in Table 6 use the same bit-structure as the User_Fault_Action_xx
listed in the OEM-defined User Faults on page 113. The variable System_Action (available in WinVCL
Monitor or TACT) returns the decimal number corresponding to the active fault action bit(s). The
Dual Drive fault actions, Bits 12-15, are listed in the supplemental Dual Drive Operation manual.

System_Action Bit

Action

No defined System_Action

Effect of fault as noted in Table 6

Bit0 = ShutdownMotor

Disable the motor.

Bit1 = ShutdownMainContactor

Shut down the main contactor (only if Main Enable = On)

Bit2 = ShutdownEMBrake

Shut down the EM brake (only if EM Brake Disable Upon Fault = On).

Bit3 = ShutdownThrottle

Set the Throttle_Command = 0%.

Bit4 = ShutdownInterlock

Set the Interlock_State = Off.

Bit5 = ShutdownDriverl

Shut down Driver1.

Bit6 = ShutdownDriver2

Shut down Driver2.

Bit7 = ShutdownDriver3

Shut down Driver3.

Bit8 = ShutdownDriver4

Shut down Driver4.

Bit9 = ShutdownPD

Shut down Proportional Driver

Bit10 = FullBrake

Set the Brake_Command = 100%.

Bit11 = [reserved]

N/A (for 1232—1238E/SE, and 1239E controllers)

Bit12 = TrimDisable

Disable Dual Drive trim calculation.

Bit13 = SevereDual

For Dual Drive system, one controller has a severe fault but the main
contactor must stay closed so the other controller can continue to operate.

Bit14 = ShutdownSteer

Steer angle = 0° (DD applicable).

Bit15 = LOSDual

For Dual Drive system, set the max speed to Dual_LOS_Max_Speed
parameter for operation in Limited Operating Strategy.

Example:
HPD/Sequencing Fault,
Effect of fault =

System Action = 8

(equates to Bit3 set:

Flash Code 47.

Shutdown Throttle.

0000 0000 0000 1000)
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Table 6 TROUBLESHOOTING CHART

PROGRAMMER LGD DISPLAY

CODE EFFECT OF FAULT POSSIBLE CAUSE SET / CLEAR CONDITIONS

12 Controller Overcurrent 1. External short of phase U,V, or W motor Set: Phase current exceeded the current
ShutdownMotor; connections. measurement limit.
gZU;ZOW”/‘E/’IZgC‘;(”?CTOH 2. Motor parameters are mis-tuned. Clear: Cycle KSI.

LtaownEMBIaxe, 3. Controller defective.
ShutdownThrottle; )
FullBrake. 4. Speed encoder noise problems.

13 Current Sensor Fault 1. Leakage to vehicle frame from phase U, | Set: Controller current sensors have invalid offset

ShutdownMotor; V, or W (short in motor stator). reading.
ShutdownMainContactor; 2. Controller defective. -
ShutdownEMBrake; Clear: Cycle KSl.
ShutdownThrottle;

FullBrake.

14 Precharge Failed 1. See Monitor menu » Battery: Capacitor Set: The precharge failed to charge the capacitor
ShutdownMotor; Voltage. bank.

ShutdownMainContactor; 2. External load on capacitor bank (B+ Clear: Cycle Interlock input or use VCL function
ShutdownEMBrake; connection terminal) that prevents the | Enaple_Precharge(.

ShutdownThrottle; capacitor bank from charging. -

FullBrake.

15 Controller Severe Undertemp 1. See Monitor menu » Controller: Set: Heatsink temperature below -40°C.
ShutdownMotor; . Temperatre. Clear: Bring heatsink temperature above -40°C,
ShutdownMainContactor; 2. Controller is operating in an extreme and cycle interlock or KS
shUtdOWnEMBfakB,’ environment. ’

ShutdownThrottle;
FullBrake.

16 Controller Severe Overtemp 1. See Monitor menu » Controller: Set: Heatsink temperature above +95°C.
ShutdownMozfor; ) Temperatu_re. o Clear: Bring heatsink temperature below +95°C,
ShutdownMainContactor; 2. Controller is operating in an extreme and cycle interlock o KS|.

ShutdownEMBrake; environment.
ShutdownThrottle; 3. Excessive load on vehicle.
FullBrake. )

4. Improper mounting of controller.

17 Severe B+ Undervoltage 1. Battery parameters are misadjusted. Set: Capacitor bank voltage dropped below the
No dfive torque. 2. Non_controuer System drain on battery_ Severe Undervoltage ||m|t (See page 25) W|th FET

3. Battery resistance too high. bridge enabled.
4. Battery disconnected while driving. Clear: Bring capacitor voltage above Severe
5. See Monitor menu » Battery: Capacitor | Undérvoltage limit.
Voltage.
6. Blown B+ fuse or main contactor did not
close.

17 Severe KSI Undervoltage 1. See Monitor menu » Battery: Keyswitch | Set: When below Brownout Voltage for 2 seconds
No action. Voltage. (see Table D-1).

2. Non-controller system drain on battery/ | Cjear: Bring KSI voltage above Brownout Voltage.
KSI circuit wiring.

3. KSI disconnected while driving.

4. Blown KSI fuse.

18 Severe B+ Overvoltage 1. See Monitor menu » Battery: Capacitor Set: Capacitor bank voltage exceeded the Severe
ShutdownMotor; Voltage. Overvoltage limit (see page 25) with FET bridge
ShutdownMainContactor; 2. Battery parameters are misadjusted. enabled.
gZu;Zowngfllegkg, 3. Battery resistance too high for given Clear: Bring capacitor voltage below Severe

utaownrhrottie; regen current. Overvoltage limit, and then cycle KSI.
FullBrake. . .
4. Battery disconnected while regen
braking.
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Table 6 TROUBLESHOOTING CHART cont'd

PROGRAMMER LCD DISPLAY
CODE EFFECT OF FAULT POSSIBLE CAUSE SET / CLEAR CONDITIONS

18 Severe KSI Overvoltage 1. Incorrect (to high) battery-voltage Set: KSl voltage exceeded Severe Overvoltage limiit
ShutdownMotor; . applied t? K5l {pin 1) ) Clear: Bring KSI voltage below the Severe
ShutdownMainContactor; 2. See Monitor menu » Battery: Keyswitch | Qvervoltage limit
ShutdownEMBrake; Voltage. (see page 25, Severe Overvoltage)
ihltllgdozvnThrott/e; Note: Prevents the Main Contactor closure if ’

ulibraxe. KSl is greater than the Severe Qvervoltage
limit.

22 Controller Overtemp Gutbhack 1. See Monitor menu » Controller: Set: Heatsink temperature exceeded 85°C.
Reduced drive and brake torque. Temperatu.re. o ) Clear: Bring heatsink temperature below 85°C.

2. Controller is performance-limited at this
temperature.

3. Controller is operating in an extreme
environment.

4. Excessive load on vehicle.

5. Improper mounting of controller.

23 B+ Undervoltage Cutback 1. Normal operation. Fault indicates the Set: Capacitor bank voltage dropped below the

Reduced drive torque. batteries need recharging. Controller is Undervoltage limit (see page 25) with the FET

performance limited at this voltage. bridge enabled.

2. Battery parameters are misadjusted. Clear: Bring capacitor voltage above the

3. Non-controller system drain on battery. Undervoltage limit.

4. Battery resistance too high.

5. Battery disconnected while driving.

6. See Monitor menu » Battery: Capacitor
Voltage.

7. Blown B+ fuse or main contactor did not
close.

24 B+ Overvoltage Cutback 1. Normal operation. Fault shows that regen | Set: Capacitor bank voltage exceeded the
Reduced brake torque. Note: This braking currents elevated the battery Overvoltage limit (see page 25) with the FET bridge
fault is declared only when the voltage during regen braking. Controller | enabled.
controller is running in regen. is performance limited at FhIS _voltage. Clear: Bring capacitor voltage below the

2. Battery parameters are misadjusted. Overvoltage limit.
3. Battery resistance too high for given
regen current.
4. Battery disconnected while regen
braking.
5. See Monitor menu » Battery: Capacitor
Voltage.

25 +5V Supply Failure 1. External load impedance on the +5V Set: +5V supply (pin 26) outside the 5 V+10%
None, unless a fault action is supply (pin 26) is too low. range.
programmed in VCL. 2. See Monitor menu » outputs: 5 Volts and Clear: Bring voltage within range.

Ext Supply Current.

26 Digital Out 6 Open/Short 1. External load impedance on Digital Set: Digital Output 6 (pin 19) current exceeded 1
Digital Output 6 driver will not Output 6 driver (pin 19) is too low. Amp.
turn on. Clear: Remedy the overcurrent cause and use the

VCL function Set_DigOut() to turn the driver on
again.

27 Digital Out 7 Open/Short 1. External load impedance on Digital Set: Digital Output 7 (pin 20) current exceeded 1
Digital Output 7 driver will not Output 7 driver (pin 20) is too low. Amp.
turn on. Clear: Remedy the overcurrent cause and use the

VCL function Set_DigOut() to turn the driver on
again.

11 — DIAGNOSTICS AND TROUBLESHOOTING

pg. 133




Curtis 1232E/34E/36E/38E & 1232SE/34SE/36SE/38SE Manual, os 31 — May 2017

Return to TOC

Table 6 TROUBLESHOOTING CHART cont'd

PROGRAMMER LCD DISPLAY
CODE EFFECT OF FAULT POSSIBLE CAUSE SET / CLEAR CONDITIONS
28 Motor Temp Hot Cutback 1. Motor temperature is at or above the Set: Motor temperature is at or above the
Reduced drive torque. programmed Temperature Hot setting, Temperature Hot parameter setting.
and the current is being cut back. Clear: Bring the motor temperature within range.
2. Motor Temperature Control Menu
parameters are mis-tuned.
3. See Monitor menu » Motor: Temperature
and » Inputs: Analog2.
4. If the application doesn’t use a motor
thermistor, Temp Compensation and Temp
Cutback should be programmed Off.

29 Motor Temp Sensor Fault 1. Motor thermistor is not connected Set: Motor thermistor input (pin 8) is at the voltage

MaxSpeed reduced (LOS, Limited properly. rail (OVor10V).
Operating Strategy), and motor | 3. If the application doesn’t use a motor Clear: Bring the motor thermistor input voltage
temperature cutback disabled. thermistor, Motor Temp Sensor Enable | within range.
should be programmed Off.
3. See Monitor menu » Motor: Temperature
and » Inputs; Analog2.

31 Coil1 Driver Open/Short 1. Open or short on driver load. Set: Driver 1 (pin 6) is either open or shorted. This

ShutdownDriver1. 2. Dirty connector pins. fault can be set only when Main Enable = Off.
3. Bad crimps or faulty wiring. Clear: Correct open or short, and cycle driver.

31 Main Open/Short 1. Open or short on driver load. Set: Main contactor driver (pin 6) is either open
ShutdownMotor; 2. Dirty connector pins. or shorted. This fault can be set only when Main
ShutdownMainContactor; 3. Bad crimps or faulty wiring Enable = On.

ShutdownEMBrake; ’ ’ . ;
ShutdownThrottle; Clear: Correct open or short, and cycle driver
FullBrake.

32 Coil2 Driver Open/Short 1. Open or short on driver load. Set: Driver 2 (pin 5) is either open or shorted. This

ShutdownDriver2. 2. Dirty connector pins. fault can be set only when EM Brake Type = 0.
3. Bad crimps or faulty wiring. Clear: Correct open or short, and cycle driver.

32 EMBrake Open/Short 1. Open or short on driver load. Set: Electromagnetic brake driver (pin 5) is either
ShutdownEMBrake; 2. Dirty connector pins. open or shorted. This fault can be set only when EM
ShutdownThrottle; 3. Bad crimps or faulty wiring. Brake Type >0.

FuliBrake. Clear: Correct open or short, and cycle driver.

33 Coil3 Driver Open/Short 1. Open or short on driver load. Set: Driver 3 (pin 4) is either open or shorted.

ShutdownDriver3. 2. Dirty connector pins. Clear: Correct open or short, and cycle driver.
3. Bad crimps or faulty wiring.

34 Coil4 Driver Open/Short 1. Open or short on driver load. Set: Driver 4 (pin 3) is either open or shorted.

ShutdownDriverd. 2. Dirty connector pins. Clear: Correct open or short, and cycle driver.
3. Bad crimps or faulty wiring.

35 PD Open/Short 1. Open or short on driver load. Set: Proportional driver (pin 2) is either open or
ShutdownPD. 2. Dirty connector pins. shorted.

3. Bad crimps or faulty wiring. Clear: Correct open or short, and cycle driver.

36 Encoder Fault 1. Motor encoder failure. Set: Motor encoder phase failure detected.
ahgtdg,w’éf’ZBr ake; 2. Bad crimps or faulty wiring. Clear: Either cycle KSI, or if parameter LOS Upon

otor aisabied. 3. See Monitor menu » Motor: Motor RPM. Encoder Fault= On and Interlock has been cycled,
then the Encoder Fault is cleared and Encoder LOS
fault (code 93) is set, allowing limited motor control.

36 Sin/Cos Sensor Fault 1. Sin/Cos sensor failure. Set: Greater than Sin_Cos_Fault_Threshold %
ShutdownEMBrake; 2. Bad crimps or faulty wiring. difference from expected value between two phases
Motor disabled. 3. See Monitor menu » Motor: Motor RPM. | S€€N 5 times within one second.

Clear: Cycle KSI, or VCL reset, or Entry into LOS
mode if enabled, (or entry into an ACIM auto-
characterization).
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Table 6 TROUBLESHOOTING CHART cont'd

PROGRAMMER LCD DISPLAY

CODE EFFECT OF FAULT POSSIBLE CAUSE SET / CLEAR CONDITIONS

37 Motor Open 1. Motor phase is open. Set: Motor phase U, V, or W detected open.
ShutdownMotor; 2. Bad crimps or faulty wiring. -

ShutdownMainContactor; P Y g Clear: Cycle KS.
ShutdownEMBrake;

ShutdownThrottle;

FullBrake.

38 Main Contactor Welded 1. Main contactor tips are welded closed. Set: Just prior to the main contactor closing, the
ShutdownMotor; 2. Motor phase U or V is disconnected or capacitor bank voltage (B+ connection terminal)
ShutdownMainContactor; open. was loaded for a short time and the voltage did not
gZU;ZOW”%’;”ng?" 3. An alternate voltage path (such as an discharge.

: ILIIB OI':"” rotie, external precharge resistor) is providing | Clear: Cycle KSI
ulibraxe. a current to the capacitor bank (B+
connection terminal).

39 Main Contactor Did Not Close | 1. Main contactor did not close. Set: With the main contactor commanded closed,
ShutdownMotor; 2. Main contactor tips are oxidized, burned, | the capacitor bank voltage (B+ connection terminal)
ShutdownMainContactor; or not making good contact.* did not charge to B+.
gzz;zgm%%ge 3. Externall load on_capacitor bank (B+ Clear: Cycle KSI.

FullBrake. ’ Conne.cnon terminal) that prevents *New contactors may need to be cycled electrically &
capacitor bank from charging. : ) :
mechanically to remove any non-conductive material on
4. Blown B+ fuse. the tips. Use reduced voltage (e.g., 12V) to prevent tip
damage through excessive arcing.

41 Throttle Wiper High 1. See Monitor menu » Inputs: Throttle Pot. | Set: Throttle pot wiper (pin 16) voltage is higher

ShutdownThrottle. 2. Throttle pot wiper voltage too high. than the high fault threshold (can be changed with
the VCL function Setup_Pot_Faults()).
Clear: Bring throttle pot wiper voltage below the
fault threshold.

42 Throttle Wiper Low 1. See Monitor menu » Inputs: Throttle Pot. | Set: Throttle pot wiper (pin 16) voltage is lower than
ShutdownThrottle. 2. Throttle pot wiper voltage too low. the low fault threshold (can be changed with the

VCL function Setup_Pot_Faults().
Clear: Bring throttle pot wiper voltage above the
fault threshold.

43 Pot2 Wiper High 1. See Monitor menu » Inputs: Pot2 Raw. Set: Pot2 wiper (pin 17) voltage is higher than the
FullBrake. 2. Pot2 wiper voltage too high. high fault threshold (can be changed with the VCL

function Setup_Pot_Faults()).
Clear: Bring Pot2 wiper voltage below the fault
threshold.

44 Pot2 Wiper Low 1. See Monitor menu » Inputs: Pot2 Raw. Set: Pot2 wiper (pin 17) voltage is lower than the
FullBrake. 2. Pot2 wiper voltage too low. low fault threshold (can be changed with the VCL

function Setup_Pot_Faults()).
Clear: Bring Pot2 wiper voltage above the fault
threshold.

45 Pot Low OverCurrent 1. See Monitor menu » Outputs: Pot Low. Set: Pot low (pin 18) current exceeds 10 mA.
ShutdownThrottie; 2. Combined pot resistance connected to | Clear: Clear pot low overcurrent condition and cycle
FullBrake. pot low is too low. KSI.

46 EEPROM Failure 1. Failure to write to EEPROM memory. Set: Controller operating system tried to write to
ShutdownMotor; This can be caused by EEPROM memory | EEPROM memory and failed.
ShutdownMainContactor; writes initiated by VCL, by the CAN .

ShutdownEMBrake; bus, by adjusting parameters with the Clear: .Download the correct softyvare. (0S) and
; . matching parameter default settings into the

ShutdownThrottle, programmer, or by loading new software controller and cycle KS|

Shutdownlinterlock; into the controller. '

ShutdownDriver1;

ShutdownDriver2;

ShutdownDriver3;

ShutdownDriver4;

ShutdownPD;

FullBrake.
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Table 6 TROUBLESHOOTING CHART cont'd

PROGRAMMER LCD DISPLAY
CODE EFFECT OF FAULT POSSIBLE CAUSE SET / CLEAR CONDITIONS
47 HPD/Sequencing Fault 1. KSI, interlock, direction, and throttle Set: HPD (High Pedal Disable) or sequencing fault
ShutdownThrottle. inputs applied in incorrect sequence. caused by incorrect sequence of KSI, interlock,
2. Faulty wiring, crimps, or switches at KS|, | direction, and throttle inputs.
interlock, direction, or throttle inputs. Clear: Reapply inputs in correct sequence.
3. See Monitor menu » Inputs.

47 Emer Rev HPD 4. Emergency Reverse operation has Set: At the conclusion of Emergency Reverse, the
ShutdownThrottle; concluded, but the throttle, forward and | fault was set because various inputs were not
ShutdownEMBrake. reverse inputs, and interlock have not returned to neutral.

been returned to neutral. Clear: If EMR_Interlock = On, clear the interlock,
throttle, and direction inputs. If EMR_Interlock = Off,
clear the throttle and direction inputs.

49 Parameter Change Fault 1. This is a safety fault caused by a change Set: Adjustment of a parameter setting that requires
ShutdownMotor; in certain parameter settings so that the cycling of KSI.

ShutdownMainContactor; vehicle will not operate until KSI is cycled. Clear: Cycle KSI
ShutdownEMBrake; For example, if a user changes the Throttle ' '
ShutdownThrottle; Type this fault will appear and require

FullBrake. cycling KSI before the vehicle can operate.

51-67 OEM Faults 1. These faults can be defined by the Set: See OEM documentation.
(See OEM documentation.) OEM and are implemented in the . :

application-specific VCL code. See OEM Clear: See OEM documentation.
documentation.

68 VCL Run Time Error 1. VCL code encountered a runtime VCL Set: Runtime VCL code error condition.
gﬁuzowmo% ntactor: error. ) Clear: Edit VCL application software to fix this error
Shu ; do EI;B ‘;{ actor, 2. See Monitor menu » Controller: VCL Error | congition; flash the new compiled software and

utaown ra 'e! Module and VCL Error. Tl_]IS error can then matching parameter defau":s; cyc|e KSI.
ShutdownThrottle; be compared to the runtime VCL module
Shutdowninterlock; ID and error code definitions found in the
ShutdownDriver1; specific 0S system information file.
ShutdownDriver2;
ShutdownDriver3;
ShutdownDriver4;
ShutdownPD;
FullBrake.

69 External Supply Out of Range | 1. External load on the 5V and 12V supplies | Set: The external supply current (combined current
None, unless a fault action is draws either too much or too little used by the 5V supply [pin 26] and 12V supply
programmed in VCL. current. [pin 25]) is either greater than the upper current

2. Fault Checking Menu parameters Ext threshold or lower than the lower current threshold.
Supply Max and Ext Supply Min are The two thresholds are defined by the External
mis-tuned. Supply Max and External Supply Min parameter

3. See Monitor menu » Outputs: Ext Supply settings (page 54).

Current. Clear: Bring the external supply current within range.

71 0S General 1. Internal controller fault. Set: Internal controller fault detected.
ShutdownMotor; .

ShutdownMainContactor; Clear: Cycle KS|.
ShutdownEMBrake;

ShutdownThrottle;

Shutdowninterlock;

ShutdownDriver1;

ShutdownDriver2;

ShutdownDriver3;

ShutdownDriver4;

ShutdownPD;

FullBrake.

72 PDO Timeout 1. Time between CAN PDO messages Set: Time between CAN PDO messages received
ShutdownThrottle; received exceeded the PDO Timeout exceeded the PDO Timeout Period.

CAN NMT ‘State setto Period. Clear: Cycle KSI or receive CAN NMT message.
Pre-operational.
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Table 6 TROUBLESHOOTING CHART cont'd

PROGRAMMER LGD DISPLAY
CODE EFFECT OF FAULT POSSIBLE CAUSE SET / CLEAR CONDITIONS
73 Stall Detected 1. Stalled motor. Set: No motor encoder movement detected.
’\‘S/‘lhgtdglwrg‘:'lgﬁr ake; 2. Motor encoder failure. Clear: Either cycle KSI, or if parameter LOS Upon
Cc())n?rijl ;\S/I% dg éhange d10L0S 3. Bad crimps or faulty wiring. Encoder Fault = On and Interlock has been cycled,
(L\m\ted Operating Strate ) 4. Problems with power Supp|y for the then the Stall Detected fault is cleared and Encoder
perating o). motor encoder. LOS fault (code 93) is set, allowing limited motor
5. See Monitor menu » Motor: Motor RPM. control.
74 Fault On Other Traction 1. Dual Drive fault: see Dual Drive manual.
Controller
75 Dual Severe Fault 1. Dual Drive fault: see Dual Drive manual.
77 Supervisor Fault 1. The Supervisor has detected a mismatch | Set: Mismatched redundant readings; damaged
P p g g
ShutdownMotor; in redundant readings. Supervisor; illegal switch inputs.
g’,;ugowngﬁg C(l)(nt'actor; 2. Internal damage to Supervisor Clear: Check for noise or voltage drift in all switch
Shz ; dzm Thrazr‘tale?, MiCroprocessor. inputs: check connections; cycle KSI.
Shutdowninter k 3. Switch inputs allowed to be within
Shu i dOW” g el 0;"_ ’ upper and lower thresholds for over 100
Shz i dzm D; %Z 2’, milliseconds. (for recurring errors, check
Shutdown Driver3:' the switches for moisture).
ShutdownDriver4;
ShutdownPD;
FullBrake.
78 Supervisor Incompatible 1. The main 0S is not compatible with the | Set: Incompatible software.
ShutdownMotor; Supervisor 0S. .
e oad ey el 5 o or ot
ShutdownEMBrake; ' '
ShutdownThrottle;
Shutdowninterlock;
ShutdownDriver1;
ShutdownDriver2;
ShutdownDriver3;
ShutdownDriver4;
ShutdownPD;
FullBrake.
82 Bad Calibrations 1. Internal controller fault. Set: Internal controller fault detection.
ShutdownMotor; .
ShutdownMainContactor; Clear: Cycle KS|.
ShutdownEMBrake;
ShutdownThrottle;
FullBrake.
83 Driver Supply 1. Internal controller fault in the voltage Set: Internal controller fault detection.
ShutdownMotor; supply for the driver circuits. .
ShutdownMainContactor; Clear: Cycle KSI.
ShutdownEMBrake;
ShutdownThrottle;
FullBrake.
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Table 6 TROUBLESHOOTING CHART cont’d

PROGRAMMER LCD DISPLAY
CODE EFFECT OF FAULT POSSIBLE CAUSE SET / CLEAR CONDITIONS
87 Motor Characterization Fault 1. Motor characterization failed during Set: Motor characterization failed during the motor
ShutdownMotor; characterization process. See characterization process.
ShutdownMainContactor; Monitor menu » Controller: Motor Normally caused by turning off
ShutdownEMBrake; Characterization Error for cause: Motor_Characterization_Test_Enable before
ShutdownThrottle; 0 = sequencing error. Normally caused running test. Needs controller reset.
FullBrake. by turning off Motor Characterization | clear: Correct fault; cycle KSI, or VCL reset.
Test Enable before running the test.
1 = encoder signal seen but step size not
auto-detected; set up Encoder Steps
manually
2 = motor temp sensor fault
3 = motor temp hot cutback fault
4 = controller overtemp cutback fault
5 = controller undertemp cutback fault
6 = undervoltage cutback fault
7 = severe overvoltage fault
8 = encoder signal not seen, or one or
both channels missing
9 = motor parameters out of
characterization range
20 = Sin/Cos sensor not found
21 = phasing not detected
22 = Sin/Cos sensor characterization
failure
23 = started characterization procedure
while motor rotating.
88 Encoder Pulse Count Fault 1. Encoder Steps parameter does not Set: Detected wrong setting of the Encoder Steps
ShutdownMotor; match the actual motor encoder. parameter.
gzzgzmgawgg% zfactor; Clear: Ensure the Encoder Steps parameter
ShutdownThrottle; matches the actual encoder; cycle KSI.
Shutdowninterlock;
ShutdownDriver1;
ShutdownDriver2;
ShutdownDriver3;
ShutdownDriver4;
ShutdownPD;
FullBrake.
89 Motor Type Fault 2. The Motor_Type parameter value is out | Set: Motor_Type parameter is set to an illegal
ShutdownMotor; of range. value.
ShutdownMainContactor; .
ShutdownEMBrake; %elar. Set Motor_Type to correct value and cycle
ShutdownThrottle; '
FullBrake.
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Table 6 TROUBLESHOOTING CHART cont'd

PROGRAMMER LCD DISPLAY
CODE EFFECT OF FAULT POSSIBLE CAUSE SET / CLEAR CONDITIONS

91 VCL/0S Mismatch 1. The VCL software in the controller Set:VCL and OS software do not match; when KSI
ShutdownMotor; does not match the OS software in the cycles, a check is made to verify that they match
ShutdownMainContactor; controller. and a fault is issued when they do not.
ShutdownEMBrake; Clear: Download the correct VCL and 0S software
ShutdownThrotte, into the controller.

Shutdowninterlock; '
ShutdownDriver1;

ShutdownDriver2;

ShutdownDriver3;

ShutdownDriver4;

ShutdownPD;

FullBrake.

92 EM Brake Failed to Set 1. Vehicle movement sensed after the EM Set; After the EM Brake was commanded to set
ShutdownEMBrake; Brake has been commanded to set. and time has elapsed to allow the brake to fully
ShutdownThrottle. 2. EM Brake will not hold the motor from engage, vehicle movement has been sensed.
F?S‘}lf)ﬂk"k)'g is engaged when rotating. Clear: 1.Activate the Throttle (EM Brake type 2).
ieriogie= 1. 2. Activate the Interlock (EM Brake type 1).

93 Encoder LOS (Limited 1. Limited Operating Strategy (LOS) control | Set: Encoder Fault (code 36) or Stall Detected (code
Operating Strategy) mode has been activated, as a result of | 73) was activated, if parameter LOS Upon Encoder
Enter LOS control mode. either an Encoder Fault (Code 36) or a Fault = On and Interlock has been cycled, then the

Stall Detected fault (Code 73). Encoder LOS (code 93) control mode is activated,
2. Motor encoder failure_ a”OWing ||m|ted motor Control.
3. Bad crimps or faulty wiring. Clear: Cycle KSI or, if LOS mode was activated by
S the Stall Detected fault, clear by ensuring encoder
4. Vehicle is stalled. .
senses proper operation, Motor RPM = 0, and
Throttle Command = 0.

94 Emer Rev Timeout 1. Emergency Reverse was activated and Set: Emergency Reverse was activated and ran
ShutdownEMBrake; concluded because the EMR Timeout until the EMR Timeout timer expired.
ShutdownThrottle. timer has expired. Clear: Turn the emergency reverse input Off.

2. The emergency reverse input is stuck
On.

98 lllegal Model Number 1. Model_Number variable contains illegal | Set: lllegal Model_Number variable; when KSI
ShutdownMotor; value. cycles, a check is made to confirm a legal Model_
ShutdownMainContactor; 2. Software and hardware do not match. Number, and a fault is issued if one is not found.
ShutdownEMBrake; 3. Controller defective. Clear: Download appropriate software for your
ShutdownThrottle; controller model.

FullBrake.

99 Parameter Mismatch 1. Dual drive enabled on only one controller. | Set: When the Dual Drive software is enabled,
ShutdownMotor; 2. Incorrect position feedback type chosen | the controller must be setto either Speed Mode
ShutdownMainContactor; for motor technology in use. Express or Speed Mode; otherwise this fault is set.
ShutdownEMBrake; 3. Dual drive is enabled in torque mode. Motor Techology=0 must be paired with Feedback
ShutdownThrottle; Type=1, and Motor Technology=1 must be paired
FullBrake. with Feedback Type=2; otherwise this fault is set.

Clear: Adjust parameters to appropriate values and
cycle KSI.
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A CAUTION

12 — MAINTENANCE

There are no user serviceable parts in Curtis E/SE controllers. No attempt should be made to open, repair,
or otherwise modify the controller. Doing so may damage the controller and will void the warranty.

It is recommended that the controller and connections be kept clean and dry and that the controller’s
fault history file be checked and cleared periodically.

CLEANING

Periodically cleaning the controller exterior will help protect it against corrosion and possible
electrical control problems created by dirt, grime, and chemicals that are part of the operating
environment and that normally exist in battery powered systems.

When working around any battery powered system, proper safety precautions should be taken.
These include, but are not limited to: proper training, wearing eye protection, and avoiding loose
clothing and jewelry.

Use the following cleaning procedure for routine maintenance. Never use a high pressure washer to
clean the controller.

1. Remove power by disconnecting the battery.

2. Discharge the capacitors in the controller by connecting a load (such as
a contactor coil) across the controller’s B+ and B— terminals.

3. Remove any dirt or corrosion from the power and signal connector areas. The controller
should be wiped clean with a moist rag. Dry it before reconnecting the battery.

4. Make sure the connections are tight. Refer to Chapter 2, page 7-8, for maximum
tightening torque specifications for the battery and motor connections.

FAULT HISTORY

The 1313 handheld or 1314 PC programmer can be used to access the controller’s fault history file.
The programmer will read out all the faults the controller has experienced since the last time the fault
history file was cleared. Faults such as contactor faults may be the result of loose wires; contactor
wiring should be carefully checked. Faults such as overtemperature may be caused by operator habits
or by overloading.

After a problem has been diagnosed and corrected, it is a good idea to clear the fault history file.
This allows the controller to accumulate a new file of faults. By checking the new fault history file at
a later date, you can readily determine whether the problem was indeed fixed.
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APPENDIX A

VEHICLE DESIGN CONSIDERATIONS
REGARDING ELECTROMAGNETIC COMPATIBILITY (EMC)
AND ELECTROSTATIC DISCHARGE (ESD)
DECOMMISSIONING AND RECYCLING THE CONTROLLER

ELECTROMAGNETIC COMPATIBILITY (EMC)

Electromagnetic compatibility (EMC) encompasses two areas: emissions and immunity. Emissions are
radio frequency (RF) energy generated by a product. This energy has the potential to interfere with
communications systems such as radio, television, cellular phones, dispatching, aircraft, etc. Immunity
is the ability of a product to operate normally in the presence of RF energy.

EMC is ultimately a system design issue. Part of the EMC performance is designed into or inherent
in each component; another part is designed into or inherent in end product characteristics such as
shielding, wiring, and layout; and, finally, a portion is a function of the interactions between all these
parts. The design techniques presented below can enhance EMC performance in products that use
Curtis motor controllers.

Emissions

Signals with high frequency content can produce significant emissions if connected to a large enough
radiating area (created by long wires spaced far apart). Contactor drivers and the motor drive
output from Curtis controllers can contribute to RF emissions. Both types of output are pulse width
modulated square waves with fast rise and fall times that are rich in harmonics. (Note: contactor
drivers that are not modulated will not contribute to emissions.) The impact of these switching
waveforms can be minimized by making the wires from the controller to the contactor or motor as
short as possible and by placing the wires near each other (bundle contactor wires with Coil Return;
bundle motor wires separately).

For applications requiring very low emissions, the solution may involve enclosing the controller,
interconnect wires, contactors, and motor together in one shielded box. Emissions can also couple
to battery supply leads and throttle circuit wires outside the box, so ferrite beads near the controller
may also be required on these unshielded wires in some applications. It is best to keep the noisy
signals as far as possible from sensitive wires.

Immunity

Immunity to radiated electric fields can be improved either by reducing overall circuit sensitivity
or by keeping undesired signals away from this circuitry. The controller circuitry itself cannot be
made less sensitive, since it must accurately detect and process low level signals from sensors such
as the throttle potentiometer. Thus immunity is generally achieved by preventing the external RF
energy from coupling into sensitive circuitry. This RF energy can get into the controller circuitry via
conducted paths and radiated paths.
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Conducted paths are created by the wires connected to the controller. These wires act as antennas and
the amount of RF energy coupled into them is generally proportional to their length. The RF voltages
and currents induced in each wire are applied to the controller pin to which the wire is connected.
Curtis controllers include bypass capacitors on the printed circuit board’s throttle wires to reduce the
impact of this RF energy on the internal circuitry. In some applications, additional filtering in the
form of ferrite beads may also be required on various wires to achieve desired performance levels.

Radiated paths are created when the controller circuitry is immersed in an external field. This
coupling can be reduced by placing the controller as far as possible from the noise source or by
enclosing the controller in a metal box. Some Curtis controllers are enclosed by a heatsink that also
provides shielding around the controller circuitry, while others are partially shielded or unshielded.
In some applications, the vehicle designer will need to mount the controller within a shielded box on
the end product. The box can be constructed of just about any metal, although steel and aluminum
are most commonly used.

Most coated plastics do not provide good shielding because the coatings are not true metals, but
rather a mixture of small metal particles in a non-conductive binder. These relatively isolated particles
may appear to be good based on a dc resistance measurement but do not provide adequate electron
mobility to yield good shielding effectiveness. Electroless plating of plastic will yield a true metal and
can thus be effective as an RF shield, but it is usually more expensive than the coatings.

A contiguous metal enclosure without any holes or seams, known as a Faraday cage, provides the
best shielding for the given material and frequency. When a hole or holes are added, RF currents
flowing on the outside surface of the shield must take a longer path to get around the hole than if
the surface was contiguous. As more “bending” is required of these currents, more energy is coupled
to the inside surface, and thus the shielding effectiveness is reduced. The reduction in shielding is a
function of the longest linear dimension of a hole rather than the area. This concept is often applied
where ventilation is necessary, in which case many small holes are preferable to a few larger ones.

Applying this same concept to seams or joints between adjacent pieces or segments of a shielded
enclosure, it is important to minimize the open length of these seams. Seam length is the distance
between points where good ohmic contact is made. This contact can be provided by solder, welds, or
pressure contact. If pressure contact is used, attention must be paid to the corrosion characteristics
of the shield material and any corrosion-resistant processes applied to the base material. If the ohmic
contact itself is not continuous, the shielding effectiveness can be maximized by making the joints
between adjacent pieces overlapping rather than abutted.

The shielding effectiveness of an enclosure is further reduced when a wire passes through a hole in
the enclosure; RF energy on the wire from an external field is re-radiated into the interior of the
enclosure. This coupling mechanism can be reduced by filtering the wire where it passes through
the shield boundary.

Given the safety considerations involved in connecting electrical components to the chassis or
frame in battery powered vehicles, such filtering will usually consist of a series inductor (or ferrite
bead) rather than a shunt capacitor. If a capacitor is used, it must have a voltage rating and leakage
characteristics that will allow the end product to meet applicable safety regulations.
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The B+ (and B-, if applicable) wires that supply power to a control panel should be bundled with the
other control wires to the panel so that all these wires are routed together. If the wires to the control
panel are routed separately, a larger loop area is formed. Larger loop areas produce more efficient
antennas which will result in decreased immunity performance.

Keep all low power I/O separate from the motor and battery leads. When this is not possible, cross
them at right angles.

ELECTROSTATIC DISCHARGE (ESD)

Curtis motor controllers contain ESD-sensitive components, and it is therefore necessary to protect
them from ESD (electrostatic discharge) damage. Most of the control lines have protection for moderate
ESD events, but must be protected from damage if higher levels exist in a particular application.

ESD immunity is achieved either by providing sufficient distance between conductors and the ESD
source so that a discharge will not occur, or by providing an intentional path for the discharge current
such that the circuit is isolated from the electric and magnetic fields produced by the discharge. In
general the guidelines presented above for increasing radiated immunity will also provide increased
ESD immunity.

It is usually easier to prevent the discharge from occurring than to divert the current path. A
fundamental technique for ESD prevention is to provide adequately thick insulation between all
metal conductors and the outside environment so that the voltage gradient does not exceed the
threshold required for a discharge to occur. If the current diversion approach is used, all exposed
metal components must be grounded. The shielded enclosure, if properly grounded, can be used
to divert the discharge current; it should be noted that the location of holes and seams can have a
significant impact on ESD suppression. If the enclosure is not grounded, the path of the discharge
current becomes more complex and less predictable, especially if holes and seams are involved.
Some experimentation may be required to optimize the selection and placement of holes, wires, and
grounding paths. Careful attention must be paid to the control panel design so that it can tolerate a
static discharge.

MOV, transorbs, or other devices can be placed between B- and offending wires, plates, and touch
points if ESD shock cannot be otherwise avoided.

DECOMMISSIONING AND RECYCLING THE CONTROLLER

The controller is intended for installation into an Original Equipment Manufacturer (OEM) vehicle.
They are a component that has no function unless installed as part of the specific vehicles’ electrical
or electro-hydraulic control system.

For controller decommissioning and recycling:

1. Follow the OEM’s vehicle decommissioning instructions.

2. Follow all applicable landfill directives or regulations for
Electrical and Electronic Equipment (EEE) waste.
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Figure B-1

Supervisory system in Curtis
enhanced AC motor controllers. g sovEs » Outputs

APPENDIX B
EN13849 COMPLIANCE

Since January 1, 2012, conformance to the European Machinery Directive has required that the Safety
Related Parts of the Control System (SRPCS) be designed and verified upon the general principles
outlined in EN13849. EN13849 supersedes the EN954 standard and expands upon it by requiring
the determination of the safety Performance Level (PL) as a function of Designated Architecture
plus Mean Time To Dangerous Failure (MTTFd), Common Cause Faults (CCF), and Diagnostic
Coverage (DC). These figures are used by the OEM to calculate the overall PL for each of the safety
functions of their vehicle or machine.

The OEM must determine the hazards that are applicable to their vehicle design, operation, and
environment. Standards such as EN13849-1 provide guidelines that must be followed in order to
achieve compliance. Some industries have developed further standards (called type-C standards) that
refer to EN13849 and specifically outline the path to regulatory compliance. EN1175-1 is a type-C
standard for battery-powered industrial trucks. Following a type-C standard provides a presumption
of conformity to the Machinery Directive.

Curtis Enhanced AC Motor Controllers comply with these directives using advanced active
supervisory techniques. The basic “watchdog” test circuits have been replaced with a Supervisor
microcontroller that continuously tests the safety related parts of the control system; see the simplified
block diagram in Figure B-1.

PRIMARY MOTOR CONTROL [

Monitor

Inputs > MICROPROCESSOR 4
_ POWERBASE »( AC
< - MOTOR
Monitor
Communication
Link
[, SUPERVISOR
MICROPROCESSOR Shutdown

The Supervisor and Primary motor control processors run diagnostic checks at startup and
continuously during operation. At startup, the integrity of the code and EEPROM are ensured
through CRC checksum calculations. RAM is pattern checked for proper read, write, and addressing.
During operation, the arithmetic and logic processing unit of each micro is cyclically tested through
dynamic stimulus and response. The operating system timing and task sequencing are continuously
verified. Redundant input measurements are crosschecked over 30 times per second, and operational
status information is passed between microprocessors to keep the system synchronized. Any faults in
these startup tests, communication timing, crosschecks, or responses will command a safe shutdown
of the controller, disabling the driver outputs and motor drive within 200 ms.
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To mitigate the hazards typically found in machine operations, EN13849 requires that safety
functions be defined; these must include all the input, logic, outputs, and power circuits that
are involved in any potentially hazardous operation. Two safety functions are defined for Curtis
Enhanced AC Motor Controllers: Uncommanded Powered Motion and Motor Braking Torque.

The Uncommanded Powered Motion safety function provides detection and safe shutdown in the
following circumstances: faulted throttle; improper sequence of forward/reverse switches, throttle,
and interlock; incorrect direction of travel; loss of speed control or limiting; uncommanded
movement; or movement at start-up. The Braking Torque safety function provides detection and
safe shutdown in the event of the loss of braking torque, position/hill hold, or emergency reverse.

Curtis has analyzed each safety function and calculated its Mean Time To Dangerous Failure
(MTTEd) and Diagnostic Coverage (DC), and designed them against Common Cause Faults (CCF).
The safety-related performance of the 1232E controller is summarized as follows:

Safety Function Designated Architecture MTTFd DC CCF PL

Uncommanded

Powered Motion 2 >40 yrs >90% Pass d

Motor Braking Torque 2 >16 yrs >90% Pass c

EN1175 specifies that traction and hydraulic electronic control systems must use Designated
Architecture 2 or greater. This design employs input, logic, and output circuits that are monitored
and tested by independent circuits and software to ensure a high level of safety performance (up to
PL=d).

Mean Time To Dangerous Failure (MTTFd) is related to the expected reliability of the safety related
parts used in the controller. Only failures that can result in a dangerous situation are included in the
calculation.

Diagnostic Coverage (DC) is a measure of the effectiveness of the control system’s self-test and
monitoring measures to detect failures and provide a safe shutdown.

Common Cause Faults (CCF) are so named because some faults within a controller can affect
several systems. EN13849 provides a checklist of design techniques that should be followed to achieve
sufficient mitigation of CCFs. The CCF value is a pass/fail criterion.

Performance Level (PL) categorizes the quality or effectiveness of a safety channel to reduce the

« » « »

potential risk caused by dangerous faults within the system with “a” being the lowest and “e” being
the highest achievable performance.
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APPENDIX C

PROGRAMMING DEVICES

Curtis programmers provide programming, diagnostic, and test capabilities for the controller. The
power for operating the programmer is supplied by the host controller via a 4-pin connector. When
the programmer powers up, it gathers information from the controller.

Two types of programming devices are available: the 1314 PC Programming Station and the 1313
handheld programmer. The Programming Station has the advantage of a large, easily read screen;
on the other hand, the handheld programmer (with its 45x60mm screen) has the advantage of being
more portable and hence convenient for making adjustments in the field.

Both programmers are available in User, Service, Dealer, and OEM versions. Each programmer can
perform the actions available at its own level and the levels below that—a User-access programmer
can operate at only the User level, whereas an OEM programmer has full access.

PC PROGRAMMING STATION (1314)

The Programming Station is an MS-Windows 32-bit application that runs on a standard Windows
PC. Instructions for using the Programming Station are included with the software. In addition,
the Curtis 1309 Interface box with a computer-side USB and controller-side 4-pin serial Molex
connection is required for the 1314 PC Programmer.

HANDHELD PROGRAMMER (1313)

The 1313 handheld programmer is functionally equivalent to the PC Programming Station; operating
instructions are provided in the 1313 manual. This programmer replaces the 1311, an earlier model
with fewer functions.

PROGRAMMER FUNCTIONS

Programmer functions include:

Parameter adjustment — provides access to the individual programmable parameters.
Monitoring — presents real-time values during vehicle operation; these include all inputs and outputs.

Diagnostics and troubleshooting — presents diagnostic information, and also a means to clear the
fault history file.

Programming — allows you to save/restore custom parameter settings.

Favorites — allows you to create shortcuts to your frequently-used adjustable parameters and
monitor variables (1313 only).
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APPENDIX D

CONTROLLER SPECIFICATIONS

Table D-1 SPECIFICATIONS: 1232E/SE, 1234E/SE, 1236E/SE, 1238E/SE CONTROLLERS

Nominal input voltage:

PWM operating frequency:

Maximum encoder frequency:
Maximum controller output frequency:
Electrical isolation to heatsink:
Storage ambient temperature range:
Operating ambient temperature range:
Thermal cutback:

Design life:

Operating duration at maximum current:

Package environmental rating:
Weight:

Dimensions, WxLxH:

EMC:
Safety:

UL:

24V, 24-36V, 36-48 V, 48-80V, 72-96 V

NOMINAL MINIMUM MAXIMUM BROWNOUT
VOLTAGE VOLTAGE VOLTAGE VOLTAGE
24V 14V 30V 12V
24-36V 16.8V 45V 15V
36-48V 25.2V 60V 20V
48-80V 336V 105V 20V
72-96V 504V 120V 30V

10 kHz

10 kHz

450 Hz

500V ac (minimum)

—40°C to 95°C (—40°F to 203°F)

—40°C to 50°C (—40°F to 122°F)

Controller linearly reduces maximum current limit with an internal heatsink

temperature from 85°C (185°F) to 95°C (203°F); complete cutoff occurs
above 95°C (203°F) and below —40°C (—40°F)

1238E-75XX and 1238E-76XX: 5,000 hours

All other models: 20,000 hours

2 minutes minimum (unless otherwise noted), with initial temperature of
25°C and no additional external heatsink

IP65 per IEC529; compliance requires AMPSEAL 35-pin connector header

1232E:1.70kg  1232SE:1.92 kg
1234E:2.84kg  1234SE: 3.12 kg
1236E:412kg  1236SE: 3.79 kg
1238E:6.82kg  1238SE: 6.00 kg

1232E: 140 x 180 x 71 mm  7232SE: 140 x 180 x 74 mm
1234E:155 x 212 x 75 mm  1234SE: 155 x 212 x 79 mm
1236E:165 x 232 x 85 mm  1236SE: 165 x 232 x 85 mm
1238E: 275 x 232 x 85 mm  1238SE: 275 x 232 x 85 mm

Designed to the requirements of EN 12895:2000

Designed to the requirements of EN 1175-1:1998 + A1:2010 and EN
13849-1:2008 Category 2

UL recognized component per UL583

Note: Regulatory compliance of the complete vehicle system with the controller installed is the responsibility of the OEM.
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Table D-1 SPECIFICATIONS: 1232E/SE, 1234E/SE, 1236E/SE, 1238E/SE CONTROLLERS, Cont’d

MODEL CHART
NOMINAL MAXIMUM $2-60 MINUTE CONTINUOUS
BATTERY VOLTAGE CURRENT CONTINUOUS CURRENT FOR
MODEI NUMBER ) (A) CURRENT (A) DESIGN LIFE (A)
1232E-21XX 24 180 9 80
1232E-23XX 24 250 125 100
1232E-51XX 36-48 150 75 79
1232E-52XX 36-48 200 100 9
1232E-62XX 48-80 175 80 45
1232E-72XX 72-96 175 80 50
1234E-23XX 24 350 175 160
1234E-52XX 36-48 275 135 90
1234E-53XX 36-48 350 175 920
1234E-62XX 48-80 250 110 60
1236E-44XX 24-36 400 175 175
1236E-45XX 24-36 500 240 210
1236E-54XX 36-48 450 205 210
1236E-55XX 36-48 550 250 140
1236E-64XX 48-80 350 (1 min) 100 100
1238E-46XX 24-36 650 300 325
1238E-48XX 24-36 800 355 365
1238E-56XX 36-48 650 295 325
1238E-64XX 48-80 450 155 175
1238E-65XX 48-80 550 190 175
1238E-66XX 48-80 650 (1 min) 195 175
1238E-75XX 72-96 550 175 175
1238E-76XX 72-96 650 200 175
1232SE-24XX 24 375 185 160
1232SE-53XX 36-48 350 175 160
1234SE-45XX 24-36 500 235 210
1234SE-54XX 36-48 450 215 210
1234SE-63XX 48-80 350 149 175
1236SE-46XX 24-36 650 285 220
1236SE-56XX 36-48 600 260 210
1236SE-65XX 48-80 450 185 175
1238SE-49XX 24-36 1000* 425 376

Notes: All current ratings are rms values per motor phase.

S$2-60 minute current is the typical current achievable before thermal cutback occurs, with an ambient temperature of 25°C and the controller mounted to a
6 mm thick vertical steel plate with 6 km/h (1.7 m/s) airflow perpendicular to the plate.

Continuous current for design life is the maximum long-term current, at an internal heatsink long-term temperature of 70°C (158°F), at which the controller
will achieve its design life. These numbers are often calculated for a given application by determining an rms duty cycle current and heatsink temperature. For
applications that exceed this, please contact your Curtis distributor or support engineer.

*1238SE-49XX. Please contact your Curtis distributor or support engineer regarding the duty-cycle of this controller.
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